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● Safety precautions
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● The driver's main features
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Safety precautions
The following precautions ensure the correct use of the printer and prevent printer damage. Use these
precautions at all times.

● Use the power supply voltage that is specified on the nameplate. To avoid overloading the printer's
electrical outlet, do not use the outlet for multiple devices.

● Make sure that the printer is well-grounded. Failure to ground the printer can result in electrical shock,
fire, and susceptibility to electromagnetic interference.

● Do not disassemble or repair the printer yourself. Contact your local HP Service Representative for
service. See HP Customer Care on page 183.

● Use only the electrical cord that HP supplied with the printer. Do not damage, cut, or repair the power
cord. A damaged power cord creates a risk of fire and electric shock. Replace a damaged power
cord with an HP-approved power cord.

● Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of
the printer. Doing so can cause fire, electric shock, or other serious hazards.

● Turn off the printer and unplug the power cable from the power outlet in any of the following cases:

● When you place your hands inside the printer

● If smoke or an unusual smell emanates from the printer

● If the printer is making an unusual noise that does not occur during normal operation

● If a piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal
parts of the printer

● During an electrical (thunder or lightning) storm

● During a power failure

Using this guide
The HP Start-up Kit CD/DVD is the most complete source of information about this product and is organized
into the following chapters.

Introduction
This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance
These chapters help you carry out normal printer procedures and include the following topics:

● Connectivity and software instructions on page 12

● Basic setup options on page 20

● Handle the paper on page 26

● Handle the ink system on page 56

● Print options on page 79

● Color management on page 104
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● Practical printing examples on page 122

● Maintain the printer on page 135

Troubleshooting
These chapters help you solve problems that might occur while printing and include the following topics:

● Troubleshoot print-quality issues on page 148

● Troubleshoot ink-system issues on page 167

● Troubleshoot paper issues on page 162

● Troubleshoot other issues on page 172

● Front-panel error messages on page 179

Support and specifications
These chapters contain reference information, including HP customer care and the specifications of the
printer:

● Get help on page 182

● Printer specifications on page 188

● Legal information on page 193

Appendices
The appendices highlight some of the more common printing scenarios you might face as a user. Each
appendix takes a step-by-step approach to working through a given printing scenario, and points you to
various parts of this guide that provide more task-specific information and instruction.

Glossary
This chapter contains definitions of printing and HP terms that are used in this documentation.

Index
In addition to the table of contents, an alphabetical index is included to help you to find topics quickly.

Warnings and Cautions
Symbols are used in this manual to ensure the proper use of the printer and to prevent printer damage.
Follow the instructions that are marked with these symbols.

WARNING! Failure to follow the guidelines that are marked with this symbol could result in
serious personal injury or death.

CAUTION: Failure to follow the guidelines that are marked with this symbol could result in minor
personal injury or damage to the product.

Using this guide 3
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The printer's main features
Some major features of the printer are shown below:

● Print resolution of up to 2400 × 1200 optimized dots per inch (dpi), from a 1200 × 1200 dpi input
when using photo paper, the Best print-quality option, and the Maximum resolution for the photo
paper option

● HP Easy Printer Care (Windows®) and HP Printer Utility (Mac OS). See The HP Easy Printer Care
(Windows) and HP Printer Utility (Mac OS) main features on page 11.

● Accurate and consistent color reproduction features:

● Press emulations for U.S., European, and Japanese standards; and color-monitor red-gree-blue
(RGB) emulations

● Automatic color calibration and profiling

● An eight-ink system that provides a wide color range on matte fine-art papers and glossy photo
papers for photographic and graphic arts prints. The ink system also offers complete coverage of
International Organization for Standards (ISO) and Specifications for Web Offset Publications
(SWOP) gamuts for color accuracy in pre-press applications.

● An HP Embedded Spectrophotometer for consistent and accurate color, even with paper and
environment changes and easy creation of custom International Color Consortium (ICC) profiles.
See HP Embedded Spectrophotometer on page 108.

● Ink and paper usage information that is available from the Web through the Embedded Web Server.
See Access the Embedded Web Server on page 23.

● Paper flexibility and automatic easy load, including information and profiles that are available on
the front panel, or through HP Easy Printer Care (Windows) and HP Printer Utility (Mac OS)

The printer's main components
The following views illustrate the main components of the HP Designjet Z6100 42–in and 60–in Printers.
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Front view 42–in printer

1. Ink cartridge

2. Platen

3. Printhead

4. Printhead carriage

5. Front panel

6. Maintenance cartridge

7. Paper-load lever

8. Spindle

9. Bin
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Rear view 42–in printer

1. Quick Reference Guide holder

2. Hard power switch and power-cord plug in

3. Sockets for communication cables and optional accessories

Front view 60–in printer

1. Ink cartridge

2. Platen

3. Printhead

4. Printhead carriage
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5. Front panel

6. Maintenance cartridge

7. Paper-load lever

8. Spindle

9. Take-up reel deflector

10. Take-up reel motor

11. Take-up reel cable and sensor housing unit

12. Take-up reel sensor

13. Take-up reel spindle hub

Rear view 60–in printer

1. Quick Reference Guide holder

2. Hard power switch and power-cord plug in

3. Sockets for communication cables and optional accessories

Take-up reel motor

NOTE: The take-up reel is a standard feature on the HP Designjet Z6100 60–in Printer. It is an
optional accessory on the HP Designjet Z6100 42–in Printer. See Accessories on page 146.

The printer's main components 7

In
tr

od
uc

tio
n



1. Take-up reel spindle lever

2. Manual winding buttons

3. Wind-direction switch

The front panel
Your printer's front panel is located on the front of the printer, on the right-hand side. Use if for the following
functions:

● Use it to perform certain operations, such as loading and unloading paper.

● View up-to-date information about the status of the printer, the ink cartridges, the printheads, the
maintenance cartridge, the paper, the print jobs, and other parts and processes.

● Get guidance in using the printer.

● See warning and error messages, when appropriate.

● Use it to change the values of printer settings and the operation of the printer. However, settings in
the Embedded Web Server or in the driver override changes made on the front panel.
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The front panel has the following components:

1. The display area, shows information, icons, and menus.

2. The Power button turns the printer on and off. If the printer is in sleep mode, this button will wake it
up. (This is different from the hard power switch on the back of the printer. See Turn the printer on
and off on page 21.)

3. The Power light is off when the printer is off. This light is amber when the printer is in sleep mode,
green when the printer is on, green and flashing when the printer is in transition between off and
on.

4. The Form Feed and Cut button normally advances and cuts the roll. Here is a list of its other functions:

● If the printer is waiting for more pages to be nested, this button cancels the waiting time and
prints the available pages immediately.

● If the printer is drying the ink after printing, this button cancels the waiting time and releases
the page immediately.

● If the take-up reel is enabled, this button advances the paper 10 cm (3.9 inches), but does not
cut the paper.

5. The Reset button restarts the printer (as if it were switched off and switched on again). You will need
a non-conductive implement with a narrow tip to operate the Reset button.

6. The Cancel button cancels the current operation. It is often used to stop the current print job.

7. The Status light is off when the printer is not ready to print: the printer is either off, or in sleep mode.
The Status light is green when the printer is ready and idle, green and flashing when the printer is
busy, amber when a serious internal error has occurred, and amber and flashing when the printer
is awaiting human attention.

8. The Up button moves to the previous item in a list, or increases a numerical value.

9. The OK button is used to select the item that is currently highlighted.

10. The Back button is used to return to the previous menu. If you press it repeatedly, or hold it down,
you return to the main menu.

11. The Down button moves to the next item in a list, or decreases a numerical value.

To highlight an item on the front panel, press the Up or Down button until the item is highlighted.

To select an item on the front panel, first highlight it and then press the OK button.

The four front-panel icons are all found on the main menu. If you need to select or highlight an icon, and
you do not see the icons in the front panel, press the Back button until you can see them.

Sometimes this guide shows a series of front panel items like this: Item1 > Item2 > Item3. A construction
like this indicates that you should select Item1, select Item2, and then select Item3.

You will find information about specific uses of the front panel throughout this guide.

Printer software
The following software is provided with your printer:

● HP-GL/2 printer driver for Windows operating systems

● PostScript© printer driver for Windows and Mac OS operating systems

NOTE: The PostScript drivers are only available with HP Designjet PostScript printers.

The printer's main components 9

In
tr

od
uc

tio
n



● HP Easy Printer Care (Windows) and HP Printer Utility (Mac OS). See The HP Easy Printer Care
(Windows) and HP Printer Utility (Mac OS) main features on page 11.

NOTE: Because Windows XP Professional x64 Edition does not support HP Easy Printer
Care, it cannot be installed on computers that are running that version of Windows.

● The Embedded Web Server, which runs in the printer and enables you to use a Web browser on
any computer to check the ink levels and the printer status. See Access the Embedded Web
Server on page 23.

The Embedded Web Server's main components
The Embedded Web Server is a Web server running inside the printer. Users can obtain printer
information, manage settings and profiles, and troubleshoot problems through the Embedded Web Server.
It also allows service engineers to retrieve internal information that helps diagnose printer problems.

Access the Embedded Web Server remotely by using an ordinary Web browser running on any computer.
Its features and functionality are organized within three tabs. Buttons near the top of each tabs page
provide access to online help and supplies reordering.

Main tab
The Main tab provides information about the following items:

● Print jobs and managing the print queue

● Supplies status

● Paper and ink usage and accounting

● PANTONE©* emulation

Setup tab
The Setup tab includes options to complete these tasks:

● Define printer, network and security settings

● Send accounting reports and notifications of warnings and errors through email

● Update firmware

● Upload paper profiles

● Set the date and time

Support tab
The Support tab contains options to complete these funtions:

● Use the Embedded Web Server Print Quality Troubleshooting wizard to help resolve some of the
most common print quality issues

● Browse helpful information from a variety of sources

● Access HP Designjet links for technical support with your printer, driver and accessories

● Access service support pages that show current and historical data on the usage of your printer

● Troubleshoot image-quality
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The driver's main features
The HP-GL/2 driver is your main printer driver. The following are its main features:

● Access to the HP Knowledge Center, which includes illustrated, step-by-step guides for the most
common printing environments

● A crop-lines option to indicate where the paper should be cut to achieve an appropriate paper size

● A wide variety of printing options

● Color-adjustment options

The HP Easy Printer Care (Windows) and HP Printer
Utility (Mac OS) main features

The HP Easy Printer Care (Windows) and HP Printer Utility (Mac OS) provide an easy-to-use interface that
allows the user to manage and access various printer features and functionality.

● Manage the printer, including single-point color control with the HP Color Center.

● Gain access to the online HP Knowledge Center.

● View the status of the ink cartridges, the printheads and the paper.

● Manage, install, and create International Color Consortium (ICC) profiles (available with PostScript
printers only).

● Access and use embedded profiles (available with PostScript printers only).

● Update the printer's firmware. See Update the printer firmware on page 141.

● Calibrate the printer and display.

● Change various printer settings (on the Settings tab).

● Configure network settings

NOTE: Because Windows XP Professional x64 Edition does not support HP Easy Printer Care, it
cannot be installed on computers that are running that version of Windows.
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2 Connectivity and software
instructions

● Install the driver

● Choose which connection method to use

● Connect to a network (Windows)

● Connect directly to a computer (Windows)

● Uninstall the printer software (Windows)

● Connect to a network (Mac OS)

● Connect directly to a computer (Mac OS)

● Uninstall the printer software (Mac OS)
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Install the driver
This information guides you through the driver installation process. The instructions for installing the driver
are specific to your computer operating system and the method by which you choose to connect the
computer to the printer. When you install the driver, the HP Easy Printer Care (Windows) or HP Printer
Utility (Mac OS), and the HP Color Center software are also installed.

Choose which connection method to use
The following methods can be used to connect your printer.

Connection type Speed Cable length Other factors

Gigabit Ethernet Fast; varies according to
network traffic

Long (100 m=328 ft) Requires extra equipment (switches)

Jetdirect print server
(optional accessory)

Moderate; varies
according to network
traffic

Long (100 m=328 ft) Requires extra equipment (switches)

Provides additional features

See http://www.hp.com/go/jetdirect/ for
more details

USB 2.0 (optional
accessory)

Very fast Short (5 m=16 ft)

NOTE: The speed of any network connection depends on all the components that are used in
the network, which can include network interface cards, hubs, routers, switches, and cables. If any
one of these components cannot operate at high speed, you will have a low-speed connection. The
speed of your network connection can also be affected by the total amount of traffic from other
devices on the network.

Connect to a network (Windows)
Before you begin, check your equipment:

● The printer should be set up and turned on.

● The Ethernet hub or router should be on and functioning correctly.

● All computers on the network should be turned on and connected to the network.

● The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer:

1. Make a note of the IP address on the status screen on the printer's front panel (192.168.1.1 in this
example):

2. Insert the HP Start-Up Kit CD/DVD into your computer. If the CD/DVD does not start automatically,
run the START.EXE program in the root folder of the CD/DVD.

Install the driver 13
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3. Click Install.

NOTE: Because Windows XP Professional x64 Edition does not support HP Easy Printer
Care, it cannot be installed on computers that are running that version of Windows.

4. Follow the onscreen instructions to install the driver and set up the printer. The following notes help
you to understand the screens and make appropriate choices.

● When asked how the printer is connected, select Wired networking.

● The configuration program looks for printers that are connected to your network. When the
search is complete, a list of printers appears. Identify your printer by its Internet Protocol (IP)
address and select it from the list.

● The configuration program analyzes the network and the printer. The program detects the
network settings and suggests the settings to use when configuring the printer. It is not normally
necessary to change any of these settings, but you can do so if you want to.

If your computer fails to find any printers on the network, the Printer Not Found window appears,
which helps you to find your printer. If you are using a firewall, you might have to disable it temporarily
in order to find the printer. You also have the options of searching for the printer by its Uniform Resource
Locator (URL), IP address, or media access control (MAC) address.

Connect directly to a computer (Windows)
If you have an HP High speed USB 2.0 card (available as an optional accessory and supported under
Windows 2000, XP, and 2003 Server), you can connect your printer directly to a computer without going
through a network. See Accessories on page 146.

TIP: A universal serial bus (USB) connection might be faster than a network connection, but
because the cable is limited in length, the printer is more difficult to share.

1. Do not connect the computer to the printer yet. First install the printer driver software on the computer.

2. Insert the HP Start-Up Kit CD/DVD into your CD/DVD drive. If the CD/DVD does not start
automatically, run the START.EXE program in the root folder of the CD/DVD.

3. Click Install.

NOTE: Because Windows XP Professional x64 Edition does not support HP Easy Printer
Care, it cannot be installed on computers that are running that version of Windows.

4. Follow the onscreen instructions to install the driver and set up the printer. The following notes help
you to understand the screens and make appropriate choices.

● When asked how the printer is connected, select Connected directly to this computer.

● If you would like to share the printer with other people that are connected to your network, click
the Printer Properties button in the Ready to Install window, and then click the
Sharing tab and type the name under which the printer will be shared.

● When prompted to do so, connect your computer to the printer with a certified USB cable. Make
sure that the printer is turned on.

NOTE: The use of non-certified USB cables can lead to connectivity problems. Only
cables that are certified by the USB Implementor's Forum (http://www.usb.org/) should
be used with this printer.
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Uninstall the printer software (Windows)
1. Insert the HP Start-Up Kit CD/DVD into your CD/DVD drive. If the CD/DVD does not start

automatically, run the START.EXE program in the root folder of the CD/DVD.

2. Click Uninstall, and follow the onscreen instructions to uninstall the printer software.

Connect to a network (Mac OS)
You can connect your printer to a network under Mac OS X by using the following methods:

● Bonjour or Rendezvous

● TCP/IP

NOTE: The printer does not support AppleTalk.

Before you begin, check your equipment:

● The printer should be set up and turned on.

● The Ethernet hub or router should be on and functioning correctly.

● All computers on the network should be turned on and connected to the network.

● The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer.

Bonjour or Rendezvous connection
1.

On the front panel, and select the  icon, and then select Connectivity Menu > Gigabit
Ethernet > View configuration. Note the multicast Domain Name System (mDNS) service name
of your printer.

2. Insert the HP Start-Up Kit CD/DVD into your CD/DVD drive.

3. Click the CD icon on your desktop.

4. Click the Mac OS X HP Designjet Installer icon.

5. Follow the onscreen instructions. HP recommends that you use the Easy Install option.

The printer software is installed, including the printer driver, HP Printer Utility, and HP Color Center.

Uninstall the printer software (Windows) 15
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6. When the software has been installed, the HP Printer Setup Assistant starts automatically to help you
set up a connection to your printer. Follow the onscreen instructions.

7. When you reach the Select Printer screen, look for your printer's mDNS service name (which you
noted in step 1) in the Printer Name column.

● If you find the correct printer name, scroll sideways to see the Connection Type column, and
make sure that it shows Bonjour/Rendezvous. Highlight that line. If you do not immediately
see the printer name, continue searching farther down the list.

● If you cannot find your printer name with a Bonjour/Rendezvous connection type, check
the box My printer is not in the list

Click Continue.

8. Continue following the onscreen instructions. When you reach the Printer Queue Created screen,
click Quit to exit, or click Create New Queue if you want to connect another printer to the
network.

9. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run separately from the CD.

TCP/IP connection
1.

On the front panel, and highlight the  icon. The status screen appears.

Note the URL of your printer (http://xxxx11 in this example).

2. Insert the HP Start-Up Kit CD/DVD into your CD/DVD drive.
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3. Click the CD/DVD icon on your desktop.

4. Click the Mac OS X HP Designjet Installer icon.

5. Follow the onscreen instructions. HP recommends that you use the Easy Install option.

The printer software is installed, including the printer driver, HP Printer Utility, and HP Color Center.

6. When the software has been installed, the HP Printer Setup Assistant starts automatically to help you
set up a connection to your printer. Follow the onscreen instructions.

7. When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1) in
the Printer Name column.

● If you find the correct printer name, scroll sideways to see the Connection Type column, and
make sure that it shows Bonjour/Rendezvous. Highlight that line. If you do not immediately
see the printer name, continue searching farther down the list.

● If you cannot find your printer name with a Bonjour/Rendezvous connection type, check
the box My printer is not in the list

Click Continue.

8. Continue following the onscreen instructions. When you reach the Printer Queue Created screen,
click Quit to exit, or click Create New Queue if you want to connect another printer to the
network.

9. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the CD.

Connect directly to a computer (Mac OS)
If you have an HP High speed USB 2.0 card (available as an optional accessory), you can connect your
printer directly to a computer without going through a network. See Accessories on page 146.

1. Make sure that the printer is either turned off, or disconnected from the computer.

2. Insert the HP Start-Up Kit CD/DVD into your CD/DVD drive.

Connect directly to a computer (Mac OS) 17
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3. Click the CD/DVD icon on your desktop.

4. Click the Mac OS X HP Designjet Installer icon.

5. Follow the onscreen instructions. HP recommends that you use the Easy Install option.

The printer software is installed, including the printer driver, HP Printer Utility, and HP Color Center.

6. When the software has been installed, the HP Printer Setup Assistant starts automatically to help you
set up a connection to your printer.

7. Make sure that the printer is turned on and connected to the computer with a certified USB cable.

NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this
printer.

8. In the HP Printer Setup Assistant, click Continue.

9. In the list of printers that appears, select the entry that uses the connection type USB, and click
Continue.

10. The following screen shows information about your printer's installation, and the name of the printer
can be modified. Make any changes you want to make, and click Continue.

11. Your printer is now connected. On the Printer Queue Created screen, click Quit to exit, or click
Create New Queue if you want to connect another printer.

12. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, run the HP Printer Setup Assistant can be run at any time from the
CD.

Share the printer

NOTE: Printer sharing between users is supported under Mac OS X V10.2 and later.

If your computer is connected to a network, you can make your directly connected printer available to
other computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.

2. Enable printer sharing by clicking Sharing > Services > Printer Sharing.

3. Your printer now automatically appears in the list of shared printers that is available on any other
computer that is running Mac OS and connected to your local network.
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NOTE: Any other users that want to share your printer must install the printer software on their
own computers.

Any other users that share your directly connected printer can send print jobs, but cannot receive
information from the printer. This affects printer alerts, printer status reports, paper management,
printer administration, and troubleshooting.

Mac OS V10.2 users have to select the Show printers connected to other computers
option in the Print Center in order to see shared printers.

Sharing your directly connected printer with other users will slow down your computer, perhaps to
the point that the delay is unacceptable.

TIP: The best way to share the printer over a network is to connect the printer to the network,
rather than to any single computer. See Connect to a network (Mac OS) on page 15.

Uninstall the printer software (Mac OS)
1. Insert the HP Start-Up Kit CD/DVD into your CD/DVD drive.

2. Click the CD/DVD icon on your desktop.

3. Click the Mac OS X HP Designjet Installer icon.

4. Click Uninstall, and follow the onscreen instructions to uninstall the printer software.

Uninstall the printer software (Mac OS) 19
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3 Basic setup options

● Printer setup options

● Embedded Web Server setup options

● HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) setup options
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Printer setup options
Turn the printer on and off

TIP: Turn the printer on with the hard power switch on the back of the printer or by pressing the
Power button on the front panel. You can leave the printer on without wasting energy. Leaving it
on improves response time and overall system reliability. When the printer has not been used for
a certain period of time, it saves power by going into sleep mode. Any interaction with the printer
returns it to active mode, and it can resume printing immediately.

NOTE: In sleep mode, the printer wakes up from time to time to do maintenance service to the
printheads. This avoids the need of doing long preparation after long idle periods.

If you want to turn the printer on or off, the normal and recommended method is to use the Power button
on the front panel.

When you turn off the printer this way, the printheads are automatically stored with the maintenance
cartridge, which prevents them from drying out.

However, if you plan to leave the printer turned off for a long period of time, you are recommended to
turn it off using the Power button, and then also switch off the power switch at the rear.

To turn it back on later, use the power switch at the rear, and then press the Power button.

When the printer is turned on, it will take some time to initialize itself. This time is about 10 minutes for
the HP Designjet Z6100 printer series.
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Restart the printer
In some circumstances you may be advised to restart the printer. Please proceed as follows:

1. Press the Power button on the front panel to turn the printer off. Wait a few moments, and then press
the Power button again. This should restart the printer. If it does not, continue with step 2.

2. Use the Reset button on the front panel. You will need a non-conductive implement with a narrow tip
to press the Reset button. This normally has the same effect as pressing the Power button, but might
work if the Power button press does not.

3. If neither steps 1 nor 2 seems to have any effect, turn off the printer by using the power switch at the
rear of the printer.

4. Remove the power cord from the power socket.

5. Wait for 10 seconds.

6. Reinsert the power cord into the power socket and turn on the printer by using the power switch.

7. Make sure that the Power light on the front panel illuminates. If it does not, use the Power button to
turn on the printer.

Change the language of the front panel
Two methods are available to change the language that is used for the front-panel menus and messages.

●
If you can understand the current front panel language, go to the front panel and select the 
icon, and then select Front panel options > Select language.

● If you cannot understand the current front panel language, start with the printer powered off. At the
front panel, press the OK button and hold it down. While holding down the OK button, press the
Power button and hold it down. Continue to hold down both buttons until the green light on the left
side of the front panel starts flashing, and then release both buttons. You can expect a delay of about
one second. If the green light starts flashing without any delay, you may need to start again.

Whichever method you used, the language selection menu should now appear on the front panel.

Highlight your preferred language, and then press the OK button.
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Request e-mail notification of specific error conditions
1. In the Embedded Web Server, go to the E-mail server page on the Setup tab and ensure that the

following fields are correctly filled in:

● SMTP server. This is the IP address of the outgoing mail server (Simple Mail Transfer Protocol
[SMTP]) that processes all e-mail messages from the printer. If the mail server requires
authentication, e-mail notifications will not work.

● Printer e-mail address. Each e-mail message that the printer sends must include a return
address. This address does not need to be a real, functional e-mail address, but it should be
unique, so that recipients of the message can identify the printer that sent it

2. Go to the Notification page, which is also on the Setup tab.

3. Click the New icon to request new notifications, or click the Edit icon to edit notifications that have
already been set up. Then specify the e-mail addresses to which notifications are sent, and select the
incidents that result in notification messages.

Change the sleep mode setting
If the printer is left turned on but unused for a certain period of time, it automatically goes into sleep mode
to save power. The default period of time it waits is 15 minutes. To change the time the printer waits before

it goes into sleep mode, go to the front panel and select the  icon, and then select Front panel
options > Sleep mode wait time. Highlight the wait time that you want, and then press the OK
button.

Turn off the buzzer

To turn the printer's buzzer on or off, go to the front panel and select the  icon, and then select Front
panel options > Enable buzzer.

Change the front panel display contrast

To change the contrast of the front-panel display, select the  icon, select Front panel options >
Select display contrast, and then select a value by using the Up or Down button. Press the OK button
to save the value.

Change the units of measurement

To change the units of measurement that appear on the front panel, select the  icon, select Front
panel options > Select units, and then select English or Metric.

The units of measurement can also be changed in the Embedded Web Server.

Embedded Web Server setup options
Access the Embedded Web Server

Use the Embedded Web Server to manage your printer remotely through an ordinary Web browser
running on any computer.

NOTE: To use the Embedded Web Server, you must have a TCP/IP connection to your printer.
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The following browsers are known to be compatible with the Embedded Web Server:

● Internet Explorer 5.5 or later for Windows

● Safari 1, 2, 3 or later for Mac OS X

● Netscape Navigator 6.01 or later

● Mozilla 1.5 or later

● Mozilla Firefox 1.0 or later

To use the Embedded Web Server on any computer, open your Web browser and type the printer address.
The printer address appears on the status screen on the printer's front panel (192.168.1.1 in this
example):

If you follow these instructions but fail to open the Embedded Web Server, see Cannot access the
Embedded Web Server on page 174.

Password-protect the Embedded Web Server
1. In the Embedded Web Server, click the Setup tab and go to the Security page.

2. Type a security password of your own choice in the New password field.

3. Type it again in the Confirm password field.

4. Click Set password.

When a password is set, no one can perform the following actions in the Embedded Web Server without
providing the security password:

● Manage print jobs in the queue (cancel, delete)

● View previews of print jobs

● Delete stored jobs

● Clear accounting information

● Update the printer's firmware

NOTE: If you forget the security password, see Cannot access the Embedded Web Server
on page 174.

Change the language of the Embedded Web Server
The Embedded Web Server functions in the following languages: English, Portuguese, Spanish, Catalan,
French, Italian, German, Simplified Chinese, Traditional Chinese, Korean, and Japanese. It uses the
language that you specified in your Web browser options. If you specify a language that it cannot support,
it functions in English.
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To change the language, change your Web browser's language setting. For example, in Internet Explorer
version 6, go to the Tools menu and select Internet Options, Languages. Make sure that the
language you want is at the top of the list in the dialog box.

To complete the change, close and reopen your Web browser.

HP Easy Printer Care (Windows) or HP Printer Utility
(Mac OS) setup options

Use the HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) to manage your printer from a
computer that has a USB connection and TCP/IP.

● In Windows, start HP Easy Printer Care from your desktop shortcut or by clicking Start > All
Programs > Hewlett-Packard > HP Easy Printer Care > Start HP Easy Printer Care.
This opens the HP Easy Printer Care, which shows the printers installed.

● In Mac OS, select STARTUP_DISK > Library > Printers > HP > Utilities > HP Printer
Utility. The HP Printer selector opens the first time you use the Printer Utility. Subsequently, the Printer
Utility opens automatically upon startup. Use the HP Color Center icon in the dock to open the Printer
Selector. The printer should be added in the Printer Setup Utility.

Upon startup, the Printer Utility opens automatically for the last printer configured.

Select your printer and click Launch Utility. This opens the HP Printer Utility.

After you have installed the HP Printer Utility from the startup disk, you can start it from the dock.

If you follow these instructions but fail to get through to HP Easy Printer Care (Windows) or HP Printer
Utility (Mac OS), see Cannot access HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS)
on page 177.

NOTE: Because Windows XP Professional x64 Edition does not support HP Easy Printer Care, it
cannot be installed on computers that are running that version of Windows.

Change the language of the HP Easy Printer Care (Windows) or HP
Printer Utility (Mac OS)

The HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) functions in the following languages:
English, Portuguese, Spanish, Catalan (Windows only), French, Italian, German, Russian, Simplified
Chinese, Traditional Chinese, Korean, and Japanese.

● In Windows, select Tools > Set Language, select a language from the list, and click the Apply
button

● In Mac OS, change the language as you would for any other software program. In System
Preferences, select International, and then restart the software.
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4 Handle the paper

● Overview

● Load a roll onto the spindle

● Load a roll into the printer

● Unload a roll from the printer

● Use the take-up reel

● View information about the paper

● Perform paper advance calibration

● Download paper profiles

● Use non-HP paper

● Cancel the drying time

● Change the drying time

● Printing paper info

● Store the paper

● Order paper
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Overview
Paper is only a subset of the portfolio of printing media the printer can handle. You can also print on a
wide variety of films, textiles and fabrics, self-adhesive materials, and banner and sign materials.
Throughout this guide, however, these media are generally referred to as paper.

NOTE: Because the front panel has limited space, the names of the HP paper might be
abbreviated and might not appear in the front panel exactly as they are shown on the packaging
label.

NOTE: Because the complete list of supported paper is very long, only the most common paper
types appear in the front panel. If you want to see an HP paper type that does not appear on the
front panel, download the profile to the printer from http://www.hp.com/go/designjet. See
Download paper profiles on page 47.

NOTE: The automatic paper-cutter feature is disabled for some of the heaviest media types,
because some heavy paper can damage the cutter.

Use paper
Choosing the correct paper type for your needs is an essential step in ensuring good print quality. For
best printing results, use only recommended HP paper (see Supported paper types on page 28), HP
papers have been developed and thoroughly tested to ensure reliable performance. All printing
components (printer, ink system, and paper) have been designed to work together to offer trouble-free
operation and ensure optimal print quality.

Here are some additional tips about paper usage:

● Allow all paper types to adapt to room conditions, out of the packaging, for 24 hours before using
them for printing.

● Handle film and photo paper by the edges, or wear cotton gloves. Skin oils can be transferred to
the paper, leaving fingerprint marks.

● Keep the paper tightly wound on the roll throughout the loading and unloading procedures. To make
sure that the roll stays tightly wound, consider using tape to adhere the lead edge of the roll to the
core just before removing the roll from the printer. You can keep the roll taped during storage. If the
roll starts to unwind, it can become difficult to handle.

NOTE: The use of tape to adhere the lead edge of the roll is especially important for 76.2–
mm (3–inch) cores, in which the inherent stiffness of the printing material can cause the
material to loosen and unwind from its core.

● Whenever you load a roll, the front panel prompts you to specify the paper type that you are loading.
For good print quality, it is essential to specify this correctly. Make sure that the paper name that is
printed on the packaging label matches the description on the front panel.

If you cannot find a specific paper on the front-panel display, go to http://www.hp.com/go/
designjet/supplies to download the latest color profile to your printer, or select the paper description
that best matches the paper name printed on the packaging label.

● The quality of some images might be reduced if you use a paper type that is unsuitable for your
image. This is especially important to consider when printing on fiber-based papers such as HP
Universal Coated Paper, HP Coated Paper, HP Heavyweight Coated Paper and HP Universal
Heavyweight Coated Paper. Printing images that contain high-saturation area fills on fiber-based
papers can create unwanted wavy patterns as a result of paper expansion. This can ultimately
contribute to more severe problems. Consider using Super Heavyweight Coated Paper and other
cockle-free papers when printing high-saturation area fills.
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● Make sure that the appropriate print-quality setting (Best, Normal, Normal-Fast, or Fast) is selected.
You can set the print quality in the driver, in the Embedded Web Server, or on the front panel. Driver
or Embedded Web Server settings override front panel settings. The combination of paper type and
print-quality settings tells the printer how to place the ink on the paper—for example, the ink density
and halftoning method. See Select print quality on page 80.

● Although the ink systems that are supplied with this printer have good light-fastness, colors will
eventually fade or change if exposed to sunlight over a long period of time

● If the paper type shown on the front panel does not correspond to the paper that you intend to use,
take one of the following actions:

● Reload the roll into the printer and select the correct media type. See Unload a roll from the
printer on page 36 and Load a roll into the printer on page 32.

● Use the Embedded Web Server, the HP Easy Printer Care, or the HP Printer Utility to reconfigure
the media type for the roll.

●
At the printer's front panel, select the  icon, and then select View loaded paper >
Change loaded paper type.

NOTE: The paper advance calibration is not performed when the paper type is
changed from the frnt panel.

Drying time
On some paper and under certain environmental conditions, the ink needs some time to dry before the
paper is unloaded. The following settings are available:

● Optimal: the printer automatically determines the appropriate drying time, based on the paper you
have selected and the current temperature and humidity. If any drying time is required, a “drying
time to go” countdown appears on the front panel.

● Extended: the default drying time is extended. This can be used if you find that the default drying
time is sufficient to dry the ink.

● Reduced: the default drying time is reduced. This can be used if you want to get prints as fast as
possible, and you find that the reduced drying time causes no significant problem in your
environment.

● None: no drying time is provided. This can be used, for example, if you are manually removing the
prints as quickly as the printer is producing them.

● Manual: this allows you to specify the drying time (in minutes).

To change the drying time, see Change the drying time on page 49.

Supported paper types
The following table lists the most common HP paper types that are suitable for use with your printer, and
shows the name that you should select on the front panel when loading each paper type. If you want to
use an HP paper that does not appear on the front panel, go to http://www.hp.com/go/designjet/
supplies and download the appropriate paper profile. You only need to download a profile once; the
printer stores it for future use and it subsequently appears in the front panel .

For the part numbers, widths, and weights of these papers, see Order paper on page 49.

NOTE: This list is likely to change over the course of time. For the latest information, visit
http://www.hp.com/go/designjet/supplies/.
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Table 4-1  Supported paper types

Paper type Product name Front panel name

Bond and Coated Paper HP Coated Paper HP Coated Paper

HP Coated Paper (CAD) HP Coated Paper (CAD)

HP Universal Coated Paper HP Universal Coated Paper

HP Universal Coated Paper (CAD) HP Univ Coated Paper(CAD)

HP Heavyweight Coated Paper HP Heavyweight Coated

HP Universal Heavyweight Coated Paper HP Univ HeavyweightCoated

HP Universal Inkjet Bond Paper HP Univ Inkjet Bond Paper

Plain paper Plain paper

Bright White Bond Paper Bright White Bond Paper

Coated Paper Coated Paper

Coated Paper (CAD) Coated Paper (CAD)

Heavyweight Coated Paper Heavyweight Coated Paper

Super Heavyweight Coated Paper Super HW Coated Paper

Photo Paper HP Premium Instant-dry Photo Gloss HP Premium ID Gloss

HP Premium Instant-dry Photo Satin HP Premium ID Satin

HP Professional Satin Photo Paper HP Prof Satin Photo Paper

HP Universal Instant-dry Photo Gloss HP Universal ID Gloss

HP Universal Instant-dry Photo Semi-Gloss HP Universal ID SemiGloss

Photo Gloss Paper Photo Gloss Paper

Photo Semi-Gloss/Satin Paper Photo SG/Satin Paper

Fine Art Material HP Professional Matte Canvas HP Prof Matte Canvas

HP Collector Satin Canvas HP Collector Satin Canvas

HP Aquarella Art Paper HP Aquarella Art Paper

HP Artist Matte Canvas HP Artist Matte Canvas

HP Universal Matte Canvas HP Universal Matte Canvas

HP Hahnemühle Smooth Fine Art Paper HP Smooth Fine Art Paper

HP Matte Litho-realistic Paper HP Matte Litho

HP Hahnemühle Textured Fine Art Paper HP Textured FA Paper

Canvas Canvas

Fine Art Paper Fine Art Paper

Backlit Material HP Premium Vivid Color Backlit Film HP Premium Vivid Backlit

Backlit Film Backlit Film

Banner and Sign Material HP Instant-dry Indoor Banner, Gloss HP ID Indoor Banner Gloss

HP Opaque Scrim Banner HP Opaque Scrim Banner

Indoor Banner Indoor Banner

Scrim Banner Scrim Banner
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Paper type Product name Front panel name

Technical Paper Natural Tracing Paper Natural Tracing Paper

Translucent Bond Translucent Bond

Vellum Vellum

Film Transparent/Clear Film Transparent/Clear Film

Matte Film Matte Film

Proofing Paper HP Professional High-gloss Contract
Proofing Paper

HP HG Contract Proofing

HP Professional Semi-gloss Contract
Proofing Paper

HP SG Contract Proofing

HP Proofing Matte HP Proofing Matte

Proofing Gloss Paper Proofing Gloss Paper

Proofing Semi-Gloss/Satin Paper Proofing SG/Satin Paper

Proofing Matte Paper Proofing Matte Paper

Self-Adhesive Material Adhesive Polypropylene Adhesive Polypropylene

Adhesive Vinyl Adhesive Vinyl

Fabric/textile Material (Shown only if a custom paper is
downloaded from the Internet)

TBD

Load a roll onto the spindle
1. Make sure that the printer wheels are locked (the brake lever is pressed down) to prevent the printer

from moving.

2. Remove the first end of the spindle from the right side of the printer, and then move the spindle to
the right in order to extract the other end. Do not insert your fingers into the spindle supports during
the removal process.

The spindle has a hub at each end to keep the roll in position. Remove the blue hub at the left end
to mount a new roll. The hub slides along the spindle to hold rolls of different widths.

Table 4-1  Supported paper types (continued)
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3. Slide the lever-lock on the blue hub to the unlocked position and remove the hub (1) from the left end
of the spindle.

4. Rest the roll of paper that you want to load on the take-up reel deflector. The roll might be long and
heavy, and you might need two people to handle it.

5. Slide the spindle into the roll. Make sure that no space exists between the roll and the fixed hub at
the right end of the spindle.

Make sure that the paper will wind off the roll in the correct direction. If it does not, remove the
spindle from the roll, turn the roll 180° and rest it on the deflector. Then slide the spindle into the roll.

NOTE: A label on the spindle also shows the correct winding direction.
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6. Put the blue hub on to the upper end of the spindle, and push it towards the end of the roll as shown
in step 1 in the following image. Then slide the lever-lock to the locked position as shown in step 2.

7. With the blue hub on the left, insert the spindle into the left side of the printer (1), and then into the
right side of the printer (2).

If you regularly use different paper types, you can change rolls more quickly if you pre-load rolls of different
paper types on different spindles. Extra spindles are available for purchase.

Load a roll into the printer
NOTE: To start this procedure, you need to have a roll loaded on the spindle. See Load a roll
onto the spindle on page 30.

1.
At the printer's front panel, select the  icon, and then select Paper load > Load roll.

2. Wait until the front panel prompts you to open the printer window.

32 Chapter 4   Handle the paper

H
a
nd

le the p
a
p
er



3. Lift the paper-load lever.

4. Pull out approximately 1 m (3 feet) of paper.

5. Carefully insert the leading edge of the roll above the black-ribbed roller.

WARNING! Take care not to touch the rubber wheels on the platen while loading paper.
These wheels can rotate and trap skin, hair, or clothing.

WARNING! Take care not to push your fingers inside the printer's paper path.
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6. Wait until the paper emerges from the printer, as shown in the following graphic.

NOTE: If you have an unexpected problem at any stage of the paper loading process,
see The paper cannot be loaded successfully on page 163.

7. Align the edge of the paper with the blue line and the left edge of the semi-circle to the right of the
platen.

TIP: It may be helpful to also align the lead edge of the paper with the front edge of the
platen. You can use a blade or scissors to improve the lead edge of the paper if it is not
straight or is not cut well.

8. When the paper is correctly aligned with the blue line and half-circle, lower the paper-load lever.

9. Wait for the front-panel message that prompts you to wind excess paper onto the roll.
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10. Wind the excess paper onto the roll. Use the hub to turn the roll in the direction shown.

11. Lower the printer window.

12. Wait for the front panel to again prompt you to wind excess paper onto the roll.

13. The printer will perform a color calibration if it has not already calibrated the paper type you are
using, and if color calibration is turned on. See Color calibration on page 110.

14. a) Select the paper category and paper type of the roll you are loading.

NOTE: If it is not clear which paper category or paper type to select, see Supported paper
types on page 28.

b) Select the length of the roll you are loading.

NOTE: If the paper that you are using has a paper-data barcode printed on the leading
edge of the roll, the paper information is automatically loaded into the printer.
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15. If you have a take-up reel (a standard feature on the 60–inch printer and an optional accessory on
the 42–inch printer) and it is enabled, you will see the “Take-up reel enabled” message on the front-
panel Paper tab. In this case, a message will appear on the front panel asking if you want to load
paper into the reel. If you select No (or if you do not have a take-up reel) the front panel displays
the Ready message and the printer is ready to print. If you select Yes, a message will appear on
the front panel asking if you want to load the take-up reel now or during printing.

● If you want to load the take-up reel now, select Load take-up reel now, read through the
introductory text in the section Use the take-up reel on page 38, and then continue to step 3
of the procedure.

● If you want to load the take-up reel during printing, select Load it during printing, read
through the introductory text in the section Use the take-up reel on page 38, and then continue
to step 3 of the procedure.

NOTE: Familiarize yourself with the procedural steps, because loading the take-up reel
while printing requires you to complete the procedure while the printer is feeding and
printing paper. Loading the take-up reel during printing saves approximately 1 m (3 feet)
of paper.

If the take-up reel is not enabled and you would like to enable it, select the  icon, and then
select Take-up reel > Enable.

NOTE: During the initial printer set up, printhead alignment and color calibration is performed
automatically after the roll is loaded into the printer.

Unload a roll from the printer
NOTE: If you used the take-up reel (a standard feature on the 60–inch printer and an optional
accessory on the 42–inch printer) during printing, unload the printed roll from the take-up reel
before attempting to remove the roll from the printer. See Unload a roll from the take-up reel
on page 43.

Initiate the procedure for unloading a roll from the printer the front panel or by lifting the paper-load lever.
In either case, a front-panel animation guides you through the remainder of the procedure.

Before unloading a roll, check whether the end of the roll is still attached to the spindle, and follow the
appropriate procedure as described in the following sections.
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The normal procedure (roll attached to spindle)
If the end of the roll is still attached to the spindle, use the following procedure.

1.
On the printer's front panel, select the  icon, and then select Unload paper.

2. The paper is ejected from the printer.

If for some reason the paper is not automatically ejected from the printer, the front-panel display
prompts you to lift the paper-load lever and wind the roll by hand until the paper leaves the printer.
When you have finished, lower the paper-load lever.

3. Turn the hub by hand, until the paper is fully wound onto the roll.

4. Press the OK button.

5. Remove the roll from the printer, pulling out the right end on the right side of the printer first. Do not
insert your fingers into the spindle supports during the removal process.

Roll is detached from spindle
Use the following procedure if the end of the roll is visible but no longer attached to the spindle:

1. If you have already selected Paper unload at the front panel, press the Cancel button to cancel
that procedure.

2. Lift the paper-load lever. If the front panel shows a warning about the lever, ignore it.

3. Pull out the paper from the front of the printer.

4. Remove the empty spindle from the printer, pulling out the end on the right side of the printer first.
Do not insert your fingers into the spindle supports during the removal process.

5. Lower the paper-load lever.

6. If the front panel shows a warning message, press the OK button to clear it.

No paper visible
Use this procedure if the end of the roll has entirely disappeared into the printer:

1. Press the Form Feed and Cut button on the front panel to eject the remaining paper.

2. Remove the empty spindle from the printer, pulling out the end on the right side of the printer first.
Do not insert your fingers into the spindle supports during the removal process.
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Use the take-up reel
CAUTION: Make sure the printer is turned off when installing the take-up reel motor on the
printer.

The take-up reel must be enabled and operated from the front panel. When the take-up reel is enabled,
the “Take-up reel enabled” message appears on the Paper tab on the front panel. If the take-up reel is

not enabled and you would like to enable it, select the  icon and then select Take-up reel >
Enable.

Follow these guidelines when taping rolls to the take-up reel spindle core:

● Make sure that the paper is straight when it is attached to the spindle core. Otherwise it skews as it
winds onto the core.

● The spindle core on the take-up reel must be the same width as the paper that you are using.

● Check that neither side of the spindle core has end caps, and make sure the spindle core is pushed
firmly into both spindle guides.

● If you are using a HP Designjet Z6100 42–in Printer, make sure that the bin loop is placed behind
the foot brace so that it does not block the take-up reel sensors.

NOTE: If you want to load the take-up reel during printing, familiarize yourself with the
procedural steps. Loading the take-up reel during printing requires you to complete the procedure
while the printer is feeding and printing paper. Loading the take-up reel during printing saves
approximately 1 m (3 feet) of paper.

Load a roll onto the take-up reel
1.

On the printer's front panel, select the  icon, and then select Take-up reel > Load take-up
reel.

2. If you want to load the take-up reel now, select Load take-up reel now on the front panel. If you
want to load the take-up reel during printing, select Load it during printing on the front panel.

3. Make sure that the take-up reel deflector is in its upright position.
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4. Unlock the take-up reel spindle by pushing the spindle lever to its uppermost position.

5. Remove the take-up reel spindle.

6. The front-panel display guides you through the process of loading the take-up reel spindle core onto
the take-up reel spindle. When that task is complete, load the take-up reel spindle into the printer by
pushing firmly on both ends of the spindle.
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7. Press the OK button on the front panel, and then select a winding direction.

The printer advances the paper. Make sure that the paper passes in front of the take-up reel deflector,
as shown.

8. Pull the paper taut to the position shown in the following figure. Do not attempt to pull more paper
out of the printer. Use tape to secure the paper to the spindle core. You might need to use more tape
than is shown in the following image. The paper should be secure enough to support the weight of
the loop-shaping core, which you insert in step 12.

NOTE: If you are loading the take-up reel during printing you do not need to pull the paper
taut. Tape the paper to the spindle core when an adequate length of paper has fed from the
printer after printing begins.

NOTE: To avoid having the paper skew as it winds onto the spindle core, make sure the
paper is straight when you attach it. It is sometimes useful to use the core grooves to align the
paper.

40 Chapter 4   Handle the paper

H
a
nd

le the p
a
p
er



9. Press the OK button on the front panel. The printer advances the paper.

NOTE: Make sure that you insert the loop-shaping core. The take-up reel will not function
correctly without it. The loop-shaping core must have end caps. Make sure that the end caps
extend over the edges of the paper.

10. Assemble a loop-shaping core by matching the shape-coded and color-coded lengths of plastic
tubing. The loop-shaping core must be the same width as the paper that you are using. Make sure
that both end caps are firmly fitted on the ends of the loop-shaping core.

NOTE: The front-panel display shows the required length of the loop-shaping core based
on the width of the roll that you have loaded into the printer.

11. Gently lower the take-up reel deflector.
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12. Carefully insert the loop-shaping core.

NOTE: Make sure that you insert the loop-shaping core. The take-up reel will not function
correctly without it. The loop-shaping core must have end caps. Make sure that the end caps
extend over the edges of the paper.

13. Use the wind-direction switch on the take-up reel motor to select the winding direction. Setting 1
winds the paper so that the printed image faces in. Setting 2 winds the paper so that the printed
image faces out.

The front panel shows you to the correct setting based on the winding-direction decision you made
in step 7.

14. Press the OK button on the front panel. The Take-up reel has been successfully installed
message appears.

15. The following image shows how the printer looks when it is operating. As paper is fed from the
printer, it drops down in a loop and then up into the take-up reel spindle.

NOTE: While the take-up reel is operating, make sure that the take-up reel sensors are not
blocked.

NOTE: The automatic paper-cutter is disabled when the take-up reel is in use.
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NOTE: If you want to move the printer, first remove the take-up reel sensor and cable housing
unit from the foot of the printer stand. Place the sensor and cable housing unit on the printer stand
crossbar and use the blue plastic screw to affix the housing unit to the leg of the stand, as shown,
while the printer is being moved. When reinstalling the housing unit, make sure that the wheel on
the foot of the printer stand is pointing forward.

Unload a roll from the take-up reel
1.

On the printer's front panel, select the  icon, and then select Paper unload > Unload roll.

The printer advances the paper to allow for cutting.

2. Lift the take-up reel deflector to its upright position.

3. Switch the wind-direction switch to the Off position. The switch is in the off position when it is centered
(in other words, when the switch is neither in position 1 nor position 2).
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4. Remove the loop-shaping core.

5. Use the winding button on the take-up reel motor to wind the excess paper around the take-up reel
spindle.

6. Press the OK button on the front panel.

7. The printer knows if the type of paper that is loaded is suitable for the automatic paper-cutter. The
paper is cut if it is suitable. If the paper is not suitable, cut the paper manually.

NOTE: The automatic paper-cutter feature is disabled for some of the heaviest media types,
because they can damage the cutter.
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8. Use the winding button on the take-up reel motor to wind the remainder of the paper around the take-
up reel spindle.

9. Press the OK button on the front panel.

The amount of printed paper that is on the take-up reel spindle appears on the front panel.

10. Unlock the take-up reel spindle by pushing the spindle lever to its uppermost position.

11. Remove the roll from the printer, pulling out the end on the right side of the printer first. Do not insert
your fingers into the spindle supports during the removal process.

12. To remove the roll from the printer after you have unloaded the take-up reel, see Unload a roll from
the printer on page 36.

View information about the paper

On the printer's front panel, select the  icon, and then select View loaded paper > View paper
details.

The following information appears on the front panel:

● The roll status

● The paper type that you have selected
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● The width of the paper in millimeters (estimated by the printer)

● The length of the paper in millimeters (estimated by the printer)

If no paper is loaded, the message Out of paper appears.

The same information appears on the Embedded Web Server's Supplies page.

Perform paper advance calibration
The printer is calibrated to advance correctly when printing all the papers that appear on the front panel.
When you select the type of loaded paper, the printer adjusts the rate at which it advances the paper
while printing. However, to fine-tune the image quality of your print, you might need to calibrate the rate
at which the paper advances. See Troubleshoot print-quality issues on page 148 to determine whether
paper-advance calibration is the solution for your issue.

Accurate paper advance controls proper placement of dots on the paper. If the paper is not advanced
correctly, light or dark bands appear in the printed image and the grain in the image might increase.

To check the paper advance calibration status of the paper, select the  icon, and then select View
loaded paper > View paper details. The status appears:

● DEFAULT: this status appears when an HP paper is loaded. Unless you experience image-quality
problems in your printed image, such as banding or graininess, HP recommends that you do not
calibrate the paper advance.

● RECOMMENDED: this status appears when you create a new paper. The paper advance values
for this paper are inherited from the family type. HP recommends that you perform a paper advance
calibration to optimize the values.

● OK: this status indicates that the loaded paper has been calibrated previously. However, you might
need to repeat the calibration if you experience image-quality problems, such as banding or
graininess in your printed image.

NOTE: Whenever you update the printer firmware, the paper-advance calibration values
are reset to the factory default. See Update the printer firmware on page 141.

NOTE: Colored papers, glossy canvas, and transparent materials such as translucent bond,
clear film, natural tracing paper, and vellum are not suitable for paper-advance calibration.

Overview of the paper advance procedure
1.

On the front panel, select the  icon, and then select Image quality maintenance > Paper
advance calibration > Calibrate paper advance. The printer automatically calibrates the
paper-advance and prints a paper advance calibration image.

2. Wait until the front panel shows the status screen, and then reprint your image.

NOTE: The calibration procedure takes approximately six minutes. The front-panel display
shows any errors in the process.

If you are satisfied with your image, continue using this calibration for your paper type. If you see
improvement in your image, continue with step 3. If you are dissatisfied with the calibration, return
to the default calibration. See Return to the default calibration on page 47.

3.
To fine-tune the calibration, select the  icon, and then select Image quality maintenance
> Paper advance calibration > Adjust paper advance.
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4. Select the percentage of change from -100% to 100%. To correct light banding, decrease the
percentage. To correct dark banding, increase the percentage.

5. Press the OK button on the front panel to save the value.

6. Wait until the front panel shows the status screen, and then reprint your image.

Return to the default calibration
Returning to the default calibration sets all the paper-advance calibration to zero. To return to the default
paper advance-calibration value, you must reset the calibration.

1.
On the front panel, select the  icon, and then select Image quality maintenance > Paper
advance calibration > Reset paper advance.

2. Wait until the front panel shows that the operation has been successfully completed before you press
the Back button to return to the Ready screen.

Download paper profiles
Each supported paper type has its own characteristics. The printer changes the way it prints on each
different paper type. For example, some might need more ink and some might require a longer drying
time. The printer requires a description of the requirements of each paper type. This description is called
the “paper profile”.

The paper profile contains the ICC profile, which describes the color characteristics of the paper. It also
contains information about other characteristics and requirements of the paper that are not directly related
to color. Existing paper profiles for your printer are installed in the printer's software.

Your printer contains paper profiles for only the most commonly used paper types. If you buy a paper
type for which your printer has no profile, you cannot select that paper type in the front panel.

You can assign a profile for a new paper type in three ways:

● Use a HP factory paper profile by selecting the closest category and type on the front panel, in HP
Easy Printer Care (Windows), or in HP Printer Utility (Mac OS)

NOTE: Because colors might not be accurate, this method is not recommended for high-
quality prints.

● Go to http://www.hp.com/go/designjet/downloads and click the HP Designjet ICC/Media
profiles and PANTONE tables link. Select from the HP Designjet media profiles drop-down
menu.

NOTE: HP only provides profiles for HP paper types. If you do not find the paper profile
that you want on the Web, it might have been added to the latest firmware for your printer.
Check the firmware release notes for information. See Update the printer firmware
on page 141.

● Add a custom paper type. See Use non-HP paper on page 47, and create an ICC profile for either
HP or non-HP papers.

Use non-HP paper
HP paper has been fully tested with the printer and can be expected to give the best print quality.

Download paper profiles 47

H
a
nd

le
 t

he
 p

a
p
er

http://www.hp.com/go/designjet/downloads


You can print on paper from any manufacturer. Before doing so, add the custom paper type and allow
the printer to run a color calibration. You can add a custom paper by using the HP Color Center in HP
Easy Printer Care (Windows) or HP Printer Utility (Mac OS).

NOTE: If you have already selected Custom paper > Add Custom Paper from HP Easy
Printer Care (Windows) or HP Printer Utility (Mac OS), the first Add New Paper screen appears
and you can start this procedure at step 4.

1. Go to the Color Center in HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS).

2. Select Manage Papers.

3. In Windows, select Add new paper. In Mac OS, click +.

4. Type the paper name.

NOTE: HP recommends that you use the commercial name of the paper so that other users
recognize it.

5. Select a paper category.

NOTE: The paper category determines the amount of ink that is used and other basic
printing parameters. To obtain satisfactory results, experiment with different categories and
use the ones that work best.

6. Load the custom paper. See Load a roll into the printer on page 32.

7. Click Next. The printer performs a color calibration and prints a calibration chart. This can take up
to 10 minutes.

NOTE: For more information on the processes available in the Color Center, see A summary
of the color-management process on page 109.

8. After the new calibration parameters are calculated and stored, you are reminded to create an ICC
profile. Click Done. The custom paper is added to the paper category you selected.

9. To create an ICC profile, which allows you to print on your paper with the best possible color
accuracy, see Color profiling on page 111.

Cancel the drying time
Press the Form Feed and Cut button (1) on the front panel.

CAUTION: A print that has not dried sufficiently can suffer from quality problems.
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Change the drying time
Change the drying time setting to accommodate special printing conditions.

Select the  icon, and then select Paper handling options > Select drying time. Select from the
options Extended, Optimal, Reduced, None or Manual.

If you select Manual, set the drying time. Select the  icon, and then select Paper handling
options > Manual drying time, and then select the drying time (in seconds).

For more information about drying time, see Drying time on page 28.

Printing paper info
Enable the Printing paper info option to see the printer's estimation of the remaining roll length. The
information is a combination of barcode and text that is printed on the leading edge of the roll when the
paper is unloaded from the printer.

NOTE: The paper-length estimation is only available if the printer registered the amount of paper
that was on the roll when you loaded it. To provide this informations to the printer, specify the roll
length on the front panel when loading the paper, or load a roll that has the paper-data barcode
printed on it.

To enable the Printing paper info option, select the  icon in the printer's front panel, and then
select Paper handling options > Enable Printing paper info.

Store the paper
The following are tips for storing paper:

● Always keep unused rolls wrapped in the plastic wrap to prevent discoloration. Rewrap partially
used rolls if they are not being used.

● Do not stack rolls.

● Allow all paper types to adapt to room conditions out of the packaging for 24 hours before printing.

● Handle film and glossy paper by the edges or wear cotton gloves. Skin oils can be transferred to the
paper, leaving fingerprint marks.

● Keep the paper tightly wound on the roll throughout the loading and unloading procedures. If the
roll starts to unwind, it can become difficult to handle.

Order paper
The following paper types are currently provided for use with your printer.

NOTE: This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/designjet/supplies/.
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Key to geographic availability:

● (As) indicates papers that are available in Asia

● (A) indicates papers that are available in Asia (excluding Japan)

● (J) indicates papers that are available in Japan only

● (E) indicates papers that are available in Europe, the Middle East, and Africa

● (L) indicates papers that are available in Latin America

● (N) indicates papers that are available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

Table 4-2  Paper

Paper type g/m² Length Width Part numbers

HP Bond and Coated Paper

HP Universal Inkjet Bond Paper 80 150 feet = 45.7 m 24 inches = 610 mm Q1396A

36 inches = 914 mm Q1397A

42 inches = 1067 mm Q1398A

300 feet = 91.4 m 23.39 inches = 594
mm

Q8004A (AsE)

33.11 inches = 841
mm

Q8005A (AsE)

574 feet = 175 m 36 inches = 914 mm Q8751A

HP Bright White Inkjet Bond Paper 90 150 feet = 45.7 m 16.54 inches = 420
mm

Q1446A (J)

23.39 inches = 594
mm

Q1445A (J)

24 inches = 610 mm C1860A (LN),
C6035A (AsE)

33.11 inches = 841
mm

Q1444A (EJ)

36 inches = 914 mm C1861A (LN),
C6036A (AsE)

300 feet = 91.4 m 36 inches = 914 mm C6810A

HP Universal Coated Paper 95 150 feet = 45.7 m 24 inches = 610 mm Q1404A (AsEN)

36 inches = 914 mm Q1405A (AsEN)

42 inches = 1067 mm Q1406A

60 inches = 1524 mm Q1408A (AEN)
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Paper type g/m² Length Width Part numbers

HP Coated Paper 90 150 feet = 45.7 m 16.54 inches = 420
mm

Q1443A (J)

23.39 inches = 594
mm

Q1442A (EJ)

24 inches = 610 mm C6019B

33.11 inches = 841
mm

Q1441A (EJ)

36 inches = 914 mm C6020B

42 inches = 1067 mm C6567B

54 inches = 1372 mm C6568B

300 feet = 91.4 m 36 inches = 914 mm C6980B

HP Universal Heavyweight Coated
Paper

120 100 feet = 30.5 m 24 inches = 610 mm Q1412A (EAsN)

36 inches = 914 mm Q1413A

42 inches = 1067 mm Q1414A (EAsN)

HP Heavyweight Coated Paper 131 100 feet = 30.5 m 24 inches = 610 mm C6029C (AsEN)

36 inches = 914 mm C6030C

42 inches = 1067 mm C6569C

54 inches = 1372 mm C6570C

60 inches = 1524 mm C6977C

225 feet = 67.5 m 42 inches = 1067 mm Q1956A (EN)

60 inches = 1524 mm Q1957A (EN)

HP Super Heavyweight Plus Matte
Paper

210 100 feet = 30.5 m 24 inches = 610 mm Q6626A (AsEN)

36 inches = 914 mm Q6627A (AsEN)

42 inches = 1067 mm Q6628A (AsEN)

50 inches = 1270 mm Q6629A (AsN)

60 inches = 1524 mm Q6630A (AsEN)

HP Coloured Paper Fluorescent
Yellow

100 150 feet = 45.7 m 36 inches = 914 mm Q1757A (E)

HP Coloured Paper Yellow 92 150 feet = 45.7 m 36 inches = 914 mm C1760A (EN)

50 inches = 1270 mm C6588A (E)

HP Technical Paper

HP Natural Tracing Paper 90 150 feet = 45.7 m 16.54 inches = 420
mm

Q1440A (J)

23.39 inches = 594
mm

Q1439A (J)

24 inches = 610 mm C3869A

33.11 inches = 841
mm

Q1438A (J)

36 inches = 914 mm C3868A

Table 4-2  Paper (continued)
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Paper type g/m² Length Width Part numbers

HP Translucent Bond 67 150 feet = 45.7 m 24 inches = 610 mm C3860A (AsN)

36 inches = 914 mm C3859A (NL)

HP Vellum 75 150 feet = 45.7 m 24 inches = 610 mm C3862A (N)

36 inches = 914 mm C3861A (NL)

HP Film (technical and graphic)

HP Clear Film 174 75 feet = 22.9 m 24 inches = 610 mm C3876A (AsEN)

36 inches = 914 mm C3875A

HP Matte Film 160 125 feet = 38.1 m 24 inches = 610 mm 51642A (AsEN)

36 inches = 914 mm 51642B

HP Polyester Film White Matte 185 50 feet = 15 m 36 inches = 914 mm Q1736A (AEN)

HP Photographic Paper

HP Universal Instant-Dry Photo Gloss 190 100 feet = 30.5 m 24 inches = 610 mm Q6574A

36 inches = 914 mm Q6575A

42 inches = 1067 mm Q6576A

60 inches = 1524 mm Q6578A

200 feet = 61 m 42 inches = 1067 mm Q8754A

60 inches = 1524 mm Q8756A

HP Universal Instant-Dry Photo Semi-
Gloss

190 100 feet = 30.5 m 24 inches = 610 mm Q6579A

36 inches = 914 mm Q6580A

42 inches = 1067 mm Q6581A

50 inches = 1270 mm Q6582A

60 inches = 1524 mm Q6583A

200 feet = 61 m 42 inches = 1067 mm Q8755A

60 inches = 1524 mm Q8757A

HP Premium Instant-Dry Gloss Photo
Paper

260 100 feet = 30.5 m 36 inches = 914 mm Q7993A (AsLEN)

42 inches = 1067 mm Q7995A (AsLEN)

50 inches = 1270 mm Q7997A (AsLN)

60 inches = 1524 mm Q7999A (AsLEN)

75 feet = 22.9 m 24 inches = 610 mm Q7991A (AsLEN)

HP Premium Instant-Dry Satin Photo
Paper

260 100 feet = 30.5 m 36 inches = 914 mm Q7994A (AsLEN)

42 inches = 1067 mm Q7996A (AsLEN)

50 inches = 1270 mm Q7998A (AsLN)

60 inches = 1524 mm Q8000A (AsLEN)

75 feet = 22.9 m 24 inches = 610 mm Q7992A (AsLEN)

HP Professional Satin Photo Paper 300 50 feet = 15.2 m 24 inches = 610 mm Q8759A (AsLEN)

44 inches = 1118 mm Q8840A

Table 4-2  Paper (continued)
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Paper type g/m² Length Width Part numbers

HP Photo Paper RC Matte 200 100 feet = 30.5 m 36 inches = 914 mm C7946A (AEN)

54 inches = 1372 mm C7947A (AEN)

HP Proofing Paper

HP Professional High-Gloss Contract
Proofing Paper

200 100 feet = 30.5 m 24 inches = 610 mm Q8663A (EN)

HP Professional Semi-Gloss Contract
Proofing Paper

235 100 feet = 30.5 m 24 inches = 610 mm C7971A (EN)

HP Proofing Matte 146 100 feet = 30.5 m 24 inches = 610 mm Q1968A (AsEN)

HP Backlit Material

HP Premium Vivid Color Backlit Film 285 100 feet = 30.5 m 36 inches = 914 mm Q8747A

42 inches = 1067 mm Q8748A

54 inches = 1372 mm C8749A

60 inches = 1524 mm Q8750A

HP Self-Adhesive Material

HP Indoor Paper Self-Adhesive 170 75 feet = 22.9 m 36 inches = 914 mm Q1733A (JEN)

60 inches = 1524 mm Q1735A (EN)

HP Polypropylene, Matte —
Adhesive Backed

200 70 feet = 21.3 m 36 inches = 914 mm Q1908A (AEN)

HP Colorfast Adhesive Vinyl 328 40 feet = 12.2 m 36 inches = 914 mm C6775A

54 inches = 1372 mm C6777A (EN)

HP Universal Adhesive Vinyl 290 66 feet = 20.1 m 36 inches = 914 mm Q8676A

42 inches = 1067 mm Q8677A

HP Self-Adhesive Gloss
Polypropylene

176 75 feet = 22.9 m 36 inches = 914 mm Q8834A

42 inches = 1067 mm Q8835A

HP Banner and Sign Material

HP Durable Display Film 205 50 feet = 15.2 m 36 inches = 914 mm Q6620A (EN)

50 inches = 1270 mm Q6621A (EN)

HP Instant-Dry Indoor Banner, Gloss 195 50 feet = 15.2 m 36 inches = 914 mm Q5482A (N)

42 inches = 1067 mm Q5483A (AsN)

50 inches = 1270 mm Q5484A (N)

HP Polypropylene, Matte 130 75 feet = 22.9 m 36 inches = 914 mm Q1903A (AEN)

42 inches = 1067 mm Q1904A (AEN)

54 inches = 1372 mm Q1906A (AEN)

60 inches = 1524 mm Q1907A (AEN)
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Paper type g/m² Length Width Part numbers

HP Opaque Scrim 486 50 feet = 15.2 m 36 inches = 914 mm Q1898B

42 inches = 1067 mm Q1899B

54 inches = 1372 mm Q1901B

60 inches = 1524 mm Q1902B

HP Banners with Tyvek 140 50 feet = 15.2 m 36 inches = 914 mm C6787A

54 inches = 1372 mm C6789A

HP Outdoor Paper 145 100 feet = 30.5 m 36 inches = 914 mm Q1730A (EN)

HP Outdoor Billboard Paper Blue
Back

140 100 feet = 30.5 m 36 inches = 914 mm C7949A (EN)

54 inches = 1372 mm C7950A (EN)

HP Fabric / Textile Material

HP Durable Flag Fabric 110 33 feet = 10 m 36 inches = 914 mm Q6624A (EN)

HP Paper-Backed Fabric Polyester
110 gram 11.4 mil

110 (no
backing)

185 (with
backing)

33 feet = 10 m 36 inches = 914 mm Q1745A (EN)

HP Paper-Backed Fabric Silk Satin 63.5 (no
backing)

160 (with
backing)

33 feet = 10 m 36 inches = 914 mm Q1748A (EN)

HP Fine Art Printing Material

HP Collector Satin Canvas 400 20 feet = 6.1 m 24 inches = 610 mm Q8708A (AsLEN)

50 feet = 15.2 m 36 inches = 914 mm Q8709A (AsLEN)

42 inches = 1067 mm Q8710A (AsLEN)

60 inches = 1524 mm Q8711A (AsLEN)

HP Professional Matte Canvas 430 20 feet = 6.1 m 24 inches = 610 mm Q8673A (LEN)

50 feet = 15.2 m 36 inches = 914 mm Q8671A (LEN)

42 inches = 1067 mm Q8674A (LEN)

60 inches = 1524 mm Q8672A (LEN)

HP Artist Matte Canvas 380 20 feet = 6.1 m 24 inches = 610 mm Q8704A (AsLEN)

50 feet = 15.2 m 36 inches = 914 mm Q8705A (AsLEN)

42 inches = 1067 mm Q8706A (AsLEN)

60 inches = 1524 mm Q8707A (AsLEN)

HP Universal Matte Canvas 350 20 feet = 6.1 m 24 inches = 610 mm Q8712A (AsLEN)

50 feet = 15.2 m 36 inches = 914 mm Q8713A (AsLEN)

42 inches = 1067 mm Q8714A (AsLEN)

HP Canvas Paper 180 gram 180 35 feet = 10.7 m 36 inches = 914 mm Q1724A (AEN)

HP Aquarella Art Paper 240g 240 35 feet = 10.7 m 24 inches = 610 mm Q8741A (EN)

36 inches = 914 mm Q1703A (EN)

HP Hahnemühle Watercolor Paper 210 38 feet = 11.6 m 36 inches = 914 mm Q1984A (EN)

Table 4-2  Paper (continued)
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Paper type g/m² Length Width Part numbers

HP Hahnemühle Smooth Fine Art
Paper

265 35 feet = 10.7 m 24 inches = 610 mm Q8732A (EN)

36 inches = 914 mm Q1985A (EN)

42 inches = 1067 mm Q8733A (EN)

HP Hahnemühle Textured Fine Art
Paper

265 35 feet = 10.7 m 24 inches = 610 mm Q8736A (EN)

36 inches = 914 mm Q1937A (EN)

42 inches = 1067 mm Q8738A (EN)

HP Matte Litho-Realistic Paper 270 100 feet = 30.5 m 36 inches = 914 mm Q7973A (EN)

24 inches = 610 mm Q7972A

Japan-Only HP Printing Material

HP Yupo Synthetic Paper (other
specialty)

81.5 100 feet = 30.5 m 36 inches = 914 mm Q1432A (J)

54 inches = 1372 mm Q1434A (J)

Non-recommended paper types
In many cases, paper types that HP does not support might be compatible with your printer. However,
the following paper types are unlikely to give satisfactory results:

● Photo paper that swells

● Brochure paper

Table 4-2  Paper (continued)
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5 Handle the ink system

● Ink system components

● Ink system tips

● Work with ink system components

● Order ink supplies
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Ink system components
Ink cartridges

The printer's eight ink cartridges provide magenta, light magenta, photo black, matte black, yellow, light
cyan, light gray and cyan ink to the printheads. Each cartridge has a capacity of 775 ml.

Ink cartridges require no maintenance or cleaning. When each ink cartridge is shaken vigorously before
installation, and inserted correctly into its slot, the ink will flow to the printheads. Because the printheads
control the amount of ink that is transferred to the page, high-quality printing results continue even when
the ink levels are getting low.

CAUTION: Avoid touching pins, leads, and circuitry when handling ink cartridges because
these elements are sensitive to electrostatic discharge. Such devices are called ESD-sensitive
devices. See Glossary on page 216. Electrostatic discharges are one of the main hazards to
electronics products. This type of damage can reduce the life expectancy of the device.

Replace ink cartridges

You can highlight the  icon at any time to check the ink levels of all the ink cartridges.

The front panel warns you when cartridge ink level is low. When a cartridge is empty, the printer stops
printing and the front panel provides an explanation.

HP recommends that you replace the empty cartridge with a new HP cartridge. See Order ink supplies
on page 78, Remove an ink cartridge on page 59, and Insert an ink cartridge on page 61.

Printheads
The printheads are connected to the ink cartridges. They use jet action to put ink on the paper. Each
printhead has two ink cartridge connection points and two jet nozzles, which means that each printhead
accommodates two ink cartridges. For example, the following printhead image indicates a printhead that
draws and jets ink from the magenta and yellow cartridges.
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The printheads are extremely durable and do not need to be replaced every time an ink cartridge is
replaced. They provide excellent results even when the ink cartridges contain a low level of ink.

To maintain optimum print quality, the printheads are automatically tested at regular intervals, and
automatically serviced when necessary. This takes a little time and can occasionally delay printing.

When a printhead eventually needs to be replaced, the front panel will display a message.

CAUTION: Avoid touching pins, leads, and circuitry when handling ink cartridges because
these elements are sensitive to electrostatic discharge. Such devices are called ESD-sensitive
devices. See Glossary on page 216. Electrostatic discharges are one of the main hazards to
electronics products. This type of damage can reduce the life expectancy of the device.

Maintenance cartridge
Use the maintenance cartridge to clean and maintain the printheads, ensure the best possible print quality,
and seal the printheads when they are not in use to prevent them from drying out.

NOTE: The maintenance cartridge contains liquid. Therefore, store any maintenance cartridges
upright and on a flat surface.

Ink system tips
For best results, always follow these guidelines:

● Install the ink cartridges, printheads, and maintenance cartridge before the install-by date, which is
printed on the packaging. The expiration for the ink cartridges is the manufacturing date marked on
the cartridge plus 30 months.

● Follow the instructions on the front panel during installation.

● Allow the printer and the maintenance cartridge to clean the printheads automatically.

● Avoid unnecessary removal of the ink cartridges and printheads.

● The ink cartridges should never be removed while the printer is printing. They should be removed
only when the printer is ready for you to replace them. The front panel guides you through the removal
and installation procedures (or see Remove an ink cartridge on page 59 and Insert an ink
cartridge on page 61.

● Make sure that you comply with all applicable laws and regulations when disposing of ink system
consumables.
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NOTE: Shake the ink cartridges and printheads vigorously before installing them. See Insert an
ink cartridge on page 61 and Insert a printhead on page 64.

Work with ink system components
Remove an ink cartridge

Ink cartridges should be removed for the following two reasons:

● The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing.
You can use the remaining ink in the first cartridge at a more convenient time.

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: The procedure to remove an ink cartridge must be initiated from the front panel. Do
not remove an ink cartridge until the front panel prompts you.

CAUTION: Remove an ink cartridge only if you are ready to insert another one.

WARNING! Make sure that the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.

1.
On the printer's front panel, select the  icon, and then select Replace ink cartridges.

2. Grip the blue tab in front of the cartridge that you want to remove.
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3. Pull the blue tab down and then pull it outwards, towards you.

4. The cartridge comes out, in its drawer.

5. Lift the cartridge out of its drawer.

NOTE: Avoid touching the end of the cartridge that is inserted into the printer, because the
connection might be coated with ink.

NOTE: If necessary, store a partially-used ink cartridge in the same position as if it were
inserted in the printer. Avoid using a partially-used cartridge that has been stored on its end.

6. The front-panel display identifies the missing ink cartridge.
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Insert an ink cartridge
1. Pick up the new ink cartridge and find the label that identifies the ink color. Hold the ink cartridge

so that you can see the label at the top of the side that is facing you.

2. Check that the colored label above the empty slot in the printer matches the color of the label on the
cartridge.

3. Shake the cartridge vigorously for about 15 seconds.

4. Insert the ink cartridge into the cartridge drawer.

5. Slide the drawer and cartridge into the slot until they lock into position.

If you have difficulty, see Cannot insert an ink cartridge on page 168.

6. The front-panel display confirms that all cartridges have been correctly inserted.

Remove a printhead

WARNING! Make sure that the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.
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Printhead replacement must be performed after the printer has been turned on with the hard power switch
at the back of the printer.

1.
On the printer's front panel, select the  icon, and then select Replace printheads.

2. The printer moves the carriage into the correct position.

CAUTION: If the carriage remains in the removal position for more than 3 minutes without
inserting or removing any printheads, it will attempt to return back to its home position to the
right.

3. When the carriage has stopped moving, the front panel prompts you to open the printer window.

4. Locate the carriage on the right side of the printer.

5. Pull up and release the latch on top of the carriage.
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6. Lift up the cover. This provides access to the printheads.

7. To remove a printhead, lift up the blue handle.

8. Using the blue handle, gently disengage the printhead.

9. Gently pull the blue handle upward until the printhead is released from the carriage.

CAUTION: Do not pull abruptly. That action can damage the printhead.
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10. The front-panel display identifies the missing printhead.

Insert a printhead
1. If the printhead is new, shake it vigorously before removing the protective caps. Hold the printhead

upright (with the protective caps facing down) and shake the printhead vigorously in a smooth up
and down motion for about 15 seconds.

NOTE: Be careful not to strike the printhead against anything while shaking it, because this
could cause damage.

2. Remove the orange protective caps by pulling them down.

3. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check
that the colored label on the printhead matches the colored label of the carriage slot into which the
printhead is to be inserted.
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4. Insert the new printhead into its correct slot in the carriage.

CAUTION: Insert the printhead slowly and vertically, straight down. It can be damaged if
you insert it too quickly, or at an angle, or if you rotate it as you insert it.

5. Push down as indicated by the arrow.

CAUTION: You might feel some resistance when installing the new printhead, so you need
to press it down firmly but smoothly. You should hear a beep and see confirmation on the
front-panel display that the printhead has been inserted. If you have difficulty, see Cannot
insert a printhead on page 168.

6. Insert all of the other printheads that need to be installed, and close the carriage cover.

Work with ink system components 65

H
a
nd

le
 t

he
 in

k
 s

ys
te

m



7. Make sure that the end of the blue handle catches the wire loop on the near side of the carriage.

8. Lower the handle to rest on the carriage cover.

When all of the printheads have been inserted correctly and the printer has accepted them, the printer
beeps.

NOTE: If the printer does not beep when you insert the printhead and the Replace message
appears on the front-panel display, you might need to reinsert the printhead.

9. Close the printer window.

10. The front-panel display confirms that all of the printheads are correctly inserted. The printer starts
checking and preparing the printheads. The default routine process, when all printheads are
changed, takes about 18 minutes. If the printer identifies a problem when preparing the printheads,
the process takes longer, up to 30 minutes. For a single printhead insertion, the time varies between
10 and 20 minutes. After all printheads are checked and prepared, the printhead realignment
procedure runs automatically if paper is loaded. See Align the printheads on page 71.

Clean (recover) the printheads
To clean the printheads (which often enables them to recover from problems), go to the printer's front

panel and select the  icon, and then select Image quality maintenance > Clean
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printheads. Specify which printheads you would like to clean. You can clean all of the printheads or
only some of them. Select from these options:

● Clean all

● Clean M-Y

● Clean LM-LC

● Clean PK-LG

● Clean MK-C

● Purge ink

Cleaning all printheads takes about 5 minutes. Cleaning any two printheads takes about 3 minutes.
Purging the ink takes about 5 minutes.

NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

NOTE: HP recommends that you purge the ink from the printheads before printing a job if the
printer has been turned off for more than six weeks or if you are experiencing inconsistent colors
from print to print after long storage periods. Purging the ink from the printheads helps to ensure
maximum color consistency; it is not a remedy for poor printhead health.

Clean the electrical connections on a printhead
It is possible that the printer will not recognize a printhead after it has been installed. This can happen
when ink builds up on the electrical connections between the printhead and the printhead carriage. Under
these circumstances, HP recommends that you clean the electrical connections on the printhead. However,
routine cleaning of the connections when no problems are apparent is not recommended.

A carriage interconnect wiper is included with your printer (in the Maintenance Kit box).

Use this to clean the electrical interconnects on both the printhead carriage and the printhead if the
Reseat or Replace message persists next to the printhead on the front-panel display.

1. Remove a new pre-moistened replacement sponge from its pouch.

A supply of sponges is included in the box with the wiper. If all sponges have been used, more can
be obtained by contacting your HP customer service representative.
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2. Open the carriage interconnect wiper.

3. Load the sponge by positioning the sponge on the face of the carriage interconnect wiper with the
shorter tab in the locating slot.

4. Close the carriage interconnect wiper, trapping the sponge in place.

5. Open the printhead carriage latch and extract the printhead that is causing the problem, as indicated
on the front panel. See Remove a printhead on page 61.
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6. Insert the carriage interconnect wiper into the printhead slot at the back. Wipe the electrical contacts
by inserting the tool between the electrical connections at the back of the slot and the steel spring,
with the sponge facing away from you and towards the electrical contacts. Try to avoid picking up
any ink deposit that may have accumulated on the bottom surface of the slot.

CAUTION: If the carriage remains in the central part of the printer for more than 7 minutes,
it attempts to return to its home position to the right.

7. Rub the sponge against the contacts with a light force along the entire depth of the flex connector,
inserting the wiper as far as allowed by the mechanical stop on the tool.

8. Take special care to clean all contacts thoroughly, including the ones at the lowest point of the
connector.
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9. Using the same sponge, clean the lower strip of electrical contacts on the printhead (unless the
printhead is new). Avoid touching the upper set of electrical contacts.

CAUTION: Do not touch the surface of the printhead that contains the nozzles, because
the nozzles are easily damaged.

10. After waiting a few moments to allow both connectors to dry, replace the printhead into the printhead
carriage. See Insert a printhead on page 64.

11. After completing the cleaning process, open the carriage interconnect wiper by pulling on the sponge
tab.

12. Remove the soiled sponge from the carriage interconnect wiper.

13. Dispose of the soiled sponge in a safe place to prevent the transfer of ink onto hands and clothing.
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If the front panel continues to show the Reseat or Replace message, replace the printhead or contact
your HP customer service representative.

Align the printheads
The printer performs printhead alignment whenever printheads are replaced. If no paper is loaded when
a printhead is replaced, the printer will perform the alignment the next time you load paper.

Also align the printheads if the Printhead status plot indicates an alignment error. See Use the Printhead
status plot on page 71.

1. Make sure that you have a roll of opaque, white paper loaded in the printer. Colored papers, glossy
canvas, and transparent materials such as translucent bond, clear film, tracing paper, and vellum
are not suitable for printhead alignment.

2. To request printhead alignment (if the alignment is not being performed automatically), go to the

front panel, select the  icon, and then select Image quality maintenance > Align
printheads.

The process takes about 10 minutes and starts immediately, unless an image is currently being
printed. If a print job is in process, the alignment will be done as soon as the current print job is
finished.

NOTE: Occasionally, if the paper in the printer is very close to the beginning of a roll, the
front panel might report that the printer needs to feed up to 3 m (≈ 10 ft) of paper before
starting the printhead alignment. This is necessary to ensure a successful alignment. You can
continue with the printhead alignment and allow the printer to feed as much paper as
necessary, delay the alignment until later, or cancel the alignment.

Use the Printhead status plot
The Printhead status plot consists of patterns that are designed to highlight printhead-reliability problems.
It helps you to check the performance of the printheads that are currently installed in your printer, and to
determine whether any printhead is experiencing clogging or other problems.

Print the Printhead status plot
To print the Printhead status plot:

1. Use the same paper type that you were using when you detected a problem.

2. Verify that the selected paper type is the same as the paper type that is loaded into the printer.

3.
On the printer's front panel, select the  icon, and then select Image quality maintenance
> Printhead diagnostics image.

It takes about 2 minutes to print the Printhead status plot.
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Interpret the Printhead status plot
The print is divided into two parts, both of which test printhead performance.

● Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the
print quality that you will get from each color.

● Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part
complements the first, and detects how many faulty nozzles are on each printhead.

First look at the top part of the print. Each colored rectangle should be a uniform color without any
horizontal lines across it.

Then look at the bottom part of the print. For each individual colored pattern, make sure that most of the
dashes are present.

If you see horizontal lines in the top part and also see missing dashes in the bottom part for the same
color, the printhead for that color needs to be cleaned. However, if the rectangles look solid, do not worry
about a few missing dashes in the bottom part, because the printer can compensate for a few clogged
nozzles.

The graphic shown illustrates printhead 2 in a bad state:
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Corrective action

1. Clean any faulty printheads. See Clean the printheads on page 168. Then reprint the Printhead
status plot to see whether the problem has been solved.

2. If the problem persists, clean the printheads again, and reprint the Printhead status plot to see whether
the problem has been solved.

3. If the problem persists, consider cleaning your printheads manually. See Clean the printheads
on page 168. Also try reprinting your current print job, in case it now prints satisfactorily.

4. If the problem continues to persist, replace any persistently faulty printheads. See Work with ink
system components on page 59.

What to do if problems persist
If you still experience print-quality problems after applying the advice in this chapter, here are some
additional tips to consider:

● Try using a higher print-quality option. See Select print quality on page 80.

● Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about
the problem. You could also try using the correct HP driver, if that workaround is acceptable to you.
Download the latest HP drivers from http://www.hp.com/go/designjet/.

● If you are using a non-HP raster image processing (RIP), its settings might be incorrect. See the
documentation that came with the RIP.

● Verify that your printer firmware is up to date. See Update the printer firmware on page 141.

● Verify that you have the correct settings in your software program.

● Contact HP Support. See HP Customer Care on page 183.

Remove the maintenance cartridge
A message appears on the front panel when you must change the maintenance cartridge. Follow these
precautions when removing a maintenance cartridge:

● Be careful not to get ink on your hands. Ink might be on, around, and inside the replaced maintenance
cartridge.

● Always handle and store the replaced maintenance cartridge upright to avoid spilling any ink.

CAUTION: A message appears on the front panel when the maintenance cartridge is almost full
and again when it is completely full and must be changed. You can ignore the alert and continue
printing by pressing the OK button on the front panel. However, HP strongly recommends that you
change the maintenance cartridge when prompted. Ignoring the alert can result in serious damage
to the printer.
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WARNING! Make sure that the printer wheels are locked (the brake lever is pressed down) to
prevent the printer from moving.

1.
On the printer's front panel, select the  icon, and then select Replace maintenance ctg.

2. The maintenance cartridge is located in a slot underneath the front panel, at the front of the printer.
Open the door.

3. The maintenance cartridge has a handle on the front. To remove the cartridge, press inward and
upward as indicated by the arrow, until the cartridge is released.

4. Lift up the maintenance cartridge to remove it from the slot, and slide it out.

See also Insert the maintenance cartridge on page 75.
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Insert the maintenance cartridge
The plastic bag in which the new maintenance cartridge comes can be used to dispose of the old
maintenance cartridge.

1. Insert the maintenance cartridge into the slot, in the direction indicated by the arrow.

2. When the maintenance cartridge has been pushed all the way in, press inwards and downwards as
indicated, until it clicks into place.

If you have difficulty, see Cannot insert the maintenance cartridge on page 168.

NOTE: The front panel will not show the new maintenance cartridge until the door is closed.

3. When you have inserted the maintenance cartridge into the printer, close the door.

NOTE: The printer needs all the ink cartridges, printheads and maintenance cartridge to
be installed before it can continue.

4. If no paper is loaded, the front panel will instruct you to load some.

NOTE: Make sure that the printer window and the door to the right are closed after you replace
the supplies. The printer will not print while these are open.
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Check the status of the ink system
1. Access the Embedded Web Server. See Embedded Web Server setup options on page 23.

2. Go to the Supplies page on the Main tab.

The Supplies page shows you the status of the ink cartridges (including the ink levels), the printheads, the
maintenance cartridge, and the loaded paper.

Check the status of the ink cartridges

To view the ink levels in your ink cartridges, go to the printer's front panel and select the  icon.

To get more information about your ink cartridges, use the front-panel ink menu, HP Easy Printer Care
(Windows), or HP Printer Utility (Mac OS).

Ink menu procedure
1.

On the front panel, select the  icon, and then select Ink cartridge information.

2. Select the cartridge about which you want information.

3. The front panel shows the following information:

● Color

● Product name

● Product number

● Serial number

● Status

● Ink level, if known

● Total ink capacity in milliliters

● Expiration date

● Warranty status

● Manufacturer
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HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) procedures
● In HP Easy Printer Care (Windows), go to the Overview tab. The status of each cartridge appears

when you select Supply Status > Cartridges.

● In HP Printer Utility (Mac OS), select  Information > Printer Status.

Check the status of a printhead
The printer automatically checks and services the printheads after each print. Follow these steps to get
more information on your printheads.

1.
On the front panel, select the  icon, and then select Printhead information.

2. Select the printhead for which you want to see information.

3. The front panel shows the following information:

● Colors

● Product name

● Product number

● Serial number

● Status (See Front-panel error messages on page 179.)

● Volume of ink it has used

● Warranty status

You can also get most of this information without leaving your computer by using HP Easy Printer Care
(Windows) or HP Printer Utility (Mac OS).

NOTE: If the warranty status is See warranty note, this indicates that non-HP ink is being
used. Printer service or repairs required as a result of using "non-HP" ink are not covered under
warranty. See the Legal Information document for detailed warranty implications.

Check printer usage statistics
To check your printer-usage, statistics are available.

NOTE: The accuracy of the usage statistics is not guaranteed.

Printer statistics with HP Easy Printer Care (Windows) or HP Printer Utility (Mac
OS)

1. Access HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS). See HP Easy Printer Care
(Windows) or HP Printer Utility (Mac OS) setup options on page 25.

2. Go to the Usage window to view the total printer usage.

3. Under Windows, go to the Overview tab and click on the Printer usage link.

Under Mac OS, select Information > Printer Usage and click the Start button.
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Printer statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 23.

2. Go to the Usage page on the Main tab.

Order ink supplies
You can order the following ink supplies for your printer.

Table 5-1  Ink cartridges

Cartridge Capacity (ml) Part number

HP 91 Matte Black 775 ml Ink Cartridge 775 C9464A

HP 91 Photo Black 775 ml Ink Cartridge 775 C9465A

HP 91 Light Gray 775 ml Ink Cartridge 775 C9466A

HP 91 Cyan 775 ml Ink Cartridge 775 C9467A

HP 91 Magenta 775 ml Ink Cartridge 775 C9468A

HP 91 Yellow 775 ml Ink Cartridge 775 C9469A

HP 91 Light Cyan 775 ml Ink Cartridge 775 C9470A

HP 91 Light Magenta 775 ml Ink Cartridge 775 C9471A

Table 5-2  Printheads

Printhead Part number

HP 91 Matte Black & Cyan Printhead C9460A

HP 91 Magenta & Yellow Printhead C9461A

HP 91 Light Magenta & Light Cyan Printhead C9462A

HP 91 Photo Black & Light Gray Printhead C9463A

Table 5-3  Maintenance cartridge

Maintenance cartridge Part number

HP 91 Maintenance Cartridge C9518A
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6 Print options

● Select print quality

● Select page size

● Adjust margins and layout options

● Resize a print

● Print crop lines

● Rotate an image

● Print a mirror image

● Select image orientation

● Remove the top and bottom blank areas

● Enter an account ID

● Select color emulation mode

● Change the treatment of overlapping lines

● Print with shortcuts

● Hold for preview

● Configure for high-quality printing

● Print in grayscale

● Print a draft

● Manage print jobs

● Request the printer's internal prints

● Use paper economically

● Use ink economically

● Change the graphic language setting
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Select print quality
The printer has various print-quality options. The best quality printing requires some loss of speed, while
maximum-speed printing can cause some reduction in print quality. The printer has four different print-
quality options.

NOTE: If you have set the print quality in the printer driver or through the Embedded Web Server,
that setting overrides a print-quality setting established on the front panel.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has
already received (even if they have not started to print yet).

Use the Embedded Web Server
To specify the print quality through the Embedded Web Server, go to the Submit Job page on the Main
tab. In the Job Settings tree, select Basic settings and then select one of the settings from the Print
quality drop-down menu: Fast, Normal-Fast, Normal, or Best.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use a driver
You can specify the print quality in the following ways:

● In the Windows HP-GL/2 or Postscript driver, go to the Paper/Quality tab and look at the Print
Quality section. If you select Standard Options, you can use the slider to select some compromise
between speed and quality. If you select Custom Options, you can choose Fast, Normal-
Fast, Normal or Best.

● In the Mac OS Print dialog box, go to the Image Quality panel. If you select Standard quality
options, you can use the slider to select some compromise between speed and quality. If you
select Custom quality options, you will see the specific print-quality options.

NOTE: In the Windows driver dialog box, the rendering resolution for your job appears in
the Custom Print Quality Optionsdialog box. In the Mac OS Print dialog box, it appears in
the Summary panel.

Use the front panel

On the front panel, select the  icon, and then select Printing preferences > Select quality
level.

Select page size
Select the page size through the Embedded Web Server, in a driver, or on the front panel. The size that
you select should be the page size in which the document was created. You can resize the document for
printing. See Resize a print on page 83.

NOTE: If you set the page size from your computer, that setting overrides the page size setting
on the front panel.
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Custom page sizes
Custom page sizes can be defined in a driver or through the Embedded Web Server. The two types of
custom page sizes are differentiated by how they were created, and therefore, which users have
accessibility to them.

● Custom papers: custom papers are custom page sizes that have been defined in a driver and that
reside on the user's hard drive. Therefore, custom papers are not available to other users in the
network.

● Printer forms: printer forms are custom page sizes that have been defined through the Embedded
Web Server and are visible to all network users who share that print queue. Users require at least
Print operator network permissions to create printer forms.

Use the Embedded Web Server
To select the page size through the Embedded Web Server, go to the Submit Job page on the Main
tab. In the Job Settings tree, select Advanced settings > Paper > Page size and then select
Standard or Custom page size.

● Standard: use the drop-down menus to set the Size and Orientation.

● Custom: use the free-text fields to specify a Width and Length, and use the Page size drop-down
menu to define the units of measurement.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use a driver
Select the page size in the following ways:

● In the Windows HP-GL/2 or PostScript driver, click the Paper/Quality tab, and then select
Document Size.

● In the Mac OS Page driver dialog, select Page Setup from the File menu, select your printer in
the Format for popup menu, and then select Paper size.
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To define a custom paper size that does not appear in the list of paper sizes:

● In the Windows and PostScript drivers, use one of two different methods:

● In the driver dialog, select Custom from the Document size drop-down menu on the Paper/
Quality tab. Type a name for the custom size and click Save. Then specify the paper
dimensions and click OK to save your custom paper size.

NOTE: The custom paper size you define is not available for selection in the list of
custom sizes until you have exited and opened the Printing Preferences/Properties again.
Then, you can select More from the Document sizedrop-down menu and find the
custom paper size in the list.

● On the Start menu, select Printers and Faxes, and then from the File menu select Server
Properties. On the Forms tab, click the Create a new form check box, specify the name
and dimensions of the new form, and then click Save Form.

● In Mac OS X V10.4, select Paper Size > Manage Custom Sizes in the Page Setup dialog
box.

● In Mac OS X V10.2 or V10.3, select Settings > Custom Paper Size in the Page Setup dialog
box.

Use the front panel

On the front panel, select the  icon, and then select Printing preferences > Paper options >
Select paper size.

Adjust margins and layout options
The printer margins determine the area between the edges of your image and the edges of the paper.
For information about the exact sizes (in millimeters) of the available margin settings, see Table 17-4
Margins on page 190.

Depending on the method that you use to adjust the margins, at least some of the following layout options
are available.

● Standard. Your image is printed on a page of the size that you have selected, with a narrow margin
between the edges of the image and the edges of the paper. The image should be small enough to
fit between the margins.

● Oversize. Your image is printed on a page slightly larger than the size that you have selected. If
you cut off the margins, the remaining page is the size you selected, with no margins between your
image and the edges of the paper.

● Clip Contents By Margins. Use this setting when the contents have white borders and a size
equal to that of the paper that you have selected in the driver. The printer uses the white border for
its margins and you get a page size that is equal to what was selected in the driver.

See the Usage and Preview sections of the Paper/Quality tab for tips about deciding which margins
and layout option best suit your needs.

NOTE: If margins are set in the printer driver or through the Embedded Web Server, they override
the margins that are set on the front panel.
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Use the Embedded Web Server
To set the margins through the Embedded Web Server, go to the Submit Job page on the Main tab.
In the Job Settings tree, select Advanced settings > Paper > Layout/Margins. Then use the
Select margins drop-down menu to set the margins. Select from: Default, Small, Normal and
Extended.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use a driver
Specify the margins in the following ways:

● In the Windows HP-GL/2 Normal margins and Standard layout are selected by default. To
change the margins and layout options, click the Paper/Quality tab and click the Layout button.

● In the Windows PostScript driver, Normal margins and Standard layout are selected by default.
To change the margins, click the Paper/Quality tab, select More from the Document size drop-
down menu, and then select the desired page size and the margins at the same time. Click the
Layout button to change the layout options.

● In the Mac OS driver, select Page Setup from the File menu, select your printer in the in the Format
for popup menu, and then select Paper size. You select the page size and the margins at the same
time.

NOTE: In the Windows PostScript driver, you have the option of selecting a paper size with no
margins. The No margins option should only be selected in conjunction with the Oversized
and Clip contents by margins layout settings.

NOTE: In Mac OS driver, the available margins options depend on the paper size that you
selected in the Page Setup dialog box.

You have the option of selecting a paper size with no margins. To select the No margins option,
click the Printing dialog, select the Finishing panel, and then click the Layout tab. The No
margins option should only be selected in conjunction with the Oversized and Clip contents
by margins layout settings.

Use the front panel

On the front panel, select the  icon, and then select Printing preferences > Margins > Select
margins.

Resize a print
You can send an image to the printer at a certain size but tell the printer to resize it (normally larger). This
can be useful in the follow situations:

● If your software does not support large formats

● If your file is too large for the printer's memory. In this case, you can reduce the page size in your
software and then scale it up again by using the front-panel option
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Use the Embedded Web Server
To rescale a print through the Embedded Web Server, go to the Submit Job page on the Main tab.
On the Job Settings tree, select Advanced settings > Resizing. In the Resizing drop-down menu,
select Standard, % of actual size, or Custom.

● If you select Standard, select a size and orientation from the drop-down menus.

● If you select % of actual size, enter a percentage in the free-text field.

● If you select Custom, type a size in the free-text field, and then set the units and specify on the drop-
down menu whether the size defines the width or length.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use a driver
Rescale a print in the following ways:

● In the Windows HP-GL/2 or PostScript driver, click the Features tab, and then select Resizing
options

● The Print document on option adjusts the image size to the paper size that you selected.
For example, if you select ISO A2 as the paper size and you print an A4-size image, it is
enlarged to fit the A2 paper. If the ISO A3 paper size is selected, the printer reduces a larger
image to fit the A3 size.

● The % of normal size option enlarges the printable area of the original paper size (the page
minus the margins) by the percentage indicated, and then adds the margins to create the output
paper size

● In the Mac OS Print dialog, select the Finishing panel and then select Print document on. The
image size is adjusted to the paper size that you selected.

For example, if you select ISO A3 as the paper size and you print an A4-size image, the image will
be enlarged to fit the A2 paper. If you select ISO A3 as the paper size and the image is larger than
A3, the printer reduces the image to fit the paper.

Use the front panel

On the front panel, select the  icon, and then select Printing preferences > Paper options >
Resize.

Print crop lines
Crop lines are lines that are printed onto the paper during a print job to indicate where the paper should
be cut to achieve a specific paper size. Crop lines can be printed for individual jobs or for multiple jobs
that are printed with the nesting feature.

For information about how to print crop lines for multiple jobs that are printed with the nesting feature,
see Nest with crop lines on page 100.
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Use the Embedded Web Server
To enable crop lines through the Embedded Web Server, go to the Submit Job page on the Main tab.
In the Job Settings tree, select Advanced settings > Roll options and then select a setting from
the Enable crop lines drop-down menu.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use a driver

● In the Windows driver, go to the Features tab and in the Roll Options section, select the Enable
Crop lines checkbox

● In the Mac OS Print dialog box, go to the Finishing panel and select the Crop lines check box.

Use the front panel

On the front panel, select the  icon, and then select Printing preferences > Paper options >
Enable crop lines.

Rotate an image
By default, images are printed with the shorter sides parallel to the leading edge of the paper, like this:

You can rotate your images by 90° in order to save paper, like this:
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When you rotate an image, you are actually rotating the page on the roll; the image maintains its same
orientation on the page. Rotate the image through the Embedded Web Server, in a driver, or on the front
panel. For more information about image orientation, see Select image orientation on page 87.

NOTE: If rotation is set in the printer driver or through the Embedded Web Server, it overrides
the front-panel setting.

NOTE: When you rotate a job, the page length might be increased to avoid clipping, because
the top and bottom margins are usually larger than the side margins.

CAUTION: If you rotate an image, the paper might not be wide enough for the image. For
example, rotating a portrait D/A1-size image on D/A1-size paper by 90° will probably make the
image exceed the width of the paper. If you are using the Embedded Web Server, the preview
screen confirms this with a warning triangle. The job reverts to a “hold for paper.” See Understand
job status on page 97.

Use the Embedded Web Server
To rotate an image through the Embedded Web Server, go to the Submit Job page on the Main tab.
In the Job Settings tree, select Advanced settings > Roll options and then select one of the settings
from the Rotate drop-down menu.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use a driver
You can rotate an image in the following ways:

● In the Windows HP-GL/2 or PostScript driver, select the Features tab, and then select in the Roll
Options section, select Rotate by 90 degrees.

● In the Mac OS Print dialog box, select the Finishing panel and Rotate by 90 degrees.

Use the front panel

On the front panel, select the  icon, and then select Printing preferences > Paper options >
Rotate.
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Autorotate
The Windows HP-GL/2 printer driver provides an Autorotate option, that automatically rotates oversized
portrait images by 90° in order to save paper. Click the Features tab and in the Roll Options section,
select Autorotate. Then select the width of the loaded roll on the Roll width drop-down menu.

Print a mirror image
If you are using clear imaging paper, sometimes called backlit, you might want to print a mirror image
of your image, so that when the paper is lit from behind, the image appears in the correct orientation.
Use one of the following methods to do this without changing the image in your software program.

Use the Embedded Web Server
To print a mirror image through the Embedded Web Server, go to the Submit Job page on the Main
tab. In the Job Settings tree, select Advanced settings > Transformations and then select one of
the settings from the Mirror image drop-down menu.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Select image orientation
When you set the image orientation, select either portrait or landscape orientation. Changing between
portrait and landscape changes the orientation of the image on the page, but does not rotate the page
on the roll. Change the orientation through the Embedded Web Server or in a driver. For more information
about rotating an image, see Rotate an image on page 85.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use the Embedded Web Server
To select the image orientation through the Embedded Web Server, go to the Submit Job page on
the Main tab. In the Job Settings tree, select Advanced settings > Orientation and then select
Portrait or Landscape.

Use a driver

● In the Windows driver, go to the Paper/Quality tab and then select Portrait or Landscape.

● In the Mac OS, go to the Page Setup dialog box, and then select Portrait or Landscape.

Remove the top and bottom blank areas
In addition to the page margins set for the job, the printer allows 5 millimeters of blank space between
each print. To remove these top and bottom blank areas, select the Remove top/bottom blank
areas feature.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.
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Use the Embedded Web Server
To remove top and bottom blank areas through the Embedded Web Server, go to the Submit Job page
on the Main tab. In the Job Settings tree, select Advanced settings > Roll options and then
select Remove top/bottom blank areas.

Use a driver

● In the Windows driver, go to the Features tab and select Remove top/bottom blank
areas.

● In the Mac OS Print dialog box, go to the Finishing panel and select Remove top/bottom
blank areas.

Enter an account ID
Use this feature to assign an account ID to a print job for accounting purposes. The account ID appears
in the printer-generated accounting reports. To track of job-accounting information, set your printer to
require an account ID for each job that is submitted. This setting makes the account ID field mandatory
and jobs that have no account ID revert to a "on hold for accounting" status.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use the Embedded Web Server
To enable the Account ID feature, go to the Submit Job page on the Main tab. In the Job Settings
tree, select Advanced settings > Roll options and then select Account ID.

Use a driver

● In the Windows driver, go to the Features tab and type an Account ID in the Account ID field.

● In the Mac OS Print dialog box, go to the Accounting panel and type an Account ID in the
Account ID field.

Select color emulation mode
Select color emulation modes through the Embedded Web Server, in a driver or on the front panel. For
more information about application-managed colors and printer-managed colors, see Color-management
options on page 114.

Use the Embedded Web Server
To select a color emulation mode through the Embedded Web Server, go to the Submit Job page on
the Main tab. In the Job Settings tree, select Advanced settings > Color and then select one of the
settings from the Color Management drop-down menu. If you select the Printer emulation setting,
you can then select the printer series you that want to emulate from the drop-down menu.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.
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Use a driver
Select a color emulation mode in the following ways:

● In the Windows HP-GL/2 or PostScript driver, select the Color Management section of the
Color tab.

● In the Mac OS Print dialog box, select the Color Options panel, and then select Printer
Emulation.

Use the front panel
●

On the front panel, select the  icon, and then select Printing preferences > Color
options and select the emulation mode of interest.

Change the treatment of overlapping lines
The Merge setting controls the overlapping lines in an image. There are two settings Off and On.

● If Merge is Off, only the color of the top line is printed where the lines cross.

● If Merge is On, the colors of the two lines are merged where the lines cross.

Use the front panel

To turn on Merge on the front panel, select the  icon, and then select Printing preferences > HP-
GL/2 options > Enable merge. You can set the merge setting from some software programs. Settings
in your software override the front-panel settings.

NOTE: Merge settings have no effect on PostScript files.

Print with shortcuts
The printer driver provides many options that can be set to different values when printing a particular job.
A printing shortcut stores the values that are appropriate for a particular kind of job, so that you can set
all the options with a single click. Some settings (such as paper size and orientation) can be overridden
by the values that you specify in the software program.

NOTE: Shortcuts are available only in the Windows HP-GL/2 and PostScript drivers.

To use a shortcut, click the Printing Shortcuts tab in the Windows driver.
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A list of available shortcuts appears. Select the one that matches the job that you want to print.

The driver options are now set. Print immediately, or examine the settings to make sure they are
appropriate. You can select a shortcut and then change some of its settings manually.

TIP: Make sure to check at least the settings that you can see on the Printing Shortcuts tab:
the document size, orientation, and so on.

The Factory Defaults shortcut contains the printer's default settings. When you click it, it sets all the options
to their default values.

Printing shortcuts can be customized to your particular needs. To create your own shortcut:

1. Select the shortcut that comes closest to satisfying your requirements.

2. Change any value in the Printing Shortcuts tab and other tabs.

3. Save the new printing shortcut.

If you decide later that you no longer want a shortcut, you can delete it.

Hold for preview
Preview a print on the screen to check the layout of the print before printing, which can help you to avoid
wasting paper and ink.

NOTE: If the nesting feature is enabled, the preview image might not accurately reflect the actual
print job.

Use the Embedded Web Server
1. Go to the Submit Job page on the Main tab.

2. In the Job Settings tree, select Basic settings.

3. On the Hold for a preview drop-down menu, select Yes.

4. Click the Print button to submit the job.
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In the print queue, you can see that the job has an “on hold” status.

5. To preview the job, click the icon in the Preview column.

NOTE: The printer can store up to 64 pages for preview. If the job that you selected for preview
contains more than 64 pages, the job will be canceled and purged without notification when the
printer starts to process the sixty-fifth page. If you want to preview a job that has more than 64
pages, click the Continue button before the printer starts to process the sixty-fifth page. Because
the preview image is ready as soon as the first page is processed, you should have enough time
to check the preview image.

Use a driver
You cannot actually preview a print in the printer drivers. However, selecting the preview option in the
driver opens the Embedded Web Server. You then see the image in the Embedded Web Server preview
window.

● To select the preview option in the Windows HP/GL-2 or PS drivers, go to the Printing
shortcuts tab and select the Show preview before printing check box.

● To select the preview option in the Mac OS driver, go to the Finishing panel and select the Show
print preview check box.

● You can also use your software program's print preview option.

Configure for high-quality printing
You can configure the printer for high-quality printing.

Use the Embedded Web Server
Through the Embedded Web Server, go to the Submit Job page on the Main tab. In the Job
Settings tree, select Basic settings and select Best from the Print quality drop-down menu.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use a driver
● In the Windows driver, go to the Paper/Quality tab and look at the Print Quality section. Move

the print-quality slider to the extreme right ('Quality').

● In the Mac OS Print dialog box, go to the Image Quality panel, and then move the print-quality
slider to the extreme right ('Quality').

Use the front panel

On the front panel, select the  icon, and then select Printing preferences > Select quality
level > Best.

NOTE: If you set the print quality from your computer, that overrides the print-quality setting on
the front panel.
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Additional tips
The following are additional tips for specific printing conditions:

● Printing on satin photo paper: If you are printing on satin photo paper, consider using HP
Professional Satin Photo Paper, which offers:

● A wider color gamut

● Better black optical density

● Better PANTONE* coverage

● A smoother surface

● More robustness

● Print-quality configuration suggestions: The following table shows recommended print-
quality settings and paper types for various different kinds of prints.

NOTE: High-density images should be printed on heavier paper (heavyweight or glossy).

Print content Print quality Paper types

Photographs Best Productivity Photo Gloss

Renderings Best Heavyweight Coated Paper

Productivity Photo Gloss

In-store advertising Normal-Fast or Normal Coated Paper

Heavyweight Coated Paper

Productivity Photo Gloss

Lines and images – high quality maps Best Coated Paper CAD

Heavyweight Coated Paper

Productivity Photo Gloss

Lines and fills Best Bright White

Bond Paper

Translucent materials*

Coated Paper CAD
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Print content Print quality Paper types

Heavyweight Coated Paper

Productivity Photo Gloss

Lines and fills (draft) Fast Bright White

Bond Paper

Translucent materials*

Coated Paper CAD

Heavyweight Coated Paper

Productivity Photo Gloss

Lines Normal-Fast or Normal Bright White

Bond Paper

Translucent materials*

Coated Paper CAD

Lines (draft) Fast Bright White

Bond Paper

Translucent materials*

Coated Paper CAD

* Translucent materials include Vellum, Translucent Bond, Natural Tracing Paper, Clear Film, and
Matte Film.

For technical details about print resolution, see Functional specifications on page 189.

Print in grayscale
You can convert all colors in your image to shades of gray. By using an option in your graphics program
if given the option, or by using the driver.

Use the Embedded Web Server
To print in grayscale through the Embedded Web Server, go to the Submit Job page on the Main tab.
In the Job Settings tree, select Advanced settings > Color and then select a setting from the Color/
Grayscale drop-down menu.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use a driver
● In the Windows HP-GL/2 or PostScript driver, go to the Color tab and look at the Color Options

section. Select Print In Grayscale and then select one of the two grayscale options that are
available.

● In the Mac OS Print dialog box, go to the Color options panel and select Color. Select Print
In Grayscale and then select one of the two grayscale options that are available.
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These are the two grayscale options:

● Gray and Black Inks Only: With this option, only gray and black inks are used to produce the
grayscale image.

● Full Set of Inks: With this option, a mix of colors are used to produce the grayscale image.

NOTE: The Full Set of Inks option can produce better results. Try using that option if you are
experiencing bronzing when printing on glossy paper. See The image has a metallic hue
(bronzing) on page 154.

Print a draft
You can configure the printer for fast, draft-quality printing.

Use the Embedded Web Server
Through the Embedded Web Server, go to the Submit Job page in the Main tab. In the Job
Settings tree, select Basic settings and select Fast from the Print quality drop-down menu.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use a driver
● In the Windows HP-GL/2 or PostScript driver, go to the Paper/Quality tab and look at the Print

Quality section. Move the print-quality slider to the extreme left ('Speed').

● In the Mac OS Print dialog box, go to the Image Quality panel and move the print-quality slider
to the extreme left ('Speed').

Use the front panel

On the front panel, select the  icon, and then select Printing preferences > Select quality
level > Fast.

NOTE: If you set the print quality from your computer, that overrides the print-quality setting on
the front panel.

Manage print jobs
Submit a job

1. Access the Embedded Web Server. See Embedded Web Server setup options on page 23.
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2. Go to the Submit job page on the Main tab.

3. Click the Add files button to Browse your computer and select the files to print.

NOTE: Submitting a print job through the Embedded Web Server does not require you to
have the printer driver or the software that was used to create the file installed on your
computer.

4. Set any other job options you may want from within the Job settings tree.

If you leave an option set to Default, the setting that was saved in the job will be used. If the job
contains no setting for that option, the setting in the printer will be used. The setting in the printer can
be changed on the front panel, or, in some cases, through the Device Setup page in the Embedded
Web Server.

5. Click the Print button.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Save a job
You can only save a job while submitting it for printing:

1. Access the Embedded Web Server. See Embedded Web Server setup options on page 23.

2. Go to the Submit job page on the Main tab.

3. Click the Add files button, browse your computer, and select the file to print.

4. If you want to submit more than one file, click the Add files button to add more files.

5. In the Job settings tree, go to Basic settings and set the Store job in printer option to On.

6. Set any other job options that you want from within the Job settings tree.

7. Click the Print button.

The job appears on the Stored jobs in printer page on the Main tab.

Manage print jobs 95

Pr
in

t 
op

tio
ns



Reprint an old job
If you intend to reprint a job later after making some changes to the job settings (such as size or quality),
you can store the job inside your printer so that you do not have to resubmit it later.

NOTE: If you want to reprint a job without changes, you can do that from the print queue without
saving the job.

Reprint old jobs either through the Embedded Web Server or on the front panel.

Use the Embedded Web Server
Reprint any jobs that are listed in the job queue or on the list of jobs that are stored in the printer.

● Go to the Job queue on the Main tab, select the job that you want to reprint, and click the
Reprint button.

● Go to the Stored jobs in printer page in the Main tab, select the job that you want to print,
modify the print options as necessary, and click Save, Print, or Print and save.

Use the front panel
Reprint a job on the front panel in one of two ways, depending on the job that you want to reprint.

●
To reprint the last job that was printed, select the  icon and then select Reprint last job.

●
To reprint any other job, select the  icon and select Job queue. Then select the job that you
want to reprint and select Reprint. Select the number of copies that you want to print and click
OK.

Cancel a job
Cancel a job on the front panel by pressing the Cancel button, or through the Embedded Web Server by
selecting the job from within the job queue and clicking the Cancel button.

You can also use the driver to cancel.

The printer advances the paper as it would if the print were finished.

NOTE: A multipage job or a large file might take longer to stop printing than other files.

Manage the print queue
The queue might contain more than one job. If so, your printer stores jobs in a queue while it is printing
the current page.

Prioritize a job in the queue
● On the front panel: to make any pending job in the queue the next one to be printed, select the

 icon and then select Job queue. Select the job that you want to be printed next and select
Move to front.

● Through the Embedded Web Server: select the job that you want to be printed next within the job
queue and select Move to front.
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NOTE: If nesting is turned on, the prioritized job might remain nested with others. If you want
only this job to be printed next, and on its own on the roll, first turn nesting off and then move the
job to the front of the queue as described.

Identify a job in the queue
The best way to look at the queue is through the Embedded Web Server, on the Jobs queue page on
the Main tab. Manage the queue and get full information about every job by clicking the name of the
file.

You can also manage the queue on the front panel. To do so, select the  icon and then select Job
queue. You can see a list of the jobs in the queue, each with an icon depicting its status as pending,
active, done, or cancelled.

Delete a job from the queue
Under normal circumstances, you do not need to delete a job from the queue after printing it, because it
will leave the queue as more files are sent. However, if you have sent a file in error and want to avoid
the chance that it will be reprinted, you can delete it by selecting it and then selecting Delete through the
Embedded Web Server or on the front panel.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (status = printing) and you want to both cancel the job and delete it,
first click the Cancel icon in the Web server or press the Cancel button on the front panel, and then delete
the job from the queue.

Make copies of a job in the queue
To make extra copies of any job in the queue, select the job through the Embedded Web Server and click
the Reprint button, and then specify the number of copies that you want. The job moves to the top of the
queue.

You can also do this on the front panel: select the  icon and then select Job queue. Select the job,
select Copies, and then specify the number of copies that you want and press the OK button. This
overrides any value set in your software.

NOTE: If Rotate was On when you sent the file, every copy will be rotated.

If the job has already been printed, use Move to front to move it to the top of the queue.

Understand job status
These are the possible job status messages, in the approximate order in which they appear:

● receiving: the printer is receiving the job from the computer.

● waiting to process: the job has been received by the printer and is waiting to be rendered (only
for jobs submitted through the Embedded Web Server.)

● processing: the printer is parsing and rendering the job.

● preparing to print: the printer is performing writing system checks before printing the job.

● waiting to print: the job is waiting for the print engine to become available to proceed with
printing.
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● waiting for nest: the printer is set up with Nesting=On and is waiting for other job to complete
the nest and proceed with printing.

● on hold: the job was sent with the Hold for preview option and is on hold.

NOTE: If the printer stalls while printing a job and the queue facility is turned on, the
partially printed job will appear in the queue as on hold when the printer is turned on again.
When you resume the job, it begins printing at the page on which it was interrupted.

● on hold for paper: the job cannot be printed because the paper it requires is not loaded in the
printer. Load the required paper and then click Continue to resume the job.

● on hold for accounting: the job cannot be printed because the printer requires all jobs to have
an account ID. Type the account ID and then click Continue to resume the job.

● printing

● drying

● cutting paper

● ejecting page

● canceling: the job is being canceled, but will remain in the printer job queue.

● deleting: the job is being deleted from the printer.

● printed

● canceled: the job has been canceled by the printer.

● canceled by user

● empty job: the job does not contain anything to print.

Nest jobs to save paper
Nesting means placing pages side-by-side on the paper, rather than one after the other. Do this to avoid
wasting paper. The graphic below to the left illustrates the general concept of nested print jobs. The
graphic below to the right illustrates three that have been print jobs printed with the nesting feature
disabled.

When does the printer try to nest pages?
When the Job Management menu on the front panel or the Setup page in the Embedded Web Server
shows that Nest is On, the printer nests pages.
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How long does the printer wait for another file?
So that the printer can make the best nest possible, it waits after receiving a file to determine whether a
subsequent page will nest with it. This waiting period is the nest wait time; the factory default nest wait
time is 2 minutes. This means that the printer waits up to 2 minutes after the last file is received before
printing the final nest.

You can change this waiting time on the printer's front panel. Select the  icon, and then select Job
management options > Nest options > Select wait time. The available range is 1 to 99 minutes.

NOTE: Nesting requires that you set the When to start printing feature to After

processing. To do so, select the  icon, and then select Job management options >
When to start printing and select After processing.

While the printer is waiting for nesting to time out, the remaining time appears on the front panel. You
can print the nest (cancel the nest wait time) by pressing the Cancel button.

Which pages can be nested?
All pages can be nested unless they are so large that two of them cannot fit side-by-side on the roll, or
more pages remain that can fit on the remaining length of the roll. A single group of nested pages cannot
be split between two rolls.

Configure the nesting option

On the printer's front panel: select the  icon, and then select Job management options > Nest
options > Enable nesting and select Off, In order, or Optimized order.

The following are three nesting options:

● Off

Select the Off setting to disable the nesting feature.

● In order

Pages are nested on the roll in the same order in which they are submitted to the printer. The nest is
broken and printed as soon as one of three conditions is met:

● The nest is full, meaning that the remaining paper on the roll is insufficient to accommodate the
next page that is submitted.

● The nesting timeout elapses.

● The next page to arrive is incompatible with the pages that are already nested.

For more information about the compatibility of a page, see How job compatibility is defined
on page 100.

The advantage of In-order nesting is that the wait time for pages to nest – and therefore the total
printing time – is typically reduced because more conditions exist to break the nest. The disadvantage
is that the nest is broken by the first incompatible page submitted, even if a sufficient length of paper
and additional compatible pages are in the queue. This means that a higher probability exists that
the paper will not be used efficiently.

● Optimized order

Manage print jobs 99

Pr
in

t 
op

tio
ns



Pages are nested on the roll independent of when they are submitted to the printer. An incompatible
page does not break a nest. Instead, the printer waits for more compatible pages and queues the
incompatible pages until one of three conditions is met:

● The nest is full, meaning that the remaining length of paper on the roll is too small to
accommodate the next page submitted

● The nesting timeout elapses

● The incompatible-page queue is full. The printer queues up to six incompatible pages while it
nests compatible pages. Upon receiving the seventh incompatible page, the nest is broken and
printed. Then the pages in the incompatible-page queue print.

For more information about the compatibility of a job, see How job compatibility is defined
on page 100.

The advantage of Optimized order nesting is that it typically wastes less paper because the nest is
not broken when an incompatible page is submitted. The disadvantage is the overall printing time
is typically longer because the printer waits for compatible pages.

NOTE: Pages might not be printed in the order that the were submitted to the printer when
the Optimized order option is selected.

How job compatibility is defined
In order to be in the same nest, the individual pages must be compatible in all of the following ways:

● All pages must have the same print-quality setting.

● The Maximum Detail setting must be the same on all pages.

● The Mirror setting must be the same for all pages.

● The Rendering Intent must be the same for all pages.

● The Cutter setting must be the same for all pages.

● The color adjustment settings must be the same for all pages. These are known as Advanced Color
Settings in the Windows driver, and CMYK Settings in the Mac OS driver.

● Pages must be all color or all grayscale. The pages cannot be a mix of color and grayscale.

● All pages must be in one of the following two groups; the two groups cannot be mixed in the same
nest:

● HP-GL/2, RTL, and CALS G4

● PostScript, PDF, TIFF, and JPEG

● JPEG, TIFF, and CALS G4 pages that have a resolution greater than 300 dpi might not nest with
other pages.

Nest with crop lines
Crop lines are lines that are printed onto the paper during a print job to indicate where the paper should
be cut to create a specific paper size. Crop lines can be printed for individual jobs or for multiple jobs
printed with the nesting feature.

NOTE: Selecting the crop lines option in the Nest options menu overrides the setting in the
Printing options menu for an individual job.
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To print crop lines for multiple jobs printed with the nesting feature through the Embedded Web Server:

1. Go to the Printer Settings page on the Setup tab.

2. Select Printer settings > Job management and then select Yes from the Nest drop-down menu.

3. Go to the Submit Job page on the Main tab.

4. In the Job Settings tree, select Advanced settings > Roll options, and then select Yes from
the Enable crop lines drop-down menu.

For information about how to print crop lines for individual jobs, see Print crop lines on page 84.

Check ink and paper usage for a job
Two methods exist to check ink and paper usage for a job.

NOTE: The accuracy of the usage statistics is not guaranteed.

Ink and paper statistics with HP Easy Printer Care (Windows) or HP Printer Utility
(Mac OS)

1. Access HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS). See HP Easy Printer Care
(Windows) or HP Printer Utility (Mac OS) setup options on page 25.

2. Go to the Accounting window to view information about the most recent jobs.

3. In Windows, go to the Job Accounting tab.

In Mac OS, select Information > Job Accounting and click the Look Up button.

Printer statistics with the Embedded Web Server

To obtain printer statistics through the Embedded Web Server, go to the Accounting page on the Main
tab and find the job for which you want information.

Request the printer's internal prints
The internal prints provide various kinds of information about your printer. Request these prints from the
front panel, without using a computer.

Before requesting any internal print, make sure that paper is loaded and that the Ready message appears
on the front-panel display.

To print an internal print, select the  icon, Internal prints, and then select the type of internal print
that you want.

The following internal prints are available:

● Demo: shows some of the capabilities of the printer

● Menu map: shows details of all the front-panel menus

● Configuration: shows all the current front-panel settings

● Usage report: shows estimates of the total number of prints, number of prints by paper type, number
of prints by print-quality option, and total amount of ink used per color. The accuracy of these
estimates is not guaranteed.

● HP-GL/2 palette: shows the color or grayscale definitions in the currently-selected color palette
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● PostScript font list: lists the PostScript fonts that are installed in the printer (PostScript printers only)

● Service information: provides information that service engineers require

Use paper economically
Here are some recommendations for making economical use of paper:

● If you are printing more than one job, consider nesting the jobs. Nesting means placing pages side-
by-side on the paper, rather than one after the other. See Nest jobs to save paper on page 98.

● You might be able to save some paper by using the following options:

● In the Windows HP-GL/2 or PostScript driver, select the Features tab and then select Remove
top/bottom blank areas or Rotate by 90 degrees.

● In the Mac OS Print dialog, select the Finishing panel and then select Remove top/
bottom blank areas or Rotate by 90 degrees.

● If you preview the print on your computer before printing, you can sometimes avoid wasting paper
on prints that contain obvious mistakes. See Hold for preview on page 90.

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Use ink economically
Here are some recommendations for making economical use of ink:

● For draft prints, use plain paper and move the print-quality slider to the left end of the scale
('Speed')

● Clean the printheads only when needed, and clean only those printheads that need cleaning.
Cleaning the printheads can be useful, but it uses ink.

● Leave the printer permanently turned on so that it can maintain the printheads in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not
done, the printer might use much more ink later to restore the health of the printheads.

● Wide prints make more efficient use of ink than narrow prints

NOTE: Be aware that when you submit more than one job at a time by clicking the Add files
button in the Embedded Web Server, all of the jobs that you submit will adopt the settings of the
final job that you submit. However, none of the jobs in the print queue are affected.

Change the graphic language setting
Unless you are troubleshooting one of the problems mentioned in the following section, you should not
need to change the default graphic language setting (Automatic). Avoid changing the setting because
setting a specific graphic language means that you can print only files that have been created in that
language.

NOTE: Any setting selected in HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS)
overrides the setting selected on the front panel.
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Use the front panel

To change the graphic language setting, select the  icon, and then select Printing preferences
> Select graphics language, where the following options are available.

● Select Automatic to allow the printer determine which type of file it is receiving. This setting works
for most software programs.

● Select PS if you are printing only PostScript files, and if your PostScript jobs do not start with the
standard PostScript header (%!PS) and do not include PJL language-switching commands

Alternatively, select PS if you have experienced problems while downloading PostScript fonts. In this
case, select Automatic again after you have downloaded the fonts.

If you are downloading fonts over a USB connection, select the  icon, and then select Printing
preferences > PS > Select encoding.

● Select TIFF, JPEG, PDF, or CALS G4 only if you are sending a file of the appropriate type directly
to the printer without going through a printer driver. This is normally done only through the Embedded
Web Server, which sets the language without user intervention.

NOTE: The PS and PDF options are available with PostScript printers only.

Use the HP Easy Printer Care (Windows) or HP Printer Utility (Mac
OS)

Change the graphic language setting from the HP Easy Printer Care and HP Printer Utility by using the
following steps.

1. In Windows, click the Settings tab and then select Printer settings > Printing preferences.

In Mac OS, select Configuration and then select Printer settings > Configure printer
settings > Printing preferences.

2. Select one of the following options:

● Select Automatic to allow the printer determine which type of file it is receiving. This setting
works for most software programs. Automatic is the recommended value.

● Select HP-GL/2 only if you are sending a file of the appropriate type directly to the printer,
without going through a printer driver
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7 Color management

● What is color?

● The problem: color in the computer world

● The solution: color management

● Color and your printer

● A summary of the color-management process

● Color calibration

● Color profiling

● Color-management options

● Color adjustment options

● Perform black point compensation

● Set the rendering intent

● HP Professional PANTONE* Emulation

● Color emulation modes
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What is color?
We see the world around us as steeped in color. Color is in the first instance simply an aspect of how we
experience our environment and is therefore subjective. Our color experiences are closely related to brain
activity that is triggered by signals that our eyes send to it. These signals undergo a complex and highly
interlinked sequence of processing stages that make the relationship between what our eyes emit and
what we experience anything but direct. The signals sent by the eye depend on the light-sensitive cells
that line the back of our eyes, and they belong to three types, each sensitive to electromagnetic radiation
of different physical properties (wavelengths). Such electromagnetic radiation is called light and objects
appear to have certain colors because of how the objects interact with light (by emission, reflection,
absorption, transmission, scattering, etc.).

Our individual experiences of color are also affected by our previous experiences and memories and by
the way in which we put our experiences into language. Finally, environmental factors such as changes
in lighting, scene content, or the proximity of other colors also have an effect, which makes the way in
which we view a given display or print an essential part of the colors we see. Differences in all these
aspects (from physiological differences between people, to differences in their past experiences, memories
and linguistic tendencies) can result in people talking about colors differently even in response to the same
light reflected from an single object. However, many similarities exist between how individuals experience
color. You can make very specific judgments about color that others will also agree with when care is
taken in the process. In conclusion we can say that color results from the interaction between light, objects,
and a viewer, which makes it a very complex and to a large degree subjective phenomenon.

The problem: color in the computer world
Color-imaging devices such as printers, displays, projectors, and televisions create colors by using
different methods and materials (colorants). Displays, for instance, use colorants that emit red (long
wavelength), green (medium wavelength), and blue (short wavelength) light. A white color requires all
three colorants and black requires that none of them be used (i.e. that no light be emitted). Devices that
use light-emitting colorants are called additive, because the light from them is added together before it
enters a viewer’s eyes. Printers, on the other hand, use materials that absorb parts of the light that shines
on them. They are called subtractive. Typical prints use cyan (red absorbing), magenta (green absorbing),
and yellow (blue absorbing) inks and an additional black ink that absorbs light at all wavelengths. To get
white using a printer requires not absorbing any of the light that illuminates a piece of paper and to get
black, all of the inks need to be used to absorb all of the light that is present.

To control the output of color imaging devices, the following color spaces are normally used:

● RGB (Red, Green, and Blue) is the color space typically used for additive devices. A color is
represented as a combination of specific quantities of red, green, and blue colorants that create the
range of colors (color gamut) in the device.

NOTE: Colors in subtractive devices can also be controlled by using RGB data. Especially
when control over the printer’s black ink is unnecessary, this is an efficient option.

● CMYK (Cyan, Magenta, Yellow, and Black) is the color space for subtractive devices, such
as printers or presses. A color is represented as a combination of cyan, magenta, yellow, and black
(K) inks, and combinations provide the entire range of colors in the device.
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Color spaces are only methods of controlling different color-imaging devices. They do not describe colors
directly. The same CMYK values, for example, create different colors when sent to different printers that
use different inks and paper types. For example, consider a printer that can use indoor inks or outdoor
inks. The printer (hardware) is the same, but it has two different color gamuts due to the different chemistry
of the inks (dye-based versus pigmented). Furthermore, they need to work with different paper types, as
ink interaction with the paper depends on its chemistry. Thus, the colors resulting from given CMYK values
depend on the types of inks and papers that you use with a printer. If this is the case using the same
printer, you can easily imagine how different results can be obtained with printers using different
technologies and therefore using different ink chemistry.

The same happens with RGB-controlled devices. For example, imagine that two different monitors from
the same manufacturer have their white points at 9600 K and 6500 K, respectively. Their colors are going
to be different because they will be related to a different white point reference. The situation varies even
more among monitors from different manufacturers. To emulate the standard color temperature of the
graphic-arts industry, set the white point of your monitor to 5000 K (also called D50).

NOTE: The white point is the brightest neutral color that a device can reproduce or that is present
in an image. The human visual system automatically adapts to the content of an image based on
its white point.

An RGB image, such as an image obtained from a digital camera and edited on a monitor, must first be
converted to CMYK before printing. Different devices do not give access to the same color gamuts: some
colors that can be shown on a display cannot be matched in print, and vice versa. The following figure
illustrates how the human eye perceives a larger range of colors than a typical display or printer. It also
shows that the color gamuts in two different types of color-imaging devices do not match each other.

1. All colors

2. Computer monitor gamut

3. CMYK press gamut

Some color spaces are not device-dependent, but instead represent how a viewer sees colors, such as
CIE Lab or CIECAM02. These color spaces are defined by the CIE (Commission Internationale de
l’Éclairage). The advantage of these spaces is that if two objects have the same CIELAB values, they look
the same when viewed under the same conditions. Values in these spaces can be obtained from measuring
the light emitted or reflected by an object.
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The solution: color management
Many colors from an RGB-controlled device cannot be reproduced in a CMYK-controlled device, and vice
versa. These colors are called “out-of-gamut” colors.

1. Describe the color behavior of a device as accurately as possible by using an ICC
profile. The color behavior of a device can be described by taking various RGB or CMYK
combinations, sending them to a device, measuring the resulting output, and expressing it in a device-
independent color space (for example, CIE Lab). The resulting relationship is stored in an ICC profile,
which is a standard file that translates the color space of a device(CMYK or RGB) to a device-
independent color space (for example CIE Lab). The process of generating an ICC profile is called
profiling.

2. Convert colors as effectively as possible by using a Color Management System
(CMS). A CMS is software that uses information from ICC profiles to transform the color space of
one device (defined by a source profile) into the color space of another device (defined by a
destination profile). In this solution, difficulties arise with the colors that exist in the gamut that one
device uses and that the other does not use.

The following four settings describe and CMS:

● CMS: Color Management System. The software that converts the color information that is stored in
the input image (defined by a source profile) into an output image that has the color space specified
by a destination profile. Many different CMSs are on the market: in software programs, in operating
systems, and in printing software, including the HP Designjet Z6100 internal RIP.

● Source profile: a description of the color behavior of the input device

● Destination profile: a description of the color behavior of the output device

● Rendering intent: the most difficult challenge in color management is when a color in the source
gamut does not correspond directly to a color in the destination gamut. When a perfect match is not
possible, choices must be made about how to treat gamut differences. These choices are called
rendering intent. There are four different possibilities depending on the final output that you want to
achieve.

● Use Perceptual for the most pleasing final output. It is suitable for photographic content.

● Use Saturation for vivid final output. It is suitable for business graphics (charts, presentations,
and so on), but is not recommended for color matching.

● Use Relative Colorimetric for press proofing. This rendering intent provides a match for
colors that are inside both the source and destination gamuts, and minimizes differences when
a match is not possible.

● Use Absolute Colorimetric for press proofing (like Relative Colorimetric), when you also
want to simulate the color of the source’s paper.
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The following are the most commonly used device color spaces and profiles:

● RGB mode:

● sRGB (sRGB IEC61966-2.1): for images that typically originate from consumer digital
cameras and scanners and from the Web

● Adobe® RGB (1998): for images that typically originate from professional digital cameras

● Specific RGB device space: for images that are coming from or going to a specific RGB
device that has been profiled

● CMYK mode:

● SWOP: Specifications for Web Offset Publications, a set of press standards that have been
defined for a typical U.S. press and for different types of paper stock

● ISO 12647-2: a set of press standards that have been defined by the International Standards
Organization for different types of paper. Some examples of the definitions include Coated,
Uncoated, and so on.

● Other regional standards: Euroscale, JMPA, Japan Color

● Specific CMYK device space: for images that are coming from or going to a specific CMYK
device that has been profiled. The HP Designjet Z6100 printer can measure itself and generate
an CMYK ICC profile, describing its color behavior for the paper that was loaded when it
calculated the measurement.

Color and your printer
As a creative professional, predictable and dependable results from your printer are essential to getting
your job done. Predictability is a key element of an efficient color workflow. You need prints that match
your expectations and that generate neutral grays and correct colors on your selected paper, print-to-print
and printer-to-printer. Dependability ensures that every print is free of print-quality defects and ready to
use or send to your customer. You save time and effort and avoid wasting ink and paper, and you can
meet demanding production schedules with confidence.

HP Designjet Z6100 printers have been engineered with advanced hardware and driver features to ensure
predictable and dependable results, and offer dramatic improvements in efficiency and control for your
color workflow.

HP Embedded Spectrophotometer
HP Designjet Z6100 printer series revolutionizes professional color workflows by using a built-in
spectrophotometer for color calibration and profiling.

A spectrophotometer is a precision instrument that can determine the exact composition of the light that
is reflected from a color patch. It splits the reflected light into different wavelength components and
measures the strength of each component. The HP Embedded Spectrophotometer is mounted on the
printhead carriage.

The HP Designjet Z6100 printers use the spectrophotometer to generate custom ICC profiles automatically
for your preferred paper types. It then calibrates the printers to deliver print-to-print and printer-to-printer
consistency with less than half the color error of earlier HP Designjets, under all environmental conditions,
and even on unknown (not factory-profiled) paper types. A built-in white calibration tile, which is protected
by an automatic shutter, ensures reliable measurements that meet international standards.

The printer, color-imaging pipeline, and professional-quality spectrophotometer with GretagMacbeth i1
color technology are integrated with the HP Color Center software for the HP Designjet Z6100. Giving
the calibration and profiling processes direct access to the writing system allows precise control of ink
levels and color separations for each printed color patch. The automated measurement process eliminates
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the need to handle the test print, provides repeatable drying times, and allows fast measurements with
precise electromechanical positioning of the spectrophotometer over the color patch. This provides
unprecedented ease of use and matches or exceeds the performance of more expensive offline, handheld
profiling systems.

A summary of the color-management process
To get the accurate and consistent colors that you want, follow these steps for each paper type that you
use.

1. If the printer does not recognize your paper type, add the type to the printer's list of known papers.
See Use non-HP paper on page 47. Typical users might add a few custom paper types every year.

2. Color-calibrate the paper type to ensure consistent colors. Perform this calibration when a printer
alert recommends this calibration (typically, every few weeks for each paper type you use). In
addition, calibrate immediately before a particularly important print job in which color consistency
is vital.

3. Color-profile the paper type to ensure accurate colors. Profiling does not normally need to be
repeated; after you have a profile for a particular paper type, you can continue to use it. However,
re-profiling does no harm, and some users repeat the profiling process every month to ensure that
the profile is up-to-date.

4. When printing, select the correct color profile for the paper type that you are using.

Paper types that are defined in the printer also have color profiles stored in the printer. However, HP
recommends that you calibrate the paper before using it.

If you define a new paper type, the printer automatically leads you through calibration and profiling.

The following diagram shows the operations that the HP Color Center performs, in order.
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NOTE: You can perform all three operations in sequence, as shown. You can also choose to
start with or stop after any of the three operations. However, color calibration is performed
automatically after you add a new paper type.

Color calibration
Your printer uses color calibration to produce consistent colors with the specific printheads, inks, and
paper type that you are using, and in your particular environmental conditions. After color calibration,
you can expect to get identical prints from any two different printers that are situated in different
geographical locations.

Calibration should be done in any of the following circumstances:

● Whenever a printhead is replaced

● Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

● Whenever a certain amount of printing has been done since the last calibration

● Whenever the printer has been turned off for a long period of time

● Whenever the environmental conditions (temperature and humidity) change significantly

The printer usually reminds you with an alert whenever you need to perform color calibration, unless you
have disabled the alerts. However, if the environmental conditions change, the printer will not be aware
of it.

You can check the color calibration status of the currently loaded paper at any time by selecting the

 icon, and then selecting View loaded paper > View paper details. The status can be one of
the following conditions:

● Pending: the paper has not been calibrated

NOTE: Whenever you update the printer's firmware, the color calibration status of all
papers is reset to PENDING. See Update the printer firmware on page 141.

● Recommend: the printer software recommends that you calibrate the printer because it has
recognized a condition that might require calibration

● Obsolete: the paper has been calibrated, but the calibration is now out of date and should be
repeated

● OK: the paper has been calibrated, and the calibration is up to date

● Disabled: this paper cannot be calibrated

NOTE: Colored papers; glossy canvas; and transparent materials such as translucent bond,
clear film, tracing paper; and vellum are not suitable for color calibration.

You can also check the color calibration status by using HP Easy Printer Care (Windows) or HP Printer
Utility (Mac OS).

Calibrate a paper type before creating its color profile. Later recalibration does not require a new color
profile.
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You can start color calibration in the following ways:

● From the printer alert that recommends calibration

● From the HP Color Center: select Calibrate Your Printer

●
From the front panel: select the  icon, and then select Image quality maintenance >
Calibrate color

After launching calibration, the process is fully automatic and can be performed unattended after you
have loaded appropriate paper. The paper must be at least 24 inches wide.

The process takes about 8 minutes and consists of the following steps.

1. A calibration test chart is printed, which contains patches of each ink that your printer uses.

2. To stabilize the colors, the test chart dries for a period of time that depends on the paper type.

3. The HP Embedded Spectrophotometer scans and measures the test chart.

4. The printer uses the measurements to calculate the necessary correction factors for consistent color
printing on that paper type. It also calculates the maximum amount of each ink that can be applied
to the paper.

Color profiling
NOTE: Color profiling information applies only to PostScript printers.

Color calibration provides consistent colors, but consistent colors are not necessarily accurate colors.

In order to print accurate colors, convert the color values in your files to the color values that will produce
the correct colors when using your printer, your inks, and your paper. An ICC color profile is a description
of a printer, ink, and paper combination that contains all the information for these color conversions.

When you have defined and calibrated a new paper type, the printer is ready to create a ICC profile for
use with your paper, which allows you to print on it with the best possible color accuracy. Alternatively,
if your paper type is already known to the printer, you already have its appropriate ICC profile.

Create your own profile
Create a color profile easily by using the HP Color Center to select Create and Install ICC Profile.
The printer prompts for information about the paper, and then creates and installs the new profile
automatically.
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The process takes about 15 to 20 minutes and consists of the following steps.

1. A profiling test chart is printed, which contains patches of each ink used in your printer. Unlike a
calibration test chart, most of the patches contain combinations of ink.

NOTE: To use a longer drying time, instruct the HP Color Center to create the test chart
without creating a profile (Windows: select Print target only; Mac OS: select Print ICC
profiling chart). Later, when the chart is completely dry, restart the HP Color Center and
request a profile that uses the test chart that you have already created (Windows: select
Create ICC profile from a target that has already been printed; Mac OS:
select Scan ICC profiling chart and create ICC profile). The scan will begin after the
spectrophotometer warms up.

2. The HP Embedded Spectrophotometer scans and measures the test chart.

3. The printer uses the measurements to calculate the necessary correction factors for consistent color
printing on that paper type. It also calculates the maximum amount of each ink that can be applied
to the paper.

4. The new ICC profile is stored in the correct system folder on your computer, where your software
programs can find it.

The profile is also stored in the printer so other computers that are connected to the same printer can
copy it. A profile can be accessed and used as soon as a job is submitted from the Embedded Web
Server. HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) will notify you if your printer
has profiles that are not yet stored on your computer.

NOTE: You might need to quit and restart some programs in order to use a profile that has just
been created.

Use a third-party profile
If you have obtained an ICC profile through means other than using the printer’s built-in profiling software
(for instance from an Internet download or a third-party profiling software package), you can install it for
use with your printer and paper.

NOTE: You can only import and export CMYK profiles.

The printer needs to know which paper type the profile corresponds to. First select a paper type from the
list of papers that the printer recognizes. When selecting a paper type, try to pick one that resembles your
actual paper type as closely as possible. The paper type determines the amount of ink that is used and
other basic printing parameters, so making a good choice here is fundamental to achieving good results
later on. If you find that you cannot obtain satisfactory results with the profile and paper type that you
picked, try selecting different types, and use the one that works best.
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If the paper that you are using is not listed, or if you cannot find a paper type that resembles yours closely
enough, you can define a new type. See Use non-HP paper on page 47. The printer then calibrates itself
for use with that paper, after which you can return to installing the ICC profile.

After you have selected the paper type, browse to the file that contains the ICC profile to use with your
printer and paper. Normally, ICC profile file names end in the extension “.icc” (for International Color
Consortium) or “.icm” (for Image Color Matching). The profile is stored in the correct system folder on
your computer, and in the printer.

Profile your monitor
Also calibrate and profile your monitor (display device), so that the colors you see on the screen relate
more closely to those that you see on your prints. You can do this in two ways:

● Use your operating system. In the HP Color Center, select How To Calibrate Your Display for
further information.

● Use the optional HP Advanced Profiling Solution, which gives more accurate results.

HP Advanced Profiling Solution
HP and X-Rite have worked together to develop the HP Advanced Profiling Solution, powered by
GretagMacbeth™ technology, which takes advantage of the spectrophotometer that is built into the printer
to provide a revolutionary end-to-end calibrated ICC color workflow.

The HP Advanced Profiling Solution, tailored for HP printers, offers a powerful and automated, yet cost-
effective, color-management system with a fully streamlined workflow. This helps you to avoid the cost,
hassle, and delay of offline measurement devices. Together, GretagMacbeth and HP provide a new tool
that designers, photographers, and other creative professionals can use to generate proofs and photo-
quality prints accurately and consistently.

The Advanced Profiling Solution includes the following features:

● The HP Colorimeter monitor calibrator, with which you can accurately calibrate and profile all of
your monitors: LCD, CRT, and laptops

● An ICC profiling and editing software program that provides additional features and functionality
beyond those included in the HP Color Center

Use the Advanced Profiling Solution to perform the following tasks:

● See matching colors on your screen and printed paper.

● Edit your color profiles visually for maximum control.

● Perform all operations easily using a step-by-step software interface—no extra manuals are needed.

● Generate color profiles for all your paper types, in RGB or CMYK.

The HP Advanced Profiling Solution is fully supported by HP, so you do not need to deal with various
support organizations from different companies.

Key features
The HP Advanced Profiling Solution helps you take control of your colors:

● Calibrate and profile all of your monitors: LCD, CRT, and laptop.

● Perform an automated CMYK profiling through the HP software drivers to ensure accurate printing
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● Perform an automated CMYK profiling when your printer is driven by a Raster Image Processor (RIP)
for accurate digital prints and proofs.

● Edit your profiles easily and visually for ultimate color control.

Color-management options
The aim of color management is to reproduce colors as accurately as possible on all devices, so that when
you print an image, you see very similar colors as when you view the same image on your monitor.

The following are two basic approaches to color management:

● Application-Managed Colors: your software program converts the colors of your image to the
color space of your printer and paper type by using the ICC profile that is embedded in the image
and the ICC profile for your printer and paper type.

● Printer-Managed Colors: your software program sends your image to the printer without any
color conversion, and the printer converts the colors to its own color space. The details of this process
depend on the graphics language that you are using.

● PostScript: the PostScript interpreter module inside the printer performs the color conversion
by using the profiles that are stored in the printer and the ones that are sent with the PostScript
job. This kind of color management is done when you are using the PostScript driver and you
specify printer color management, or when you send a PostScript or PDF file directly to the
printer through the Embedded Web Server. In either case you have to select the profiles to use
as default (in case the job does not specify any) and the rendering intent to apply.

● Non-Postscript (PCL, RTL, HP-GL/2): the color management is done by using a set of
stored color tables. ICC profiles are not used. This method is somewhat less versatile than the
previous methods, but is a little simpler and faster, and can produce good results with standard
HP paper types. This kind of color management is done when you are using a non-PostScript
driver and you specify printer color management, or when you send a non-PostScript file directly
to the printer through the Embedded Web Server.

NOTE: The printer can convert only two color spaces to its own color space by using the
stored color tables: Adobe RGB and sRGB if you are using Windows, and Adobe RGB and
CYMK if you are using Mac OS

You are recommended to consult the HP Knowledge Center at http://www.hp.com/go/
knowledge_center/djz6100/ to see how to use the color-management options in your particular software
program.

Select Application-Managed Colors and Printer-Managed Colors according to the place you
want to establish the setting:

● In the Windows driver: click the Color tab.

● In the Mac OS Print dialog box: select the Color Options panel.

● In some applications: make this selection in the application.

Color adjustment options
The objective of color management is to print accurate colors. Perform color management correctly to print
accurate colors withuot manual color adjustments. However, manual adjustments might be useful in the
following situations:

● Your color management is not providing accurate colors

● You want colors that are subjectively pleasing rather than accurate
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You can adjust the colors of your print in similar ways In Windows and Mac OS:

● In the Windows driver: click the Color tab, and then select Print in color. Make sure that
the Advanced Color Adjustments check box is selected, and then click the Settings button.

● In the Mac OS Print dialog box: select the Color options panel, and then select CMYK
Settings.

In either operating system, you can make adjustments by using the black slider and the three color sliders.

● Use the black slider to make the entire print lighter or darker.

● Use the color sliders to fade or emphasize each of the primary colors in the print. The primary colors
are red, green, and blue or cyan, magenta, and yellow, depending on the color model that is used
in the image.

Perform black point compensation
NOTE: This option is available only when printing a PostScript, PDF, TIFF, or JPEG job.

The black point compensation option controls whether to adjust for differences in black points when
converting colors between color spaces. When this option is selected, the full dynamic range of the source
space is mapped into the full dynamic range of the destination space. It can be very useful in preventing
blocking shadows when the black point of the source space is darker than that of the destination space.
This option is allowed only when the relative colorimetric rendering intent is selected. See Set the rendering
intent on page 116.
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Black point compensation can be specified in the following ways:

● With a Windows PostScript printer driver: click the Color tab, and then select Black point
compensation.

● With a Mac OS printer driver: select the Color Options panel, and then select Black point
compensation.

● Through the Embedded Web Server: select the Submit Job page, and then select Color > Black
point compensation.

●
On the front panel: select the  icon, and then select Printing preferences > Color
options > Black point compensation.

Set the rendering intent
NOTE: This option is available only when printing a PostScript, PDF, TIFF, or JPEG job.

Rendering intent is one of the settings available when doing a color transformation. Because some of the
colors you want to print might not be reproducible by the printer, using the rendering intent allows you to
select one of four different ways of handling these out-of-gamut colors.

● Saturation (graphics): best used for presentation graphics, charts, or images that are made up
of bright, saturated colors

● Perceptual (images): best used for photographs or images in which colors blend together. This
setting attempts to preserve the overall color appearance.

● Relative colorimetric (proofing): best used when you want to match a particular color. This
method is mainly used for proofing. It guarantees that if a color can be printed accurately, it will be
printed accurately. The other methods provide a more pleasing range of colors but do not guarantee
that any particular color will be printed accurately. This option maps the white of the input space to
the white of the paper on which you are printing.

● Absolute colorimetric (proofing): this option is the same as relative colorimetric, but without
mapping of the white. This rendering is also used mainly for proofing, where the goal is to simulate
the output of one printer (including its white point).

The rendering intent can be specified in the following ways:

● With a Windows PostScript printer driver: click the Color tab, and then select Rendering
intent.

● With a Mac OS printer driver: select the Color Options panel, and then select Rendering
intent.

● Through the Embedded Web Server: select the Submit Job page, and then select Color >
Rendering intent.

●
On the front panel: select the  icon, then Printing preferences > Color options > Select
rendering intent.

HP Professional PANTONE* Emulation
When you use a named PANTONE* color in an image, your software program normally sends a CMYK
or RGB approximation to that color to the printer. However, instead of taking the printer or the paper type
into account, the software merely produces a generic approximation of the PANTONE* color, that looks
different on different printers and on different papers.
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HP Professional PANTONE* Emulation takes into account the characteristics of the printer and the paper
type. The results look as similar to the original PANTONE* colors as is possible on a given printer using
a given paper type. This technology is designed to produce emulations that are similar to those that
prepress professionals establish.

To use HP Professional PANTONE* Emulation, just turn it on.

● With the Windows PostScript printer driver: click the Color tab, and then select HP Professional
PANTONE Emulation.

● With a Mac OS printer driver: select the Color Options panel, and then selectHP Professional
PANTONE Emulation.

● Through the Embedded Web Server: select the Submit Job page, and then select Color > HP
Professional PANTONE Emulation.

●
On the front panel: select the  icon, and then select Printing preferences > Color
options > Black point compensation.

NOTE: HP Professional PANTONE* Emulation is available only when printing a PostScript or
PDF job.

You can also use the Embedded Web Server to print a swatch book that shows emulations of PANTONE*
colors from your printer, along with a measure of the color difference (ΔE) between each emulation and
the original PANTONE* spot color. HP Professional PANTONE* Emulation not only provides the closest
match that can be achieved on your printer; but also provides clear information about how close the
emulation is to the original spot color.

To print a swatch book, click the Embedded Web Server Main tab, and then select HP Professional
PANTONE* Emulation. Select the PANTONE* stock to emulate, and then select the PANTONE* colors
that you want to print. When you have selected all the colors that you want, click the Print button.
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Color emulation modes
If you want to print a particular print job and to see approximately the same colors that you would get
from printing the same job on a different HP Designjet series printer, use the printer's emulation mode.

NOTE: Color emulations do not apply to TIFF and JPEG jobs.

● In the Windows driver: click the Color tab, select Printer Managed Colors, and then select
Printer Emulation from the Source profile drop-down menu. Then select from the Emulated
printer drop-down menu.

● In the Mac OS Print dialog box: select the Color Options panel, and then select Printer
Emulation. Then select from the Emulated printer drop-down menu.

●
On the front panel: select the  icon, and then select Printing preferences > Color
options > Emulate Printer.

● Through the Embedded Web Server: select the Submit Job page, and then Job settings >
Advanced settings > Color > Color management and the desired emulation mode.

You can emulate the following printers:

● HP Designjet 1050c Plus

● HP Designjet 1055cm Plus
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● HP Designjet 5500 UV series

● HP Designjet 5500 Dye series

The following table shows approved combinations of print-quality settings and papers for the best printer-
emulation results.

 Best Normal Normal-Fast Fast

HP Premium
Instant-Dry Gloss
Photo Paper

Yes Yes No No

HP Universal
Instant-Dry Photo
Gloss

Yes Yes No No

HP Heavyweight
Coated Paper

Yes Yes No Yes

HP Coated Paper Yes Yes Yes Yes

HP Bright White
Inkjet Bond Paper

Yes Yes Yes Yes

NOTE: The HP Designjet 5500 UV printer series does not support HP Bright White Inkjet Bond
Paper.

The HP Designjet 1050c Plus and HP Designjet 1055cm Plus printer series do not support HP
Premium Instant-Dry Gloss Photo Paper or HP Universal Instant-Dry Photo Gloss Paper.

CMYK color emulation
All CMYK emulation options apply to PDF, PostScript, TIFF, and JPEG files only.

A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted to
the printer, because different printers will produce different colors from the same CMYK data. If the image
file that you are printing was not created specifically for your HP Designjet Z6100 printer, it will require
some readjustment, which can be done using one of the following options provided with your printer:

● U.S. Web Coated (SWOP) 2 uses specifications that are designed to produce quality separations
that use U.S. inks under the following printing conditions: 300% total area of ink coverage, negative
plate, coated publication-grade stock.

● U.S. Web Uncoated 2 uses specifications that are designed to produce quality separations that
use U.S. inks under the following printing conditions: 260% total area of ink coverage, negative
plate, uncoated white offset stock.

● U.S. Sheetfed Coated 2 uses specifications that are designed to produce quality separations that
use U.S. inks under the following printing conditions: 350% total area of ink coverage, negative
plate, bright white offset stock.

● U.S. Sheetfed Uncoated 2 uses specifications that are designed to produce quality separations
that use U.S. inks under the following printing conditions: 260% total area of ink coverage, negative
plate, uncoated white offset stock.

● Euroscale Coated 2 uses specifications that are designed to produce quality separations that use
Euroscale inks under the following printing conditions: 350% total area of ink coverage, positive
plate, bright white coated stock
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● Euroscale Uncoated 2 uses specifications that are designed to produce quality separations that
use Euroscale inks under the following printing conditions: 260% total area of ink coverage, positive
plate, uncoated white offset stock.

● Europe ISO Coated FOGRA27 uses the FOGRA27 press characterization. It is designed to
produce quality separations for standard ISO printing using: 350% total ink coverage, positive film
and coated paper"

● HP CMYK Plus: a set of HP proprietary re-rendering rules that produce a good result for most digital
commercial printing jobs by expanding the reduced gamut of your press into the wider gamut of
your printer.

● JMPA: Japanese standard for offset press

● Photoshop 4 Default CMYK

● Photoshop 5 Default CMYK

● Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3 (coated) paper.
It is designed to produce quality separations by using 350% total ink coverage, positive film, and
coated paper.

● Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4 (uncoated)
paper. It is designed to produce quality separations by using 310% total ink coverage, positive film,
and uncoated paper.

● Japan Web Coated (Ad) uses specifications that are developed by the Japan Magazine Publisher
Association for digital proofing of images in the Japanese magazine and advertising market.

● Japan Color 2002 Newspaper uses the Japan Color 2002 for Newspapers specification. It is
designed to produce quality separations using: 240% total ink coverage, positive film and standard
newsprint paper"

● Toyo is designed to produce quality separations for Toyo printing presses.

● DIC is designed to produce quality separations for Dainippon Ink Company printing presses.

● Other HP Designjet printers can be emulated.

● None (Native): no emulation, for use when the when the software or operating system complete
the color conversion. Therefore, the data arrives at the printer already color–managed

NOTE: These options have no effect if the software defines its own CMYK space, known as
calibrated CMYK or CIEBasedDEFG in PostScript terminology.

RGB color emulation
These options apply to PDF, PostScript, TIFF, and JPEG files. For HP-GL/2 and RTL files, only sRGB and
AdobeRGB are supported.

If you want to print an RGB image, it must be converted to CMYK data. You might be able to do the
conversion in the software or operating system. To perform this conversion on the printer, use the following
color profiles:

● None (Native): no emulation. The printer uses its default internal conversion from RGB to CMYK,
without following any color standard. This does not imply that results will be bad.

● sRGB IEC61966-2.1 emulates the characteristics of the average PC monitor. This standard space
is endorsed by many hardware and software manufacturers, and is becoming the default color space
for many scanners, printers, and software programs.
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● ColorMatch RGB emulates the native color space of Radius Pressview monitors. This space
provides a smaller gamut alternative to Adobe RGB (1998) for print-production work.

● Apple RGB emulates the characteristics of the average Apple monitor, and is used by a variety of
desktop publishing applications. Use this space for files that you plan to display on Apple monitors,
or for working with old desktop publishing files.

● Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do
print-production work that includes a broad range of colors.
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8 Practical printing examples

● Overview

● Resize an image by using Adobe Photoshop (HP–GL/2 and PostScript driver)

● Print a color photo (Photoshop CS2 v9.0, Win)

● Print a draft for revision with the correct scale

● Reprint a job with consistent colors

● Use ESRI ArcGIS 9 to print a map
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Overview
The following step-by-step instructions for printing jobs that use specific software are similar to those at the
HP Knowledge Center on the Web. Consult the Knowledge Center at http://www.hp.com/go/
knowledge_center/djz6100/ for the most up-to-date information and for additional printing examples,
including RIP scenarios.

Resize an image by using Adobe Photoshop (HP–GL/
2 and PostScript driver)
Application settings

1. Open your image in Adobe Photoshop, and then select Image size from the Image menu.

The Image Size dialog box appears.

2. Set the sizing options.

● Pixel Dimensions: Set the resulting image size

● Document Size and resolution: Set the resulting page size and resolution. As a general
guideline, consider setting the resolution according to your print quality setting. Refer to the
following table for guidance.

Print quality setting Recommended
resolution setting

Fast 300

Normal-Fast 300–600

Normal 600–900

Best 1200

For more information about the print quality setting, see Select print quality on page 80.
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● Constrain Proportions: Select this option if you want to preserve height-to-width ratio of
your original image

● Resample Image: When an image is resampled, an interpolation method is used to assign
color values to any new pixels that Photoshop creates, based on the color values of existing
pixels in the image. Photoshop uses sophisticated methods to preserve the quality and detail
from the original image when you resample. Select from the following resampling options:

● Nearest Neighbor: A fast but less precise method that replicates the pixels in an image.
This method is for use with illustrations that contain edges that are not anti-aliased, to
preserve hard edges and produce a smaller file. However, this method can produce
jagged effects, which become apparent when you distort or scale an image or perform
multiple manipulations on a selection.

● Bilinear: A method that adds pixels by averaging the color values of surrounding pixels.
It produces medium-quality results.

● Bicubic: A slower but more precise method based on an examination of the values of
surrounding pixels. Using more complex calculations, Bicubic produces smoother tonal
gradations than Nearest Neighbor or Bilinear.

● Bicubic Smoother: A good method for enlarging images based on Bicubic interpolation
but designed to produce smoother results

● Bicubic Sharper: A good method for reducing the size of an image based on Bicubic
interpolation with enhanced sharpening. This method maintains the detail in a resampled
image. If Bicubic Sharper oversharpens some areas of an image, try using Bicubic.

3. When you have finished setting the sizing options, click the OK button.

4. Select Print with preview from the File menu.

5. Click the Page Setup button.

The Page Setup dialog box appears.
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6. In the Paper size drop-down menu, select a page size and margin setting for the image that you
are printing and then click the Printer button.

A new Page Setup dialog box appears.

7. Click the Page Setup button.

8. Select your printer and then click the Properties button.

The printer driver dialog box appears.

9. Set the print options that you want and then click the OK button. For more information about print
option settings, see Print options on page 79.
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Print a color photo (Photoshop CS2 v9.0, Win)
This example uses Adobe Photoshop CS2 V9.0 in Windows XP. The color management is done by
Photoshop.

1. Initial recommendations:

● Select an appropriate paper type for the job.

● The paper type should be calibrated and profiled with the printer and the print-quality level that
you intend to use. See Color calibration on page 110 and Color profiling on page 111.

● To obtain a correct preview of the printed image, the monitor should also be profiled.

2. Open Adobe Photoshop CS2.

3. On the Edit menu, select Color Settings.

● Make sure that More Options are displayed.

● In Color Management Policies, select Preserve Embedded Profiles.

● In Profile Mismatches, select Ask When Opening and Ask When Pasting.

● In Missing Profiles, select Ask When Opening.

● In Conversion Options, click the More Options button to open Conversion Options,
and then select Intent > Perceptual.

● Click the OK button.

4. On the File menu, select Open to open the image.

● If the document has an embedded color profile that does not match the current working space,
select Use the embedded profile. Otherwise, select Assign working space.

If the image colors do not look right, try assigning it to other color spaces by selecting Edit
> Assign Profile (try sRGB, Adobe RGB, ColorMatch RGB and others) until you are
satisfied.

● Click the OK button.

5. On the File menu, select Print with Preview.

● Select Page Setup.

● Select the printer (for example, HP Designjet Z6100ps 60–in)

.

● In Paper size: select the size of the paper that is currently loaded in the printer.

● In Orientation: select the orientation of your image on the paper (portrait or landscape).

● Click the OK button.

● Set the Position and the Scaled Print Size that you want.

● Make sure that More Options are displayed.

● Click the Color Management tab.

● In Print: select Document.

● Select Options > Color Handling, and then select Let Photoshop Determine Colors.
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● Select Options > Printer Profile, and then select the correct profile for your printer and
paper type.

● Select Options > Rendering Intent, and then select Perceptual.

● Click the Print button.

6. Select the driver settings.

● In Printer: select the printer (HP Designjet Z6100ps 60–in).

● Click the Paper Type/Quality tab, and then specify these options:

● In Paper Type: select the paper type that is currently loaded in the printer.

● In Quality Options: select Standard options and drag the slider to Quality.

● Click the Color tab, and then specify these options:

● Select Print in Color.

● In Color Management: select Application Managed Colors.

● Click the Print button.

Print a draft for revision with the correct scale
Using Adobe Acrobat

1. In the Acrobat window, check the plot size by positioning your cursor near the bottom left corner of
the screen.
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2. Select File and then select Print.

NOTE: The page size is not automatically selected according to the drawing size.

3. To keep the scale, set Page Scaling to None (which is not the default setting).
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4. Click the Properties button and then click the Paper/Quality tab.

5. Select the Document Size and Print Quality you want to use. Click the Custom button to define
a new custom paper size.

6. Click the Features tab, and then select Autorotate.
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7. Click the OK button and check to see that the print preview in the Print dialog box looks correct.

Reprint a job with consistent colors
This scenario explains how to get consistent colors from print-to-print.

NOTE: HP supports color consistency between print jobs printed with the same printer models,
using the same paper type.

Scenario 1
Reprint a job with consistent colors by using the same printer.

To ensure color consistency when reprinting the job, use the same paper type.

1. Verify that the color calibration is valid for the paper type that is loaded. On the front pane, select

the  icon, and then select View loaded paper > View paper details. In the Paper
information window, verify that Color Calibration is OK. If the status of the Color Calibration
is Pending or Recommended, perform a color calibration from the HP Color Center, or on the
front panel.
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2. Reprint a job: Through the Embedded web server, go to the Job queue, select the job you want to
reprint, and then click the Reprint button.

A file can also be printed again if was stored in the printer. Through the Embedded Web Server, go
to Stored jobs in printer, select the job you want to print, and then click the Print button.

Scenario 2
Reprint a job by using two HP Designjet Z6100 printers.

To ensure color consistency when reprinting the job, use the same paper type.

1. Verify that the color calibration is valid for the paper type that is loaded in both printers. On the front

panel, select the  icon, and then select View loaded paper > View paper details. In
the Paper information window, verify that Color Calibration is OK. If the status of the Color
Calibration is Pending or Recommended, perform a color calibration from the HP Color Center,
or on the front panel.

2. Print the jobs.

Use ESRI ArcGIS 9 to print a map
ArcGIS is a scalable system of software for geographic data creation, management, integration, analysis,
and dissemination for every organization, from an individual to a globally distributed network of people.

The software always sends RGB data to the printer driver. Select from several different printer engines.
The printer engine determines the format and method that ArcMap uses to send the print job to the printer.
One to three options are available, depending on license and printer configurations.

● Windows is the default and is always available, regardless of the printer that is in use. It allows
the software to use the installed HP-GL/2 and RTL driver

● PostScript is available only if your printer supports PostScript and when the PostScript driver has
been selected in the Name section. This allows you to output the file as a PostScript file. This option
might be useful in certain specific cases, but in general it is not recommended.

● ArcPress is an extension that can be purchased for printing from ArcGIS. It is a software RIP that
takes the original metafile and applies raster to it before sending it to the printer, so that the printer
does not need to. This is beneficial because some printers cannot apply raster or do not have enough
memory to process large jobs. Always use ArcPress with HP RTL (RGB) TrueColor.

Use the Windows printer engine
1. Make sure that you have installed the HP-GL/2 and RTL driver.
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2. When you are ready to print, select File > Page and Print Setup, and select the HP-GL/2 and
RTL driver.

3. Click the Properties button and configure the driver as follows.

● On the Paper/Quality tab, set Print Quality to Quality.

● On the Color tab, clear the Print In Grayscale check box, and set Printer managed
colors to sRGB in the Source profile drop-down menu.

4. Click the OK button.

5. Select File > Print.

● Printer Engine: select Windows Printer.

● Output Image Quality (Resample Ratio): this setting alters the number of pixels that are
sampled when an ArcMap print file is generated. It determines how many pixels in the map
document are used to create the file that goes to the printer.

● Fast = 1:5

● Normal = 1:3

● Best = 1:1 (as is)

Selecting Best requires a lot of printer resources to process the print job, and might cause long
processing times and generate out-of-memory messages, depending on the map size. If you
experience these issues, select an Output Image Quality that is lower than Best. You will gain
no advantage in print quality when you send an image that has resolution higher than the
printer's input resolution.
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6. Click the OK button to print.

Use the ArcPress printer engine
1. Even though it will function only as a port, you must have the driver that you need installed.

2. When you are ready to print, select File > Page and Print Setup, select the driver (the driver
settings have no effect), and click the OK button.

3. Select File > Print.

● Printer Engine: select ArcPress.

● Click the Properties button, select the HP RTL (RGB) TrueColor driver, and select the
resolution to be sent to the printer.
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● Click the Color Adjustment tab if you want to adjust gamma, brightness, contrast, or
saturation. You can preview the changes.

4. To print, click the OK button both in this dialog box and in the Print dialog box.
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9 Maintain the printer

● Clean the exterior of the printer

● Clean the platen

● Clean the paper-advance sensor window

● Lubricate the printhead carriage

● Maintain the ink cartridges

● Perform preventive maintenance

● Move or store the printer

● Update the printer firmware

● Change the ink absorber

● Secure disk erase
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Clean the exterior of the printer
Use a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap to
clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation (for example, ink cartridge drawer handles).

WARNING! To avoid an electric shock, make sure that the printer is turned OFF and unplugged
before you clean it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.

Clean the platen
You should clean your printer's platen every few months, or when necessary.

NOTE: If you print on wide paper after having printed on narrower paper, you might find that
the left side of the platen has become dirty. If this contaminated section of the platen is not cleaned,
it might leave marks on the back of the paper.

WARNING! Be careful not to damage the paper-advance sensor when cleaning the platen. The
sensor is the very small rectangular window (less than 1 square centimeter and shown in the
following graphic) found near the sixth platen roller from the right. See Clean the paper-advance
sensor window on page 138.

Follow these instructions to clean the platen.

1. Unload all paper from the printer. See Unload a roll from the printer on page 36.

2. Open the printer window.
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3. With a dry brush, remove ink deposits from the cutter groove.

4. With the same dry brush, remove ink deposits from the platen surface.

5. Use a clean, absorbent lint-free cloth that has been slightly dampened with isopropyl alcohol to wipe
loosened ink deposits from the platen.

NOTE: Isopropyl alcohol is not provided in the Maintenance Kit.

CAUTION: Do not use commercial cleaners or abrasive cleaners. Do not wet the platen
directly, because you will leave too much moisture behind.

6. Use the damp cloth to clean the cutter ramp.
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7. Use a dry cloth to clean the exposed part of the wheels. Ideally, you should clean the entire
circumference of these wheels.

Clean the paper-advance sensor window
The paper advance sensor is the very small rectangular window (less than 1 square centimeter in size and
shown in the following graphic) near the sixth platen roller from the right.

HP recommends that you clean the paper-advance sensor window whenever you clean the print platen
and if you are experiencing print quality issues.

Before cleaning the paper-advance sensor window, unload the media by using the front panel procedure.
See Unload a roll from the printer on page 36. Then use a clean, absorbent, lint-free cloth that you have
slightly dampened with isopropyl alcohol to very gently wipe any dust and loosened ink deposits from the
sensor window.

Wait 3-4 minutes before reloading the media to ensure that the alcohol has evaporated completely.

Under ambient light, a clean sensor window shows a violet-colored reflection that extends uniformly across
the entire surface. To see this reflection, look closely at the sensor window and slightly change your viewing
angle.
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Lubricate the printhead carriage
The printhead carriage occasionally (about once a year) needs lubrication so that it continues to slide
easily along the slider rod.

1.
To gain access to the carriage, go to the front panel and select the  icon, and then select Replace
printheads. The carriage slides to the middle section of the printer.

CAUTION: If the carriage remains in the central part of the printer for more than 7 minutes,
it attempts to return to its home position on the right.

2. Take the bottle of oil from the Maintenance Kit that is supplied with your printer. A replacement kit
can be ordered if necessary.

3. Open the printer window and apply a few drops of the oil to the pads on either side of the carriage.

4. Apply a few drops of oil directly to the slider rod on either side of the carriage.

5. Close the printer window.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to
maintain the best print quality, you should replace a cartridge when it has reached its expiration date,
which is the manufacturing date marked on the cartridge plus 30 months.

Perform preventive maintenance
During the life of your printer, components that are used constantly can wear out.

To avoid having these components degrade to the point that the printer breaks down, the printer keeps
track of the number of cycles that the printer carriage makes across the axis of the printer, and also
monitors the total quantity of ink used.
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The printer uses these numbers to track the need for preventive maintenance, and displays one of the
following messages on the front panel:

● Maintenance #1 required

● Maintenance #2 required

These messages mean that some components are nearing the end of their lives. You can continue printing
for quite some time, depending on your use of the printer. However, HP strongly recommends that you
contact your customer service representative and arrange for a preventive maintenance visit. The service
engineer can then replace the worn parts onsite, which will prolong the life of the printer.

The benefits of arranging a service engineer's visit when these messages appear on the front panel are
two-fold:

● The printer components can be replaced at a time that is convenient for you, and so will not disturb
your daily workflow.

● When the service engineer performs a preventive maintenance visit, replaces several parts at once.
This eliminates the need for repeat visits.

Move or store the printer
If you need to move your printer or store it for an extended period of time, prepare it correctly to avoid
possible damage.

1. Do not remove the ink cartridges, printheads, or printhead cleaners.

2. Make sure that no paper is loaded.

3. Make sure that the printhead carriage is located in the service station (at the right end of the printer).

4. Make sure that the Ready message appears on the front panel.

5. Turn off the power by using the Power button on the front panel.

6. Also switch off the power switch at the rear of the printer.

7. Disconnect the power cable and any cables that connect the printer to a network, a computer, or a
scanner.
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8. If you have a take-up reel installed, remove the take-up reel sensor and cable-housing unit from the
foot of the printer stand. For your convenience, you can place the sensor and cable-housing unit on
the printer-stand crossbar and use the blue, plastic screw to affix the housing unit to the leg of the
stand, while you move the printer. (See the following graphic.) When reinstalling the housing unit,
make sure that the wheel on the foot of the printer stand is pointing forward.

NOTE: If the printer or ink cartridges are moved from a cold location to a warm and humid
location, water from the atmosphere can condensate on the printer parts and cartridges and
can result in ink leaks and printer errors. In this case, HP recommends that you wait at least
3 hours before turning on the printer or installing the ink cartridges, to allow the condensate
to evaporate.

TIP: Because preparing and purging the printheads uses both time and ink, you are strongly
recommended to leave the printer always on or in sleep mode, whenever possible, to maintain
the health of the printheads. In both cases, the printer wakes up from time to time to maintain
the printheads. Thus you can avoid going through lengthy preparation processes before using
your printer.

Update the printer firmware
The printer's various functions are controlled by software that resides in the printer, also known as
firmware.

From time to time, firmware updates from Hewlett-Packard become available. These updates increase the
printer's functionality and enhance its features.

Firmware updates can be downloaded from the Internet and installed in your printer in the following ways.
Use the method that you find most convenient.

● In Windows, open the HP Easy Printer Care, select your printer, click the Support tab, and then
select Firmware Update.

● In Mac OS, open the HP Printer Utility, select Support and then select Firmware Update.

● Through the printer's Embedded Web Server, click the Setup tab and then select Firmware
update.

Follow the onscreen instructions to download the firmware file and store it on your hard disk. Then select
the downloaded file and click Update.

The firmware includes a set of the most commonly used paper profiles. Extra paper profiles can be
downloaded separately; see Download paper profiles on page 47.
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If you experience very slow progress while uploading the firmware file to the printer, the reason could be
that you are using a proxy server. In that case, try bypassing the proxy server and accessing the Embedded
Web Server directly.

● In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and select the Bypass proxy server for local addresses check box. Alternatively,
for more precise control, click the Advanced button and add the printer's IP address to the list of
exceptions, for which the proxy server is not used.

● In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change
Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which
the proxy server is not used.

Change the ink absorber
An alert appears on the printer front panel when the ink absorber is reaching its maximum saturation and
again when the absorber should be changed.

NOTE: The absorber can become excessively dry and fail to function correctly in climates where
the relative humidity is consistently below 25%.

CAUTION: A saturated or excessively dry ink absorber can cause severe damage to the
printheads and other parts of the printer. HP strongly recommends that you promptly change the
ink absorber when alerted.

Remove the ink absorber
1. Find the ink absorber and disposable plastic gloves that are included in the maintenance kit that

came packaged with your printer.

2.
On the printer's front panel, select the  icon, and then select Replace maintenance ctg.

3. Open the printer window.

142 Chapter 9   Maintain the printer

M
a
inta

in the p
rinter



4. Identify the left spittoon.

5. Locate the ink absorber.

6. Lift the tab that extends from the front edge of the absorber.

NOTE: Use the disposable plastic gloves to avoid getting ink on your hands.

7. Lift the tab on the absorber until it is clear of the spittoon and you can easily grip the tab.

8. Lift and remove the absorber from the spittoon.
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9. Dispose of the soiled ink absorber according to your local regulations.

Insert the ink absorber
1. Grip the new ink absorber as shown.

2. Insert the back edge of the absorber into the fitting in the spittoon.

3. Use your thumb to slide the absorber to the back of the fitting in the spittoon.
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4. Push down on the tabbed edge until you hear the absorber click into place. Make sure that the top
of the ink absorber is seated flatly and that none of the corners are higher than the plane of the
platen.

5. Press the OK button on the front panel. The printer verifies that the ink absorber is correctly seated.
If the front panel shows a message that it is not seated correctly, remove the ink absorber, insert it
again, and then press the OK button.

Secure disk erase
The printer's hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase facility
can completely erase your information from the hard disk to protect it from unauthorized access. You can
choose to erase particular files, or the whole hard disk.

Secure Disk Erase provides three different levels of security:

● Non-Secure Fast Erase: all pointers to the information are erased. The information itself remains
on the hard disk until the disk space it occupies is needed for other purposes, and it is then
overwritten. While it remains on the disk, it is difficult for most people to access, but may be accessed
using software designed for the purpose. This is the normal method in which files are erased on most
computer systems; it is the fastest method but the least secure.

● Secure Fast Erase: all pointers to the information are erased, and the information itself is also
overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but
more secure. It may still be possible to access fragments of the erased information by using special
tools to detect residual magnetic traces.

● Secure Sanitizing Erase: all pointers to the information are erased, and the information itself is
repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the
slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense
5220-22.m requirements for clearing and sanitization of disk media. This is the default security level
when using Secure Disk Erase.

Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print
management software. See http://www.hp.com/go/webjetadmin/.

If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support. See HP
Customer Care on page 183.

NOTE: If you choose to erase the whole hard disk, you may be asked to restart the printer several
times during the process, which will take about 6 hours with Secure Disk Erase or 24 hours with
Secure Sanitizing Erase.
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10 Accessories

● Order accessories
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Order accessories
The following accessories can be ordered for your printer.

Name Product number

HP Designjet 256 MB Memory Upgrade (increases the memory capacity of your printer to work
with complex files)

Q5673A

HP Designjet 42–inch Scanner Q1277A

HP Advanced Profiling Solution Software WW Q6695A

HP Advanced Profiling Solution Software AP Q6701A

HP Jetdirect 635n IPv6/IPsec Print Server J7961A

HP Jetdirect 625n Gigabit Ethernet Print Server J7960G

HP Designjet High speed USB 2.0 Card (provides a high speed connection direct to your printer) Q5680A

HP Designjet Z6100 42–inch Spindle (spare spindles ease the process of switching between
different types of paper)

Q6707A

HP Designjet Z6100 60–inch Spindle (spare spindles ease the process of switching between
different types of paper)

Q6708A

HP Designjet Z6100 42–inch Take-Up Reel Q6706A

HP Designjet Z6100 60-in Media Bin Q6714A

HP Designjet Z6100 User Maintenance Kit Q6715A
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11 Troubleshoot print-quality issues

● General advice

● The Embedded Web Server Print Quality Troubleshooting wizard

● Lines are too thick, too thin, or missing

● Lines appear stepped or jagged

● Parts of lines or text are missing

● Lines are printed double or in the wrong colors

● Lines are blurred (ink bleeds from lines)

● Lines are slightly warped

● Dark or light horizontal lines across the image (banding)

● The image is grainy

● The image has a metallic hue (bronzing)

● The printed output is not flat

● The print smudges when touched

● Ink marks appear on the paper

● Defects near the top of a print

● Colors are inaccurate

● The output is completely blank

● The output contains only a partial print

● The image is clipped

● The image is in one portion of the printing area

● The image is unexpectedly rotated

● The print is a mirror image of the original

● The print is distorted or unintelligible

● One image overlays another on the same print

● Pen settings seem to have no effect

● The image has a wood-grain appearance (aeroworms)
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General advice
Use the following approach when you have any print-quality problem:

● To achieve the best performance from your printer, use only genuine HP supplies and accessories,
whose reliability and performance have been thoroughly tested to give trouble-free performance and
best-quality prints. For details of recommended papers, see Order paper on page 49.

● Make sure that the paper type that you select on the front panel is the same as the paper type that
is loaded in the printer. Make sure that the paper type has been calibrated. Also make sure that the
paper type that you select in your software is the same as the paper type that you loaded in the
printer.

CAUTION: If you have the wrong paper type selected, you might experience poor print
quality and incorrect colors, and damage to the printheads might occur.

● Make sure that you are using the most appropriate print-quality settings for your purposes. See Select
print quality on page 80. You are likely to see lower print quality if you have moved the print-quality
slider to the Fast end of the scale, or set the custom quality level to Fast.

● Make sure that your environmental conditions (temperature, humidity) are in the recommended
range. See Environmental specifications on page 191.

● Make sure that your ink cartridges and printheads have not passed their expiration dates. See
Maintain the ink cartridges on page 139.

● Avoid touching the paper while printing is in progress.

The Embedded Web Server Print Quality
Troubleshooting wizard

The Embedded Web Server Print Quality Troubleshooting wizard is designed to help you resolve some
of the most common print-quality issues that users encounter in large-format printing. The wizard guides
you through the resolution of the following print-quality issues:

● Dark or light horizontal lines across the image (banding)

● Graininess
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● Poor line quality

● Inaccurate color

To access the Embedded Web Server Print Quality Troubleshooting wizard, click the Print Quality
Troubleshooting link on the Support tab. Select the print-quality issue that you are experiencing and
click the Next button.

A list of suggestions for corrective action appears along with help to guide you through the corrective
action.

Lines are too thick, too thin, or missing

1. Verify that the paper type that you have loaded corresponds to the paper type that you selected on
the front panel and in your software.

2. Make sure that you are using the appropriate print-quality settings for your purposes. See Select print
quality on page 80.

3. If you are using a HP-GL/2 driver and the resolution of your image is greater than the printing
resolution, you might notice a loss of line quality. You can find the Max. Application
Resolution option on the Windows driver Advanced tab, under Document Options > Printer
Features. If you change this option, reprint your job if the problem has been solved.

4. If lines are too thin or missing, print the Printhead status plot. See Use the Printhead status plot
on page 71.

5. Try aligning the printheads. See Align the printheads on page 71. After alignment, reprint your job
if the problem has been solved.

6.
Select the  icon on the printer's front panel, and then View loaded paper to see the paper-
advance calibration status. If the status is PENDING, perform a paper-advance calibration. See
Perform paper advance calibration on page 46.

If the problem persists after you complete these actions, contact your customer service representative for
further support.

Lines appear stepped or jagged
Use the following procedure if lines in your image appear stepped or jagged when printed:
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1. The problem might be inherent in the image. Try to improve the image within the software program
that you are using to edit it.

2. Make sure that you are using appropriate print-quality settings. See Select print quality
on page 80.

3. If you are using an HP-GL/2 driver, hange your image-rendering resolution to 300 dpi or 600 dpi,
depending on your printing need. The Max. Application Resolution option in the Windows
driver dialog's Advanced tab, under Document Options > Printer Features.

Parts of lines or text are missing
A high-quality large-format print job often requires a large amount of data, and in some specific workflows,
the output might not look like you expected. Here are some suggestions to help you to avoid this problem:

● Select a smaller page size and scale to the final page size in the driver or on the front panel.

● Save the file in another format, such as TIFF or EPS, and open it in another program.

● Use a RIP to print the file.

● Reduce the resolution of the bitmap images in your software.

● Select a lower print quality in order to reduce the resolution of the printed image.

● On the Advanced tab of the Windows driver dialog, select Document options, Printer
features, and then establish the following settings:

● Set Send job as bitmap to Enabled (HP-GL/2 driver only).

● Set 16-bit App. Compatibility to Enabled.

● Set Max. Application resolution to 300.

NOTE: These settings are described for troubleshooting purposes only and might adversely
affect the final output quality or the time necessary to generate the print job. Therefore, restore
these settings to their default values if they do not help to solve the problem.
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Lines are printed double or in the wrong colors
This problem can have various visible symptoms:

● Colored lines are printed double, in different colors.

● The borders of colored blocks are the wrong color.

Use these steps to correct this kind of problem:

1. Align the printheads. See Align the printheads on page 71.

2. Make sure that you are using appropriate print-quality settings. See Select print quality
on page 80.

Lines are blurred (ink bleeds from lines)
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Humidity can cause ink to soak into the paper, making the lines look blurred and fuzzy. Try the following
remedies:

1. Make sure that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications on page 191.

2. Verify that the paper type that you select on the front panel is the same as the paper type that you

are using. To check, select the  icon from the printer's front panel, and then select View loaded
paper.

3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper, HP Super
Heavyweight Coated Paper, or Digital Fine Art paper.

4. If you are using glossy paper, try changing to a different type of glossy paper.

5. Align the printheads. See Align the printheads on page 71.

Lines are slightly warped
The paper itself might be warped. This can happen if it has been used or stored in an extreme environment.
See Environmental specifications on page 191.

Dark or light horizontal lines across the image
(banding)

Try the following remedies if your printed image suffers from added horizontal lines as shown (the color
may vary):

1. Make sure that the paper type you have loaded corresponds to the paper type that you select on the
front panel and in your software.

2. Make sure that you are using appropriate print-quality settings for your purposes. See Select print
quality on page 80. In some cases, you can overcome a print-quality problem merely by selecting a
higher print-quality level. For instance, if you have set the print-quality slider to Fast, try setting it
to Best. If you change the print-quality settings, reprint your job if the problem has been solved.

3. Print the Printhead status plot. See Use the Printhead status plot on page 71.
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4. Check the paper-advance calibration status on the front panel. If the status is PENDING, you should
perform paper-advance calibration. See Perform paper advance calibration on page 46.

5. Try aligning the printheads. See Align the printheads on page 71. After alignment, reprint your job
if the problem has been solved.

If the problem persists, contact your customer service representative for further support.

The image is grainy

1. Verify that the paper type you have loaded corresponds to the paper type that you select on the front
panel and in your software.

2. Verify that you are printing on the correct side of the paper.

3. Make sure that you are using appropriate print-quality settings. See Select print quality
on page 80. In some cases, you can overcome a print-quality problem merely by selecting a higher
print-quality level. For instance, if you have set the print-quality slider to Fast, try setting it to Best.
If you change the print-quality settings, reprint your job if the problem has been solved.

4. Try aligning the printheads. See Align the printheads on page 71. After alignment, reprint your job
if the problem has been solved.

5. Check the paper-advance calibration status on the front panel. If the status is PENDING, you should
perform paper-advance calibration. See Perform paper advance calibration on page 46.

If the problem persists, contact your customer service representative for further support. See HP Customer
Care on page 183.

The image has a metallic hue (bronzing)
Bronzing describes an image that has a metallic hue when it is viewed from specific angles. Bronzing
occurs most commonly when you print pigmented inks on non-matte paper, such as photo paper. If you
are using standard print-quality options and the image contains the bronzing effect, move the slider to
Quality. See Select print quality on page 80.

If you are experiencing bronzing when printing grayscale images on glossy paper, try using the Full Set
of Inks printing option. To do so from the Windows driver, click the Color tab and select Print In
Grayscale, and then select the Full Set of Inks option from the drop-down menu.
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The printed output is not flat
If the paper does not lie flat when it comes out of the printer, but instead contains shallow waves, you are
likely to see defects in the printed image, such as vertical stripes. This can happen when you use thin
paper that becomes saturated with ink.

1. Make sure that the paper type you have loaded corresponds to the paper type that you select on the
front panel and in your software.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper, HP Super Heavyweight
Coated Paper, or thicker Digital Fine Art papers.

The print smudges when touched
The black ink pigment can smudge when a finger or pen touches it. This is particularly noticeable on:
vellum, translucent bond, films, productivity photo paper, and natural tracing paper.

Try these remedies to reduce the smudging:

● Try to print in an environment that is not too humid for the printer. See Environmental
specifications on page 191.

● Change pure black objects in your image to a dark color, such as dark brown, so that they are
printed with colored inks instead of black ink.

● Use HP Heavyweight Coated Paper.

● Increase the drying time. See Change the drying time on page 49.

Ink marks appear on the paper
This problem can occur for several different reasons.

Smears on the front of coated paper
If a lot of ink is used on coated paper, the paper absorbs the ink quickly and expands. As the printheads
move over the paper, the printheads come into contact with the paper and smear the printed image.
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Whenever you notice this problem, cancel the printing job immediately. Press the Cancel button on the
front panel and also cancel the job from your computer software. Otherwise the soaked paper might
damage the printheads.

Try the following suggestions to avoid this problem:

● Use a recommended paper type. See Supported paper types on page 28.

● If the image you are printing contains intense color, try using HP Heavyweight Coated Paper.

● Use extended margins (see Adjust margins and layout options on page 82), or try to increase the
margins by relocating the image within the page by using your software program.

● If necessary, try changing to a non-paper-based material such as transparent film.

Smears or scratches on the front of glossy paper
Glossy paper can be extremely sensitive to the bin or to anything else that it contacts soon after printing.
This depends on the amount of ink that has been deposited on the paper and the environmental conditions
at the time of printing. Avoid any contact with the paper surface and handle the print with care.

Ink marks on the back of the paper
Ink residue on the platen or the input rollers is likely to mark the back of the paper. See Clean the
platen on page 136.

Defects near the top of a print
In a defect that affects only the start of a print, within 5.5 cm of the leading edge of the paper, a band
of inconsistent color appears:

Use these steps to avoid this problem:

1. The easiest solution might be to select the Extended Margins option in the driver, through the
Embedded Web Server, or on the front panel. Using this remedy means that the area of the paper
affected by the problem (at the start of the page) might not be printed on. See Adjust margins and
layout options on page 82.

2. Align the printheads. See Align the printheads on page 71.

3. Make suer that you are using appropriate print-quality settings. See Select print quality
on page 80.
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Colors are inaccurate

If the colors of your print do not match your expectations, try the following remedies:

1. Verify that the paper type you have loaded corresponds to the paper type that you selected on the
front panel and in your software. At the same time, check the color-calibration status. If the status is
RECOMMENDED or OBSOLETE, you should perform color calibration. See Color calibration
on page 110. If you have made any changes, reprint your job if the problem has been solved.

2. Verify that you are printing on the correct side of the paper.

3. Make sure that you are using the appropriate print-quality settings. See Select print quality
on page 80. If you have selected the Fast options, you might not get accurate colors. If you change
the print-quality settings, reprint your job if the problem has been solved.

4. If you are using Application Color Management, make sure that the color profile that you are using
corresponds to the selected paper type and print-quality settings. If you have doubts about which
color settings to use, see Color management on page 104. If you need to create a color profile,
see Color profiling on page 111.

5. If the problem consists of color differences between your print and your monitor, follow the instructions
in the “How to calibrate your monitor” section of the HP Color Center. Reprint your job if the problem
has been solved.

6. Print the Printhead status plot. See Use the Printhead status plot on page 71.

7. Consult the HP Knowledge Center at http://www.hp.com/go/knowledge_center/djz6100/ for
step-by-step color assistance with different software programs (English language content only).

If the problem persists, contact your customer service representative for further support. See Get help
on page 182.

PANTONE* colors are inaccurate
See HP Professional PANTONE* Emulation on page 116.

Colors between different HP Designjets do not match
If you print an image on two different printer models (for instance, on an HP Designjet Z6100 printer
series and an HP Designjet 5500 printer series), the colors of the two prints might not match well.

Matching two printing devices that use different ink chemistry, paper chemistry, and printheads is unlikely
to be completely successful. Use the information provided here is to attempt to make one printer match
another.
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Print with PostScript drivers
The situation describes printing with the PostScript driver installed for that printer. In this example, we are
using an HP Designjet Z6100 printer series and an HP Designjet 5500 printer series.

1. Verify that both printers have the most recent firmware version. See Update the printer firmware
on page 141.

2. Verify that you have the most recent printer driver for both printers. Download the latest versions for
any HP printer from http://www.hp.com/go/designjet.

3. Make sure that Color Calibration is turned on. On the front panel of the HP Designjet Z6100, select

the  icon, and then select Printer configuration > Color calibration > On.

4. Load the printers with the same type of paper.

5. Verify that the Paper Type setting on the front panel corresponds to the paper that you have loaded.

6. Use you normal settings to print your image on the HP Designjet 5500.

7. Now prepare to print the same image on the HP Designjet Z6100.

In your software, set the color space of the image to emulate the HP Designjet 5500 and the specific
paper type that you used in that printer. The data sent to the driver must be already converted to this
emulation color space, which is a CMYK color space. See the online help for the software program
to find information about how to do this. In this way, the Z6100 will emulate the colors that the 5500
can produce when printing on that paper type.

8. In the PostScript driver for the HP Designjet Z6100, go to the Color Management section and set the
CMYK input profile to the same HP Designjet 5500 color space that you selected in the software (the
emulation color space).

NOTE: When trying to emulate another printer you should always use CMYK colors, not
RGB.

9. Set the rendering intent to Relative Colorimetric, or to Absolute Colorimetric if you want to emulate
the whiteness of the paper.

10. Print the image on the HP Designjet Z6100.

Print with HP-GL/2 drivers
The situation describes printing with the HP-GL/2 driver installed for that printer.

1. Verify that both printers have the most recent firmware version. See Update the printer firmware
on page 141.

2. Verify that you have the most recent printer drivers for both printers. You can download the latest
versions for any HP printer from http://www.hp.com/go/designjet.

3. Make sure that Color Calibration is turned on. On the front panel of the HP Designjet Z6100 printer

series, select the  icon, then Printer configuration > Color calibration > On.

4. Load the printers with the same type of paper.

5. Verify that the Paper Type setting on the front panel corresponds to the paper you have loaded.
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6. In the HP-GL/2 driver for the HP Designjet Z6100, click the Color tab, and select Printer
Emulation from the list of color management options. Then select the HP Designjet 5500 from the
list of emulated printers.

7. In the HP-GL/2 driver for the HP Designjet 5500, click the Options tab, and then select Manual
Color > Color Control > Match Screen. Also click the Paper Size tab, and then select Paper
Type.

Print the same HP-GL/2 file
The situation describes how to produce an HP-GL/2 file (also known as a PLT file) with the HP-GL/2 driver
installed for one printer that you intend to send to another printer.

1. Verify that both printers have the most recent firmware version. See Update the printer firmware
on page 141.

2. Make sure that Color Calibration is turned on. At the front panel of the HP Designjet Z6100, select

the  icon, then Printer configuration > Color calibration > On.

3. Load the printers with the same type of paper.

4. Verify that the Paper Type setting on the front panel corresponds to the paper you have loaded.

5. If you have an HP-GL/2 file for an HP Designjet 5500 and you want to print it on an HP Designjet
Z6100, use the Embedded Web Server or the front panel.

● Through the Embedded Web Server: leave the color options set to Default.

●
On the front panel: select the  icon, and then select Printing preferences > Color
options > Emulate printer > HP Designjet 5500 Series.

For other HP Designjet printers, set both printers to match the screen colors (sRGB, if that is available),
as when printing with separate HP-GL/2 drivers.

The output is completely blank
If the front-panel graphic language setting is Automatic (the default), try the other settings:
PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 file, and so on. Then send the file again.

When you have finished this particular print, remember to reset the graphic language to Automatic.

The output contains only a partial print
● If you pressed Cancel before the printer received all the data, you ended the data transmission and

will have to print the page again.

● The I/O timeout setting might be too short. This setting determines how long the printer waits for
the computer to send more data, before deciding that the job is finished. On the front panel, increase

the I/O timeout setting to a longer period and then send the print again by selecting the  icon,
and then selecting Connectivity menu > Advanced > Select I/O timeout.

● A communications problem between your computer and the printer might exist. Check your USB or
network cable.

● Verify that your software settings are correct for your current page size (for example, long-axis prints).

● If you are using network software, make sure that it has not timed out.
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The image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and
the printable area as described by your software. You can often identify this kind of problem before
printing by previewing your print. See Hold for preview on page 90.

● Check the actual printable area for the paper size that you have loaded.

printable area = paper size – margins

● Check what your software understands to be the printable area (which it might cite as "printing area"
or "imageable area"). For example, some software programs assume standard printable areas that
are larger than those used in this printer.

● If you have defined a custom page size that has very narrow margins, the printer might impose its
own minimal margins and clip your image slightly. You might want to use a larger paper size.
See Adjust margins and layout options on page 82.

● If your image contains its own margins, you might be able to print it successfully by using the Clip
Contents by margins option. See Adjust margins and layout options on page 82.

● If you are trying to print a very long image on a roll, make sure that your software can print an image
of that size.

● You might have asked to rotate the page to landscape orientation on a paper size that is not
sufficiently wide.

● If necessary, reduce the size of the image or document in your software, so that it fits between the
margins

Other explanations exist for a clipped images. Some programs, such as Adobe Photoshop, Adobe
Illustrator, and CorelDRAW, use an internal 16-bit coordinate system which means that they cannot handle
an image of more than 32,768 pixels. If you try to print a larger image, the bottom of the image will be
clipped. To print the entire image, try these suggestions:

● If you are using an HP-GL/2 driver, you can reduce the resolution so that the whole image requires
fewer than 32,768 pixels. The Windows driver includes an option called 16-bit App.
Compatibility, which reduces the resolution automatically. The option is on the Advanced tab,
under Document Options > Printer Features.

● Save the file in another format, such as TIFF or EPS, and open it in another program.

● Use a RIP to print the file.

The image is in one portion of the printing area
● In the software, have you selected a page size that is too small?

● Does your software read the image as being in one portion of the page?

The image is unexpectedly rotated

On the front panel, select the  icon, and then select Printing preferences > Paper options >
Rotate. Verify that the setting is what you wanted.

For non-PostScript files: if Nesting is On, pages are sometimes automatically rotated to save paper.
See Nest jobs to save paper on page 98.
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The print is a mirror image of the original

On the front panel, select the  icon, and then select Printing preferences > Paper options >
Enable mirror image. Verify that the setting is what you wanted.

The print is distorted or unintelligible
● The interface cable that is connecting your printer to your network (or to your computer) might be

faulty. Try another cable.

●
On the front panel, select the  icon, and then select Printing preferences > Select graphics
languag. If the language setting is Automatic (the default), try the other settings: PostScript for
a PostScript file, HP-GL/2 for an HP-GL/2 file, on so on. Then send the file again.

● Depending on the software, drivers, and RIPs that you are using with your printer, different ways to
solve this problem exist. Refer to the vendor's user documentation for details.

One image overlays another on the same print
The I/O timeout setting might be too long. On the front panel, decrease the setting and print again.

Select the  icon, and then select Connectivity menu > Advanced > Select I/O timeout.

Pen settings seem to have no effect
●

You have changed the settings on the front panel by selecting the  icon followed by Printing
preferences > HP-GL/2 > Define palette, but did not select that palette in Printing
preferences > HP-GL/2 > Select palette.

●
To enable the software-driven pen settings, go to the front panel and select the  icon followed
by Printing preferences > HP-GL/2 > Select palette > Software.

The image has a wood-grain appearance
(aeroworms)

Aeroworms are wavy, horizontal bands produced by air-induced dot placement error (DPE). In extreme
cases, aeroworms give the image a wood-grain appearance. The problem occurs most commonly on print
jobs that are set for low-quality and high-speed. It does not occur when the custom print-quality setting is
set to “best.”

To eliminate aeroworms, select a higher IQ print setting. See Select print quality on page 80.
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12 Troubleshoot paper issues

● The paper cannot be loaded successfully

● The paper has jammed

● Prints do not stack correctly in the bin

● Automatic paper-cutter does not function

● Take-up reel paper jammed

● Take-up reel does not wind
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The paper cannot be loaded successfully
Here are a few things to check if you cannot successfully load the paper.

● The paper might be loaded at an angle (skewed or mislocated). Make sure that the right edge of the
paper is aligned with the half-circle on the right-hand side of the platen, and that the leading edge
of the paper is aligned with the metal bar in the platen.

● The paper might be crumpled or warped, or have irregular edges.

● If the paper jams in the paper path to the platen, the leading edge of the paper might not be straight
or clean. Remove the initial 2 cm (1 in) of paper from the roll and try again. This might be necessary
even with a new roll of paper.

● Make sure that the spindle is correctly inserted.

● Make sure that the paper is correctly loaded on the spindle, and that it loads over the roll towards
you.

● Verify that the paper is wound tightly on the roll.

The paper has jammed
When a jam occurs, the Possible paper jam message usually appears in the front panel, with one of
two error codes:

● 81:01 indicates that paper cannot advance into the printer.

● 86:01 indicates that the printhead carriage cannot move from side to side.

Check the printhead path
1. Turn off the printer at the front panel, then also switch off the power switch at the rear.
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2. Open the printer window.

3. Try to move the printhead carriage out of the way.

4. Lift the paper-load lever as far up as it will go.

5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

6. Carefully pull the remainder of the roll down and out of the printer.

7. Turn on the printer.
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8. Reload the roll. See Load a roll into the printer on page 32.

9. If some paper continues to cause an obstruction within the printer, it can often be cleared by loading
a rigid paper type into the printer.

10. If you find that you have print-quality problems after a jam, try realigning the printheads. See Align
the printheads on page 71.

Check the paper path
● This problem can occur when a roll has finished and the end of the roll is stuck to the cardboard

core. If this has happened, cut the end of the roll away from the core. Then feed the paper through
the printer, and load a new roll.

● Otherwise, follow the procedure described above, under Check the printhead path on page 163

Prints do not stack correctly in the bin
NOTE: This topic applies to the HP Designjet Z6100 42–in Printer only.

● Paper often tends to curl near the end of a roll, which can cause stacking problems. Load a new roll,
or remove prints manually as they are completed.

● If you are mixing prints or nesting sets of several different sizes, you might experience stacking
problems because of the different sizes of paper in the bin.

Automatic paper-cutter does not function
The automatic paper-cutter is disabled when the take-up reel is in use. To use the cutter on the paper,

uninstall (disable) the take-up reel on the front panel by selecting the  icon, and then selecting Take-
up reel > Disable take-up reel.

NOTE: The automatic paper-cutter feature is disabled for some of the heaviest media types,
because they might damage the cutter.

Take-up reel paper jammed
If the paper is severely damaged on the take-up reel spindle core, do not use the printer's cutter to cut and
remove the paper. Instead, cut the paper manually as close as possible to the printer window, and then
remove the roll. See Unload a roll from the printer on page 36.

Take-up reel does not wind
Predictably, if the take-up reel is not winding as anticipated, the printed output is likely to end up on the
floor. If the printer recognizes a problem with the take-up reel, it will interrupt the print job until the issue
is corrected. If the printer does not recognize a problem, the job will continue to print. The following table
highlights possible issues and solutions.

Take-up reel LED
status

Issue Print job
interrupted?

Possible cause Possible solution

Blinking quickly Take-up reel is not
winding

Yes The sensor beam was
blocked for more than 3
seconds.

Make sure that the take-
up reel sensors are not
blocked by a strip of
paper, the collection
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Take-up reel LED
status

Issue Print job
interrupted?

Possible cause Possible solution

bin if you are using the
HP Designjet Z6100
42–in Printer, or any
objects. See the
following graphic.
Make sure that the
collection bin is placed
behind the foot brace.

Also ensure that the
take-up reel power
switch is in the On
position.

Blinking slowly Take-up reel is not
winding

No The sensor cables are
loose or unplugged.

Ensure that the sensor
cables are correctly
secured.

Solid red Take-up reel is not
winding

No There is too much
resistance on the take-
up reel motor.

Ensure that the paper is
not winding too tightly.
A loop-shaping core
should be inserted and
hanging as shown in
step 10 of Use the take-
up reel on page 38.

Solid green Take-up reel is not
winding

No The take-up reel power
switch is in the Off
position

Ensure that the take-up
reel power switch is in
the On position.

Solid green Take-up reel is winding
in the wrong direction

No The take-up reel wind-
direction switch is in the
wrong winding
position.

After 3 seconds, the
printer recognizes the
problem and interrupts
the print job. See the
first error listed in this
table.

Flip the take-up reel
wind-direction switch to
the correct position.

The following graphic shows the take-up reel sensors and cable.

1. Take-up reel sensor

2. Take-up reel sensor and cable housing unit
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13 Troubleshoot ink-system issues

● Cannot insert an ink cartridge

● Cannot insert a printhead

● Cannot insert the maintenance cartridge

● Front panel recommends reseating or replacing a printhead

● Clean the printheads

● Align the printheads
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Cannot insert an ink cartridge
1. Verify that you have the correct type of cartridge (model number).

2. Verify that the colored label on the cartridge is the same color as the label on the slot.

3. Verify that the cartridge is correctly oriented, the arrow on the front of the ink cartridge should face
upwards.

CAUTION: Never clean inside the ink cartridge slots.

Cannot insert a printhead
1. Verify that you have the correct type of printhead (model number).

2. Verify that you have removed the protective caps and the clear protective tape from the printhead.

3. Verify that the colored label on the printhead is the same color as the label on the slot.

4. Verify that the printhead is correctly oriented (compare with the others).

5. Verify that you have closed and latched the printhead cover.

Cannot insert the maintenance cartridge
Verify that the maintenance cartridge is correctly oriented.

Front panel recommends reseating or replacing a
printhead

1. Remove the printhead and verify that its protective film has been removed.

2. Clean the electrical connections between the printhead and the carriage. See Clean the electrical
connections on a printhead on page 67.

3. Reinsert the printhead into the carriage and check the front panel message.

4. If the problem persists, insert a new printhead.

Clean the printheads
Periodic printhead cleaning is performed automatically, as long as the printer is kept turned on. However,
you should clean the printheads if you are experiencing poor image quality and cannot resolve the issues
by other methods. This ensures that there is fresh ink in the nozzles and helps to prevents nozzle clogs.

If you have printed the Printhead status plot, you know which colors are failing. Clean the pair of
printheads that are not performing adequately. If you are not sure which printheads to clean, clean all of
the printheads.

To clean the printheads, go to the printer's front panel and select the  icon, select Image quality
maintenance > Clean printheads, and then select which printheads you want to clean. You can
clean all of the printheads or only some of them. Your choices are:

● Clean all

● Clean M-Y
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● Clean LM-LC

● Clean PK-LG

● Clean MK-C

● Purge ink

Cleaning all of the printheads takes about 5 minutes. Cleaning any two printheads takes about 3 minutes.
Purging the ink takes about 5 minutes.

NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

NOTE: HP recommends that you purge the ink from the printheads before printing a job if the
printer has been turned off for more than six weeks or if you are experiencing inconsistent colors
from print to print after long storage periods. Purging the ink from the printheads helps to ensure
maximum color consistency; it is not a remedy for poor printhead health.

Align the printheads
Precise alignment between printheads is essential for color accuracy, smooth color transitions, and sharp
edges in graphical elements. Your printer has an automatic printhead alignment process which runs
whenever a printhead has been accessed or replaced.

In the case of a paper jam, if you have used a custom paper, or if you are experiencing problems with
color accuracy; you might need to align the printheads. See Align the printheads on page 71.

NOTE: If you experience a paper jam, HP recommends that you reinsert the printheads and align
the printheads.

TIP: Use the same paper you intend to print on to align the printheads. Photo paper is
recommended for the best results. Plain; bond; and thin, coated papers are acceptable, but provide
marginal results.

WARNING! Colored papers, glossy canvas, and transparent materials such as translucent
bond, clear film, tracing paper, and vellum are not suitable for aligning the printheads. However,
if you must perform printhead alignment with a material that is not supported, make sure you use
a material with the same thickness as the material you are going to use for printing.

Reinsert printheads procedure
1. If the printhead alignment process is running and the wrong paper is loaded, press the Cancel button

on the front panel.

CAUTION: Do not print if the printhead alignment process has been canceled.

2. Load the paper you want to use. Photo paper is recommended for the best results.

WARNING! Colored papers, glossy canvas, and transparent materials such as translucent
bond, clear film, tracing paper, and vellum are not suitable for aligning the printheads.
However, if you must perform printhead alignment with a material that is not supported, make
sure you use a material with the same thickness as the material you are going to use for
printing.
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3. Remove and reinsert all of the printheads. See Remove a printhead on page 61 and Insert a
printhead on page 64. This starts the printhead alignment process.

NOTE: Make sure the printer window is closed during printhead alignment.

4. The process takes about 6 minutes. Wait until the front panel shows that the process is complete
before using the printer.

NOTE: A calibration image is printed during the printhead alignment process. The front
panel shows if there were any errors in the process.

Image Quality Maintenance menu procedure
1. Load the paper you want to use. Photo paper is recommended for the best results. Plain; bond; and

thin, coated papers are acceptable, but provide marginal results.

WARNING! Colored papers, glossy canvas, and transparent materials such as translucent
bond, clear film, tracing paper, and vellum are not suitable for aligning the printheads.
However, if you must perform printhead alignment with a material that is not supported, make
sure you use a material with the same thickness as the material you are going to use for
printing.

2.
Go to the front panel and select the  icon, and then select Image quality maintenance >
Align printheads. The printer verifies that a sufficient amount of paper exists to perform printhead
alignment.

3. If the paper type that is loaded is acceptable for printhead alignment, the printer performs the
alignment and prints an alignment pattern.

NOTE: Make sure the printer window is closed during printhead alignment.

4. The process takes about 5 minutes. Wait until the front panel shows that the process is complete
before using the printer.
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Scan errors during alignment
If the alignment process fails, a Scanning problems message appears on the front panel. This indicates
that the alignment was not completed successfully. Therefore, the printheads are not aligned and the
alignment should be repeated before printing. The problem might be because of one of the following
scenarios:

● The type of paper used in the printhead alignment process was not acceptable. Repeat the alignment
process using one of the recommended paper types.

● The printheads are not clean. Clean the printheads. See Clean the printheads on page 168.

● The printer window was open during the printhead alignment process. Repeat the alignment process
with the printer window closed.

If the problem persists after following the recommended remedies, try replacing all of the printheads. If
the problem persists after replacing the printheads, a failure in the scanning system may exist.
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14 Troubleshoot other issues

● The printer is not printing

● The software program slows down or stalls while generating the print job

● The printer seems slow

● Communication failures between computer and printer

● Cannot access the Embedded Web Server

● “Out-of-memory” error message

● AutoCAD 2000 memory allocation error

● The platen rollers squeak

● Cannot access HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS)

● No output from Microsoft Visio 2003

● Print job canceled and purged when held for preview
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The printer is not printing
Possible reasons why a file you have sent from your computer is not printing when expected, include the
following:

● A problem with the electrical power might exist. If the printer is not performing and the front panel
does not respond, verify that the power cable is correctly connected and that the electrical socket is
functioning.

● An unusual electromagnetic phenomena may exist, such as strong electromagnetic fields or severe
electrical disturbances. Such occurrences can cause the printer to behave strangely, or even stop
working. Turn off the printer by using the Power button on the front panel, wait until the
electromagnetic environment has returned to normal, and then turn the printer on again. If the
problems persist, contact your customer service representative.

● The graphic language setting might be incorrectly set.

● The correct printer driver might not have been installed in your computer.

● One of the following paper scenarios might exist:

● The paper name that appears on the front panel does not reflect the paper that is loaded in the
printer.

● There is not a sufficient amount of paper on the loaded roll to print the entire job.

Under these conditions, one print job might be printed, while another print job is held in the print
queue. To resolve this issue, unload the roll from the printer and load a new roll, using the front panel
to guide you through the process.

● The nesting setting might be On and the printer is waiting for the nest timeout to expire. Under this
condition, the front panel shows the remaining time.

● You might have requested a print preview in your printer driver. Under this condition, the preview
appears in a Web browser.

The software program slows down or stalls while
generating the print job

Large quantities of data might be necessary to generate a high-quality large-format print job. This can
cause your software program to slow down significantly or stall. Lowering the print resolution may help
to avoid this scenario, however, lowering the print resolution reduces image quality.

In the Windows HP-GL/2 driver, click the Advanced tab, select Document options > Printer
features, and then set Max. Application resolution to 300.

The printer seems slow
Here are some possible explanations:

● Did you set the print quality to Best? Images printed with the Best print-quality setting require more
time to print.

● Did you specify the correct paper type when loading the paper? Verify that the paper type that
appears on the front panel matches the paper that is loaded in the printer.

● Is your printer connected to a network? Check that all components used in the network (network
interface cards, hubs, routers, switches, and cables) are capable of high-speed operation. Is there a
lot of traffic from other devices on the network?
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● Did you set the drying time to Extended? Try changing the drying time to Optimal. See Change
the drying time on page 49.

● Are the printheads in good condition? Printing time might increase when a printhead needs cleaning.
Check the printhead status on the front panel or through the Embedded Web Server. Clean or replace
printheads if necessary.

● Do your image contain high-density, black fills? Printing time might increase for images containing
high-density, black fills.

Communication failures between computer and
printer

Some symptoms are:

● The front-panel display does not show the Receiving message when you have sent an image to the
printer.

● Your computer shows an error message when you try to print.

● Your computer or printer stalls when transferring data.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so
on).

To solve a communication problem:

● Make sure that you have selected the correct printer in your software program.

● Make sure that the printer works correctly when printing from other software programs.

● Remember that large images usually require more time to receive, process, and print.

● If the printer is connected to your computer by a USB cable, try disconnecting and reconnecting the
cable.

● If the printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, or cable converters, remove the intermediate device and try
connecting the printer directly to your computer.

● Try another interface cable. See Choose which connection method to use on page 13.

● Make sure that the graphic language setting is correctly set.

Cannot access the Embedded Web Server
If you have not done so already, please read Access the Embedded Web Server on page 23.

NOTE: If you connect your printer directly to your computer with a USB cable, use HP Easy Printer
Care (Windows) or HP Printer Utility (Mac OS).

1.
Go to the front panel and select the  icon.

2. Select Connectivity Menu > Advanced > Embedded Web Server > Allow EWS > On.

3.
If you have a TCP/IP connection to your printer, go to the front panel and select the  icon, and
then select Connectivity Menu.

4. Select the type of connection you are using.
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5. Select View Information.

6. The information should read: IP enabled: Yes. If it does not, you might need to use a different
connection.

If you still cannot access the Embedded Web Server, turn the printer off with the Power button on the front
panel and then turn it on again.

If you experience very slow progress while trying to access the Embedded Web Server, the problem could
be that you are using a proxy server. Try bypassing the proxy server and accessing the Embedded Web
Server directly.

● In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and select the Bypass proxy server for local addresses check box. You can also
click the Advanced button to add the printer's IP address to the list of exceptions, for which the
proxy server is not used.

● In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change
Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which
the proxy server is not used.

“Out-of-memory” error message
There is no direct relationship between the size of a file in your computer and the amount of memory
needed to print the file. Because of file compression and other factors, it is difficult to estimate how much
memory is needed to print a job. It is possible that the printer will lack sufficient memory to print a certain
job, despite having printed larger jobs in the past. Adding memory to your printer is one solution.

If you are using the Windows HP-GL/2 driver, printer memory problems can often be resolved by clicking
the Advanced tab, selecting Document options, selecting Printer features, and then selecting
Print job as raster.

NOTE: If you select this option, the time needed to process the job in your computer might be
considerably longer.

AutoCAD 2000 memory allocation error
When printing from AutoCAD 2000 for the first time after installing the printer driver, a Memory
allocation error message might appear.

This is an AutoCAD 2000 problem. Download the Plotting Update Patch (plotupdate.exe) from the
Autodesk Web site (http://www.autodesk.com/) to resolve the problem.

HP also recommends that you download the Plotting Update Patch if you experience other problems when
printing from AutoCAD 2000.

The platen rollers squeak
It might be necessary to oil the rollers. Locate the oil bottle in the maintenance kit that came with your
printer.

1. Turn off the printer by using the Power button on the front panel.
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2. Open the printer window.

3. Locate the small holes in the platen near some of the rollers.

4. Put three drops of oil into each hole in the platen.

NOTE: Be careful not to spill oil onto the platen.
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5. If oil spills onto the platen, wipe the platen clean by using the cloth that was supplied with the
maintenance kit.

6. Lower the printer window.

Cannot access HP Easy Printer Care (Windows) or HP
Printer Utility (Mac OS)

If you have not done so already, please read HP Easy Printer Care (Windows) or HP Printer Utility (Mac
OS) setup options on page 25.

NOTE: Because Windows XP Professional x64 Edition does not support HP Easy Printer Care, it
cannot be installed on computers that are running that version of Windows.

1.
Go to the front panel and select the  icon.

2. Select Connectivity Menu > Advanced > Web services > Printer Utility Software >
Enable.

3.
If you have a TCP/IP connection to your printer, go to the front panel and select the  icon again.

4. Select the type of connection you are using.

5. Select View Information.

If you still cannot connect, turn the printer off by using the Power button on the front panel and then turn
it on again.

No output from Microsoft Visio 2003
For more information about problems when printing large images (more than 129 inches long) from
Microsoft Visio 2003, see Microsoft's online knowledge base (http://support.microsoft.com/search/).
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To avoid these problems, you can scale down the image in Visio (to a size less than 129 inches) and then
scale up the image in the driver. Resize the image in Visio and then in the Windows driver, click the
Features tab and then select the Resizing options.

Print job canceled and purged when held for
preview

The printer can store up to 64 pages for preview. If the job that you selected for preview contains more
than 64 pages, the job will be canceled and purged without notification when the printer starts to process
the sixty-fifth page. If you want to preview a job that has more than 64 pages, click the Continue button
before the printer starts to process the sixty-fifth page. Because the preview image is ready as soon as the
first page is processed, you should have enough time to check the preview image.
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15 Front-panel error messages

Under certain circumstances, a front-panel error message appears. Follow the advice in the
Recommendation column to resolve the error.

If an error message appears on the front panel that is not included in this list, and you are in doubt over
the correct response, contact HP Support. See HP Customer Care on page 183.

Table 15-1  Text messages

Message Recommendation

[Color] cartridge has expired Replace the cartridge. See Remove an ink cartridge
on page 59 and Insert an ink cartridge on page 61.

[Color] cartridge is missing Insert a cartridge of the correct color. See Insert an ink
cartridge on page 61.

[Color] cartridge is out of ink Replace the cartridge. See Remove an ink cartridge
on page 59 and Insert an ink cartridge on page 61.

[Color] printhead #[n] error: not present Insert the correct printhead. See Insert a printhead
on page 64.

[Color] printhead #[n] error: please remove Remove the incorrect printhead and insert a new printhead of
the correct type (color and number). See Remove a printhead
on page 61 and Insert a printhead on page 64.

[Color] printhead #[n] error: replace Remove the non-functional printhead and insert a new
printhead. See Remove a printhead on page 61 and Insert a
printhead on page 64.

[Color] printhead #[n] error: reseat Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead.
See Front panel recommends reseating or replacing a
printhead on page 168.

[Color] printhead #[n] out of warranty The printhead's warranty has ended, because of the length of
time it has been in operation or because of the volume of ink
used. See Legal information on page 193.

[Color] printhead #[n] warranty warning The printhead's warranty may be invalidated by the use of the
wrong kind of ink. See Legal information on page 193.

[Warning] internal failure: Unable to create print The internal print files are not available in the printer. Load the
internal print files through the Embedded Web Server.

IO error Restart the printer. If the problem persists, contact HP Support.
See HP Customer Care on page 183.

IO warning Try again; if the problem persists, contact HP Support. See HP
Customer Care on page 183.

PDL Error: Ink system not ready Clean the printheads. See Clean the printheads on page 168.

PDL Error: Job clipped The image is too large for the paper or for the printer. Load
larger paper if possible, or reduce the image size.

PDL Error: memory full Restart the printer and try resending the job; if necessary, reduce
the complexity of the job.
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Message Recommendation

PDL Error: out of paper Load more paper.

PDL Error: parsing error The print job is unintelligible to the printer. Try to recreate and
resend it. Check your cable connections.

PDL Error: print mode error The paper type or print quality specified for the job are
incorrect. Change the loaded paper type or the print settings.

PDL Error: printing error Try sending the job again.

PDL Error: virtual memory full Restart the printer and try resending the job; if necessary, reduce
the complexity of the job.

Replace [color] cartridge Replace the cartridge. See Remove an ink cartridge
on page 59 and Insert an ink cartridge on page 61.

Reseat [color] cartridge Remove and reinsert the same cartridge. See Remove an ink
cartridge on page 59 and Insert an ink cartridge on page 61.

Update: failed. Invalid file Make sure that you have selected the correct firmware update
file. Then try again to perform the update.

Under certain circumstances, a front-panel numeric error message appears. Follow the advice in the
Recommendation column to resolve the error.

If an error message appears on the front panel that is not included in this list, turn off the printer and then
turn it back on. If the problem persists, contact HP Support. See HP Customer Care on page 183.

Table 15-2  Numeric error messages

Error code Recommendation

26.n.01 (where n = the subject ink
cartridge number)

Remove the subject ink cartridge and reinstall it in the printer. If the error persists,
replace the subject ink cartridge. If the problem persists, contact HP Support. See HP
Customer Care on page 183.

29.01 The maintenance cartridge is not inserted correctly. Open the maintenance cartridge
door on the right side of the printer, make sure that the maintenance cartridge is
correctly seated, and then close the door. If the problem persists, replace the
maintenance cartridge. If the problem persists, contact HP Support. See HP Customer
Care on page 183.

32.1.01 A take-up reel error has occurred. Make sure that the paper is adequately taped to
the take-up reel spindle core, and then make sure that the winding direction is correctly
set.

32.2.01 The take-up reel can not be detected. Make sure that the take-up reel sensor cable is
correctly connected.

61.01 The file format is incorrect and the printer cannot process the job. Try the following
remedies:

● Turn off the printer by using the Power button on the front panel and the power
switch at the back of the printer, and then disconnect the power cord—then
reconnect the power cord and turn on the printer.

● Make sure that the graphic language setting is correct. See Change the graphic
language setting on page 102.

● Resubmit the file to the printer.

● Verify that your printer firmware is up to date. See Update the printer
firmware on page 141.

If the problem persists, contact HP Support. See HP Customer Care on page 183.

Table 15-1  Text messages (continued)
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Error code Recommendation

63.04 An input/output problem has occurred with the network card. Try the following
remedies:

● Make sure that the network cable is correctly connected to the network card.

● Verify that your printer firmware is up to date. See Update the printer
firmware on page 141.

If the problem persists, contact HP Support. See HP Customer Care on page 183.

71.03 An “out of memory” failure has occurred. HP recommends that you remove any
unnecessary files from the printer's hard disk through the Embedded Web Server.

74.01 An error occurred when uploading the firmware update file. Try the following
remedies:

● Turn off the printer by using the Power button on the front panel and the power
switch at the back of the printer, and then disconnect the power cord—then
reconnect the power cord and turn on the printer.

● Try again to upload the firmware update file to the printer. See Update the printer
firmware on page 141.

If the problem persists, contact HP Support. See HP Customer Care on page 183.

76.03 A “disk out of space” has occurred. Try the following remedies:

● Turn off the printer by using the Power button on the front panel and the power
switch at the back of the printer, and then disconnect the power cord—then
reconnect the power cord and turn on the printer.

● Resubmit the file to the printer.

● HP recommends that you remove any unnecessary files from the printer's hard
disk through the Embedded Web Server.

● Perform an Electrically Erasable Read-Only Memory (EEROM) reset and then
resubmit the file to the printer.

If the problem persists, contact HP Support. See HP Customer Care on page 183.

77.04 An Embedded Web Server internal software error has occurred. Try the following
remedies:

● Turn off the printer by using the Power button on the front panel and the power
switch at the back of the printer, and then disconnect the power cord—then
reconnect the power cord and turn on the printer.

● Verify that your printer firmware is up to date. See Update the printer
firmware on page 141.

If the problem persists, contact HP Support. See HP Customer Care on page 183.

81.01, 81.03, 86.01 Open the printer window and make sure that there are no obstacles restricting the
movement of the drive roller. If the paper has jammed and is restricting the movement
of the drive roller, lift the paper load lever and clear the obstruction. If the problem
persists, contact HP Support. See HP Customer Care on page 183.

Table 15-2  Numeric error messages (continued)
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16 Get help

● Introduction

● HP Instant Support

● HP Proactive Support

● HP Customer Care

● HP Designjet Online

● Other sources of information
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Introduction
HP Customer Care offers award-winning support to ensure that you get the most from your HP Designjet.
HP Customer Care provides comprehensive, proven support expertise and new technologies to give you
unique end-to-end support. Services include setup and installation, troubleshooting tools, warranty
upgrades, repair and exchange services, phone and Web support, software updates, and self-
maintenance services. For more information about HP Customer Care, go to: http://www.hp.com/go/
designjet/.

HP Instant Support
HP Instant Support Professional Edition is HP's suite of troubleshooting tools that collect diagnostic
information from your printer and match it with intelligent solutions from HP's knowledge bases, allowing
you to resolve problems as quickly as possible.

To start an HP Instant Support session, click on the link in the Support tab of your printer's Embedded
Web Server. See Access the Embedded Web Server on page 23.

To use HP Instant Support, the following conditions must be met:

● Because HP Instant Support is accessible only through the Embedded Web Server, you must have a
TCP/IP connection to your printer.

● Because HP Instant Support is a Web-based service, you must have access to the World Wide Web,

HP Instant Support is currently available in English, Korean, Simplified Chinese, and Traditional Chinese.

For more information about HP Instant Support, go to: http://www.hp.com/go/ispe/.

HP Proactive Support
HP Proactive Support is a troubleshooting support tool that identifies, diagnoses, and resolves issues you
might encounter when using your commercial imaging and printing products. HP Proactive Support is
embedded into multiple HP software programs including the HP Easy Printer Care (Windows) and HP
Printer Utility (Mac OS), allowing you to easily and conveniently monitor, update and maintain all of your
HP printers.

For more information about HP Proactive Support, go to: http://www.hp.com/go/proactivesupport.

HP Customer Care
As your strategic support partner, we make it our business to help keep your business running smoothly.
HP Customer Care offers award-winning support to ensure that you get the most from your HP Designjet.

HP Customer Care provides comprehensive, proven support expertise and leverages new technologies to
give customers unique end-to-end support. Services include setup and installation, troubleshooting tools,
warranty upgrades, repair and exchange services, phone and Web support, software updates, and self-
maintenance services. To find out more about HP Customer Care, go to http://www.hp.com/go/
designjet/. For the most current contact information, click on the Contact HP link or call the phone
number in the Quick Reference Guide provided with your printer.

What to do before you call:

● Review the troubleshooting suggestions in this guide.

● Review the relevant driver documentation supplied with this printer (for users sending PostScript files
or those using Microsoft Windows).

● If you have installed third-party software drivers and RIPs, refer to their documentation.
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● If the problem appears to be related to your software program, first contact your software vendor.

● If you call one of the Hewlett-Packard offices, have the following information available to help us
answer your questions more quickly:

● The printer you are using (the product number and the serial number, found on the label at the

back of the printer on the front panel: select the  icon, and then View printer
information.

● The printer's Service ID (also in the View printer information option.)

● If there is an error code on the front panel, make note of it.

● The brand name and model number of the computer you are using

● Any special equipment or software you are using (for example, spoolers, networks, switch-
boxes, modems, or special software drivers)

● The part number of the network cable you are using and the name of the store though which it
was purchased

● The type of interface used on your printer (USB or network)

● The software name and version you are using

● Print out the service information prints. You may be asked to fax them to the support center
helping you.

On the front panel: select the  icon, and then select Internal prints > Service
information prints > Print all pages.

Through the Embedded Web Server: go to the Service support page in the Support tab,
and then select Printer information > Print all pages.

Telephone numbers
For an up-to-date list of HP Support telephone numbers, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. If you do not have access to the Web, try one of the numbers below.

● Algeria: 213 17 63 80

● Argentina: 0 800 777 HP INVENT, local 5411 4778 8380

● Australia: 13 10 47

● Austria: 0810 00 10 00

● Bahrain: 800 171

● Belgium: (0) 78 600 600

● Bolivia: 0 800 1110, local 54 11 4708 1600

● Brazil: 0800 157 751, local 55 11 3747 7799

● Canada: 1 800 HP INVENT

● Caribbean: 1 800 711 2884

● Central America: 1 800 711 2884

● Chile: 800 HP INVENT, 123 800 360 999
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● China: 800 810 59 59, 10 6564 59 59

● Colombia: 01 8000 51 HP INVENT, local 571 606 9191

● Czech Republic: 420 261 307 310

● Denmark: 70 11 77 00

● Ecuador: 999 119, 1 800 225 528

● Egypt: 202 532 5222

● Finland: 0203 53232

● France: 08 26 10 49 49

● Germany: 0180 52 58 143

● Greece: 210 6073603, 801 11 22 55 47

● Guadaloupe: 0800 99 00 11, 877 219 8791

● Guatemala: 1 800 999 5105, 1 800 711 2884

● Hong Kong: 852 3002 8555

● Hungary: 06 1 382 1111

● India: 1 600 112 267

● Indonesia: 350 3408

● Ireland: 1 890 946500

● Israel: 09 830 4848

● Italy: 02 3859 1212

● Jamaica: 0 800 711 2884

● Japan: software 0120 014121, hardware 0120 742594

● Korea: 82 1588 3003

● Luxembourg: 27 303 303

● Malaysia: 1 800 80 5405

● Martinique: 0 800 99 00, 877 219 8671

● Mexico: 01 800 472 6684, local 5258 9922

● Middle East: 4 366 2020

● Morocco: 2240 4747

● Netherlands: 0900 1170 000

● New Zealand: 09 365 9805

● Norway: 800 62 800

● Paraguay: 00 811 800, 800 711 2884

● Panama: 001 800 711 2884

● Peru: 0 800 10111
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● Philippines: 632 888 6100

● Poland: 22 566 6000

● Portugal: 213 164 164

● Puerto Rico: 1 800 652 6672

● RSA: 27 11 258 9301, local 086 000 1030

● Romania: 40 21 315 4442

● Russia: 095 797 3520, 812 3467 997

● Saudi Arabia: 6272 5300

● Slovakia: 2 50222444

● South Africa: 0800 001 030

● Spain: 902 010 333

● Sweden: 077 130 30 00

● Switzerland: 0848 80 20 20

● Taiwan: 886 2 872 28000

● Thailand: 0 2353 9000

● Tunisia: 71 89 12 22

● Turkey: 216 444 71 71

● UAE: 800 4520, 04 366 2020

● Ukraine: 44 4903520

● United Kingdom: 0870 842 2339

● United States: 1 800 HP INVENT

● Uruguay: 54 11 4708 1600

● Venezuela: 0 800 HP INVENT, local 58 212 278 8000

● Vietnam: 84 8 823 45 30

● West Africa (French): 351 213 17 63 80

HP Designjet Online
HP offers dedicated services and resources to ensure you always get the best performance from your HP
Designjet products and solutions.

Register at HP Designjet Online, your large-format printing community at http://www.hp.com/go/
designjet/ for unrestricted access to:

● Downloads of the latest printer firmware, drivers, software, paper profiles, and so on

● Technical support, including online troubleshooting, customer care contacts, and more

● Forums for direct contact with the experts, both HP and your colleagues

● Warranty tracking online, for your peace of mind

186 Chapter 16   Get help

G
et help

http://www.hp.com/go/designjet/
http://www.hp.com/go/designjet/


● Technical documentation and training videos

● Latest product information about printers, supplies, accessories, software, and so on

● Supplies Center for all you need to know about ink and paper

You decide the information you need by customizing your registration for the products you have purchased
and your type of business, and by setting your communication preferences.

Register at HP Designjet Online for the best performance.

HP Designjet Online is available in English, German, French, Italian, Spanish, Portuguese, Japanese,
Korean, Simplified Chinese, and Traditional Chinese.

Other sources of information
More information is available from the following sources:

● The Embedded Web Server provides information about your printer status, technical support, online
documentation, and so on. See Printer software on page 9.

● The Printer assembly document that came with your printer

Other sources of information 187
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17 Printer specifications

● Functional specifications

● Physical specifications

● Memory specifications

● Power specifications

● Ecological specifications

● Environmental specifications

● Acoustic specifications
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Functional specifications
Table 17-1  HP No. 91 ink supplies

Printheads Matte black/cyan, light magenta/light cyan, magenta/yellow,
and photo black/light gray

Maintenance cartridge Non-color-specific

Ink cartridges Magenta, light magenta, photo black, matte black, yellow, light
cyan, light gray and cyan. All cartridges contain 775 ml of ink.

Table 17-2  Paper sizes

Minimum Maximum

Width 610 mm (24 inches) 1524 mm (60 inches)

Length 420 mm (16.5 inches) Roll with maximum external diameter of 170
mm (6.7 inches)

Table 17-3  Print resolution (using Windows HP-GL/2 driver)

Print quality Maximum resolution for
photo paper

Rendering resolution Printing resolution

Best On 1200×1200 2400×1200 (HP Premium
Instant-dry Photo Gloss, HP
Premium Instant-dry Photo
Satin, HP Universal Instant-dry
Photo Gloss, HP Universal
Instant-dry Photo Semi-Gloss,
Photo Gloss Paper, Photo
Semi-Gloss/Satin Paper,
Photo Matte Paper)

1200×1200 (other)

Best Off 1200×1200 600×1200 (HP Premium
Instant-dry Photo Gloss, HP
Premium Instant-dry Photo
Satin, HP Universal Instant-dry
Photo Gloss, HP Universal
Instant-dry Photo Semi-Gloss,
Photo Gloss Paper, Photo
Semi-Gloss/Satin Paper,
Photo Matte Paper)

1200×1200 (other)

Normal n/a 600×600 600×1200 (HP Premium
Instant-dry Photo Gloss, HP
Premium Instant-dry Photo
Satin, HP Universal Instant-dry
Photo Gloss, HP Universal
Instant-dry Photo Semi-Gloss,
Photo Gloss Paper, Photo
Semi-Gloss/Satin Paper,
Photo Matte Paper)

1200×1200 (other)

Normal-Fast n/a 600×600 600×1200 (HP Premium
Instant-dry Photo Gloss, HP
Premium Instant-dry Photo
Satin, HP Universal Instant-dry
Photo Gloss, HP Universal
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Print quality Maximum resolution for
photo paper

Rendering resolution Printing resolution

Instant-dry Photo Semi-Gloss,
Photo Gloss Paper, Photo
Semi-Gloss/Satin Paper,
Photo Matte Paper)

1200×1200 (other)

Fast n/a 300×300 600×1200 (plain paper,
bright white bond paper, HP
Premium Instant-dry Photo
Gloss, HP Premium Instant-dry
Photo Satin, HP Universal
Instant-dry Photo Gloss, HP
Universal Instant-dry Photo
Semi-Gloss, Photo Gloss
Paper, Photo Semi-Gloss/
Satin Paper, Photo Matte
Paper)

1200×1200 (other)

Table 17-4  Margins

Side margins 5 mm = 0.2 inches (small, normal)

15 mm = 0.6 inches (extended)

Top margin (leading edge) 5 mm = 0.2 inches (small)

11.5 mm = 0.5 inches (normal)

35 mm = 1.4 inches (extended)

Bottom margin (trailing edge) 5 mm = 0.2 inches (small, normal and extended)

Table 17-5  Mechanical accuracy

±0.1% of the specified vector length or ±0.1 mm (whichever greater) at 23°C (73°F), 50-60% relative humidity, on A0 printing
material in Best or Normal mode with HP Matte Film.

Table 17-6  Graphic languages supported

HP Designjet Z6100 Printer HP-GL/2, RTL, TIFF, JPEG, CALS G4

HP Designjet Z6100ps Printer only Adobe PostScript level 3, PDF 1.5

Physical specifications
Table 17-7  Printer physical specifications

Weight (including stand) < 163 kg (HP Designjet Z6100 42–in)

< 195 kg (HP Designjet Z6100 60–in)

Width < 1990 mm

(HP Designjet Z6100 42–in)

< 2450 mm (HP Designjet Z6100 60–in)

Table 17-3  Print resolution (using Windows HP-GL/2 driver) (continued)
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Depth < 860 mm (with take-up reel)

< 700 mm (without take-up reel)

Height ≈ 1370 mm

Memory specifications
Table 17-8  Memory specifications

Memory (DRAM) supplied 256 MB

Memory (DRAM) maximum 512 MB

Hard disk 40 GB

Power specifications
Table 17-9  Printer power specifications

Source 100 – 127 Vac / 220 – 240 Vac ±10%, autoranging

Frequency 50–60 Hz

Current < 4 A

Consumption 350W

maximum

Ecological specifications
This product complies with European Union WEEE and RoHS Directives.

ENERGY STAR and the ENERGY STAR mark are registered U.S. marks To determine the ENERGY STAR®
qualification status of these product models. See: http://www.hp.com/go/energystar.

For up-to-date ecological specifications of your printer, please go to http://www.hp.com/ and search for
“ecological specifications”.

Environmental specifications
Table 17-10  Printer environmental specifications

Relative humidity range for best print quality 20–80%, depending on paper type

Temperature range for best print quality 15 to 30°C (59 to 86°F), depending on paper type

Temperature range for printing 5 to 40°C (41 to 104°F)

Temperature range when not in operation -20 to +55°C (-4 to +131°F)

Maximum altitude when printing 3000 m

NOTE: If the printer or ink cartridges are moved from a cold location to a warm and humid
location, water from the atmosphere can condensate on the printer parts and cartridges and can
result in ink leaks and printer errors. In this case, HP recommends that you wait at least 3 hours
before turning on the printer or installing the ink cartridges, to allow the condensate to evaporate.

Table 17-7  Printer physical specifications (continued)
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Acoustic specifications
Table 17-11  Printer acoustic specifications

Idle sound power ≤ 5.8 B (A)

Operating sound power ≤ 7.0 B (A)

Idle sound pressure ≤ 41 dB (A)

Operating sound pressure ≤ 53 dB (A)
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18 Legal information

● Hewlett-Packard Limited Warranty—HP (HP Designjet Z6100 Printer series)

● Hewlett-Packard Software License Agreement

● Open source software

● Regulatory notices

● DECLARATION OF CONFORMITY

193

Le
g
a
l i

nf
or

m
a
tio

n



Hewlett-Packard Limited Warranty—HP (HP
Designjet Z6100 Printer series)

HP product Limited Warranty Period

Printer 1 year (from the date of purchase by the customer)

Software 90 days (from the date of purchase by the customer)

Printhead Until the “end of warranty” date printed on the product is
reached, or 1200 ml of HP ink have been cycled through the
printhead, whichever occurs first

Ink cartridge Until the genuine HP ink is depleted as indicated by the printer,
or the “end of warranty” date printed on the product is reached,
whichever occurs first

A. Extent of HP Limited Warranty
1. HP warrants to you, end-user customer, that the HP hardware products specified above will be free

from defects in materials and workmanship during the Limited Warranty Period specified above. The
Limited Warranty Period starts on the date of purchase. Your dated sales or delivery receipt, showing
the date of purchase of the product, is your proof of purchase date. You may be required to provide
proof of purchase as a condition of receiving warranty service.

2. For software products, HP’s Limited Warranty applies only to a failure to execute programming
instructions during the Limited Warranty Period specified above.

3. HP does not warrant that the operation of any product will be uninterrupted or error free.

4. HP’s Limited Warranty covers only those defects that arise as a result of normal use of the HP products,
and does not cover any other problems, including those that arise as result of:

a. Improper or inadequate maintenance or modification;

b. Software, interfacing, paper, parts, or supplies not provided or supported by HP;

c. Operation outside the product’s specifications; or

d. Unauthorized modification or misuse.

Routine printer maintenance operations in the HP Designjet Z6100 Printer series, such as cleaning
and preventive maintenance services (including parts contained in any preventive maintenance kit
and HP service engineer visits), are not covered by HP’s Limited Warranty.

5. YOU SHOULD MAKE PERIODIC BACKUP COPIES OF THE DATA STORED ON THE PRINTER'S
HARD DISK OR OTHER STORAGE DEVICES AS A PRECAUTION AGAINST POSSIBLE FAILURES,
ALTERATION, OR LOSS OF THE DATA. BEFORE RETURNING ANY UNIT FOR SERVICE, BE SURE
TO BACK UP DATA AND REMOVE ANY CONFIDENTIAL, PROPRIETARY, OR PERSONAL
INFORMATION. HP IS NOT RESPONSIBLE FOR DAMAGE TO OR LOSS OF ANY FILES, STORED
BY YOU ON THE PRINTER'S HARD DISK OR OTHER STORAGE DEVICES. HP IS NOT RESPONSIBLE
FOR THE RECOVERY OF LOST FILES OR DATA.

6. For HP printer products, the use of a refilled or non-original HP consumable product (ink, printhead
or ink cartridge) does not affect either HP’s Limited Warranty to you or any HP support contract with
you. However, if printer failure or damage is attributable to the use of a non-HP or refilled ink
cartridge, HP will charge its standard time and materials charges to service the printer for the
particular failure or damage.
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7. If HP receives, during the applicable warranty period, notice of a defect in any product which is
covered by this Limited Warranty:

a. HP shall replace any defective HP software, media, or consumable product which is covered
by this Limited Warranty, and deliver another product to you to replace the defective one.

b. HP, at its sole discretion, shall either repair on site or replace any defective hardware product
or component part. If HP elects to replace any component part, HP will provide to you (i) a
replacement part, in return of the defective one, and (ii) remote part installation assistance, if
needed.

8. If HP is unable to repair or replace, as applicable, a defective product which is covered by this
Limited Warranty, HP shall, within a reasonable time after being notified of the defect, refund the
purchase price for the product.

9. HP shall have no obligation to replace or refund until you return the defective components, parts,
consumables, media, or hardware product to HP. All components, parts, consumables, media or
hardware products, removed under this Limited Warranty become the property of HP.
Notwithstanding the above mentioned, HP may waive the requirement for you to return the defective
part.

10. Unless otherwise stated, and to the extent permitted by local law, HP products may be manufactured
using new materials or new and used materials equivalent to new in performance and reliability. HP
may repair or replace products (i) with equivalent products to the products being repaired or replaced
but which may have been subject to prior use; or (ii) with an equivalent product to an original product
that has been discontinued.

11. This Limited Warranty is valid in any country/region where HP or its authorized providers offer
warranty services and HP has marketed the HP product covered by this Limited Warranty. However,
warranty service availability and response time may vary from country/region to country/region.
HP will not alter form, fit, or function of the product to make it operate in a country for which it was
never intended to function for legal or regulatory reasons.

12. Contracts for additional services may be available for any authorized HP service facility where the
listed HP product is distributed by HP or an authorized importer.

B. Limitation of warranty
TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKE ANY
OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH RESPECT
TO THE HP PRODUCTS, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS
OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

C. Limitations of liability
TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH
IN THIS LIMITED WARRANTY, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING ANY LOSS
OF PROFITS OR SAVINGS), WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY
AND WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

D. Local law
1. This Limited Warranty gives you specific legal rights. You may also have other rights which vary from

state to state in the United States, from province to province in Canada, and from country to country
elsewhere in the world. You are advised to consult applicable state, province, or national laws for
full determination of your rights.

2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement
shall be deemed modified to be consistent with such local law. THE WARRANTY TERMS
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CONTAINED IN THIS LIMITED WARRANTY, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO
NOT EXCLUDE, RESTRICT, OR MODIFY AND ARE IN ADDITION TO THE MANDATORY
STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

Revision: December 10th, 2006

Hewlett-Packard Software License Agreement
ATTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE HP SOFTWARE LICENSE TERMS SET FORTH
BELOW. USING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE LICENSE TERMS. IF YOU
DO NOT ACCEPT THESE LICENSE TERMS, YOU MAY RETURN THE SOFTWARE FOR A FULL REFUND.
IF THE SOFTWARE IS SUPPLIED WITH ANOTHER PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT FOR A FULL REFUND.

HP SOFTWARE LICENSE TERMS
The following terms govern your use of the software integrated into your HP Designjet Z6100 Printer series,
unless you have a separate agreement with HP.

Definitions. HP Designjet Z6100 Printer series software includes HP software product (“the Software”)
and Open Source Software components.

“Open Source Software” means various open source software components including, but not limited to,
Apache, Tomcat, MySQL, and omniORB, licensed under terms of applicable open source license
agreements included in the materials relating to such software (please see “Open Source Software” section
below).

License Grant. HP grants you a license to use one copy of the Software pre-installed in the HP Designjet
Z6100 Printer series. "Use" means storing, loading, executing or displaying the Software. You may not
modify the Software or disable any licensing or control features of the Software.

Ownership. The Software is owned and copyrighted by HP or its third party suppliers. Your license
confers no title to, or ownership in, the Software and is not a sale of any rights in the Software. HP's third
party suppliers may protect their rights in the event of any violation of these License Terms.

Copies and Adaptations. You may only make copies or adaptations of the Software for archival
purposes or when copying or adaptation is an essential step in the authorized Use of the Software. You
must reproduce all copyright notices in the original Software on all copies or adaptations. You may not
copy the Software onto any public network.

No Disassembly or Decryption. You may not disassemble or decompile the Software unless HP's
prior written consent is obtained. In some jurisdictions, HP's consent may not be required for limited
disassembly or decompilation. Upon request, you will provide HP with reasonably detailed information
regarding any disassembly or decompilation. You may not decrypt the Software unless decryption is a
necessary part of the operation of the Software.

Transfer. Your license will automatically terminate upon any transfer of the Software. Upon transfer, you
must deliver the Software, including any copies and related documentation, to the transferee. The
transferee must accept these License Terms as a condition to the transfer.

Termination. HP may terminate your license upon notice for failure to comply with any of these License
Terms. Upon termination, you must immediately destroy the Software, together with all copies, adaptations
and merged portions in any form or, if the Software is supplied integrated into the HP Designjet Z6100
Printer series, stop using the HP Designjet Z6100 Printer series.

Export Requirements. You may not export or re-export the Software or any copy or adaptation in
violation of any applicable laws or regulations.

U.S. Government Restricted Rights. The Software and accompanying documentation have been
developed entirely at private expense. They are delivered and licensed, as defined in any applicable
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DFARS, FARS, or other equivalent federal agency regulation or contract clause, as either "commercial
computer software" or "restricted computer software", whichever is applicable. You have only those rights
provided for such Software and Documentation by the applicable clause or regulation or by the HP
standard software agreement for the product involved.

Open Source Software. The Open Source Software is composed of individual software components,
each of which has its own copyright and its own applicable license conditions. You must review the
licenses within the individual packages to understand your rights under them. The licenses can be found
in the folder called licenses on the Drivers and Documentation CD that came with your printer. Copyrights
to the Open Source Software are held by the copyright holders.

Open source software
Open source acknowledgments

● This product includes software developed by the Apache Software Foundation
(http://www.apache.org/)

● The source code, object code, and documentation in the com.oreilly.servlet package is licensed by
Hunter Digital Ventures, LLC

Open source written offer
In accordance with the GNU General Public license, the SMAIL Public License, and the Sleepy Cat
software license, HP is providing you with this written offer to receive on a CD-R, at the cost of $30, a
complete machine-readable copy of the source code corresponding to all the code distributed to you under
a GNU General Public License, SMAIL Public License, and/or Sleepy Cat software licenses. You can
request this CD-R from your local HP support representative; telephone numbers and e-mail addresses can
be found at: http://www.hp.com/go/designjet/support/.

Regulatory notices
This HP product contains a lithium battery located on an internal motherboard that may require special
handling at end-of-life.

Material Safety Data Sheet
You can obtain current Material Safety Data Sheets for the ink systems used in the printer by mailing a
request to this address: Hewlett-Packard Customer Information Center, 19310 Pruneridge Avenue, Dept.
MSDS,Cupertino, CA 95014, U.S.A.

There is also a Web page: http://www.hp.com/hpinfo/community/environment/productinfo/
psis_inkjet.htm

Regulatory Model Number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your Printer is BCLAA-0701 and the Take-Up Reel is BCLAA-0702. This
regulatory number should not be confused with the marketing names (HP Designjet printer series or HP
Take-Up Reel for Designjet printer series) or product numbers (Q####X – where X is any single letter and
# is any number).
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Regulatory Statements
● USA

● Electro-Magnetic Compatibility (EMC)

● FCC statements (USA)

The U.S. Federal Communications Commission (in 47 cfr15.105) has specified that the
following notices be brought to the attention of users of this product.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

● Shielded cables

Use of shielded data cables is required to comply with the Class A limits of Part 15 of the FCC
Rules.

CAUTION: Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to
this equipment not expressly approved by the Hewlett-Packard Company may cause
harmful interference and void the FCC authorization to operate this equipment.

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a commercial environment. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the user
will be required to correct the interference at their own expense.

● California

● Canada

● Electro-Magnetic Compatibility (EMC)

● Normes de sécurité (Canada)

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites
applicables aux appareils numériques de Classe A prescrites dans le réglement sur le brouillage
radioélectrique édicté par le Ministére des Communications du Canada.

● DOC statement (Canada)

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.
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● Korean EMI statement

● Taiwanese EMI statement

● VCCI Class A (Japan)

● Safety power cord warning

● Chinese EMI statement

● Germany

Sound: Geräuschemission (Germany) LpA < 70 dB, am Arbeitsplatz, im Normalbetrieb, nach
DIN45635 T. 19.

● Europe

WARNING! This is a class A product. In a domestic environment this product may cause
radio interference in which case the user may be required to take adequate measures.
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● Disposal of waste equipment by users in private households in the European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of
with your other household waste. Instead, it is your responsibility to dispose of your waste equipment
by handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal
will help to conserve natural resources and ensure that it is recycled in a manner that protects human
health and the environment. For more information about where you can drop off your waste
equipment for recycling, please contact your local city office, your household waste disposal service
or the shop where you purchased the product.
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DECLARATION OF CONFORMITY
according to ISO/IEC 17050-1 and EN 17050-1

Supplier’s name: Hewlett-Packard Company

Supplier’s address: Avenida Graells, 501

08174 Sant Cugat del Vallès

Barcelona, Spain

declares that the product

Regulatory Model Numbers (1): BCLAA-0701, BCLAA-0702

Product names and models: HP Designjet Z6100 Printer series, HP Take-Up Reel for Designjet Z6100 Printer
series

Product options: All

conforms to the following product specifications

Safety: IEC 60950-1:2001 / EN 60950-1:2001

EMC: EN 55022:1998 +A1:00 +A2:03/ CISPR 22:1997+A1:00 +A2:02 Class A

EN 55024:1998 +A1:2001 +A2:2003

EN 61000-3-2:2000 +A2:2005/ IEC 61000-3-2:2000 +A1:2001 +A2:2004

EN 61000-3-3:1995+A1:2001/ IEC 61000-3-3:1994 +A1:2001

Additional information

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and the
EMC Directive 89/336/EEC and carries the CE-marking accordingly.

� This product is assigned a Regulatory Model Number which stays with the regulatory aspects of the
design. The Regulatory Model Number is the main product identifier in the regulatory documentation
and test reports, this number should not be confused with the marketing name or the product numbers.

Josep Maria Pujol

Hardware Quality Manager

Sant Cugat del Vallès (Barcelona)

December 5th, 2006
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A Overnight job scenario

In this scenario, the print service provider (PSP) is nearing the end of the business day and receives a new
order which requires delivery early the next day. The plotter is currently printing and there are jobs in the
queue which must also be delivered the next day. The best solution is to queue the new job and print it
overnight.

The following information describes the necessary tasks to ensure worry-free overnight printing.

Task 1: Handle the digital content
The following steps will help you to successfully handle the digital content.

1. Open the PDF file in Adobe Acrobat.

2. Ensure you have all the necessary information to submit the job, including fonts and high-resolution
images.

3. Check the orientation, margins, typography, color and resolution to ensure that there are no printing
or finishing inconsistencies.

4. Print a draft copy of the work on a small printer as a proof for validation.

5. Generate the PDF for the RIP.

6. Move the PDF file to the RIP station.

NOTE: Ensure the job can be completed and delivered on time given the current workload and
the paper and ink supplies.

Task 2: Handle the paper
Ensure that there is enough paper left in the current roll to accommodate all of the queued jobs and the
new order. If there is not enough paper left, pause the print queue and load a new roll.

The table below identifies sections of this user’s guide which will help you to quickly find information on
handling paper.

Table A-1  Handle the paper

Task Elements See this section of the user’s guide

Unload paper See Unload a roll from the printer on page 36

Load paper See Load a roll onto the spindle on page 30

Load a roll onto the take-up reel See Load a roll onto the take-up reel on page 38

Check the paper profile See View information about the paper on page 45

Troubleshooting See this section of the user's guide
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Task Elements See this section of the user’s guide

I can't load the paper See The paper cannot be loaded successfully on page 163

I can't find the paper profile for my paper See Download paper profiles on page 47 and Update the printer firmware
on page 141

I don't have HP paper See Use non-HP paper on page 47 and Supported paper types on page 28

The paper has jammed See The paper has jammed on page 163

The take-up reel paper has jammed See Take-up reel paper jammed on page 165

The take-up reel does not wind See Take-up reel does not wind on page 165

NOTE: For additional information about paper, see Handle the paper on page 26.

Task 3: Handle the ink system
Ensure that ink consumables levels are adequate to accommodate all of the queued jobs and the new
order. If the ink consumables levels are too low, pause the print queue and replace and align the
components as necessary.

The table below identifies sections of this user’s guide which will help you to quickly find information on
handling the ink system.

Table A-2  Handle the ink system

Task Elements See this section of the user’s guide

Check ink cartridge statistics See Check the status of the ink cartridges on page 76

Remove an ink cartridge See Remove an ink cartridge on page 59

Insert an ink cartridge See Insert an ink cartridge on page 61

Check printhead statistics See Check the status of a printhead on page 77

Remove a printhead See Remove a printhead on page 61

Insert a printhead See Insert a printhead on page 64

Align printheads See Align the printheads on page 71

Remove the maintenance cartridge See Remove the maintenance cartridge on page 73

Insert the maintenance cartridge See Insert the maintenance cartridge on page 75

Troubleshooting See this section of the user's guide

I cannot access the Embedded Web
Server

See Cannot access the Embedded Web Server on page 174

I cannot insert an ink cartridge See Cannot insert an ink cartridge on page 168

I cannot insert a printhead See Cannot insert a printhead on page 168

The printer will not recognize the
printhead

See Clean the electrical connections on a printhead on page 67

NOTE: For additional information about the ink system, see Handle the ink system
on page 56.

Table A-1  Handle the paper (continued)
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Task 4: Handle print jobs
After verifying ink consumables and paper levels, you can send the job to the printer. On the screen
preview, make adjustments for paper type, print size, number of copies and nesting as necessary. You
can then move the job to the RIP queue.

The table below identifies sections of this user’s guide which will help you to quickly find information on
handling print jobs.

Table A-3  Handle print jobs

Task Elements See this section of the user’s guide

Submit a job See Submit a job on page 94

Save a job See Save a job on page 95

Check ink and paper usage for a job See Check ink and paper usage for a job on page 101

Cancel a job See Cancel a job on page 96

Manage the print queue See Manage the print queue on page 96

Troubleshooting See this section of the user's guide

I can't access the Embedded Web Server See Cannot access the Embedded Web Server on page 174

NOTE: To improve color consistency between prints or from one printer to another, consider
performing a color calibration. For more information on color calibration, see Color calibration
on page 110.

Task 5: Adjust printed images
Check the quality of the prints. The table below identifies sections of this user’s guide which will help you
to quickly find information on adjusting printed images.

Table A-4  Handle the ink system

Task Elements See this section of the user’s guide

Select print quality See Select print quality on page 80

Select page size See Select page size on page 80

Select margins options See Adjust margins and layout options on page 82

Resize a print See Resize a print on page 83

Change the treatment of overlapping lines See Change the treatment of overlapping lines on page 89

Print in grayscale See Print in grayscale on page 93

Print crop lines See Print crop lines on page 84

Rotate an image See Rotate an image on page 85

Select the color emulation mode See Select color emulation mode on page 88

Print a mirror image See Print a mirror image on page 87

Select image orientation See Select image orientation on page 87

Remove top and bottom blank areas See Remove the top and bottom blank areas on page 87

Enter an account ID See Enter an account ID on page 88
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Task Elements See this section of the user’s guide

Troubleshooting See this section of the user's guide

I am experiencing print quality problems See Troubleshoot print-quality issues on page 148

NOTE: For additional information about adjusting printed images, see Print options
on page 79.

NOTE: For additional information about unloading a roll from the take-up reel after printing,
see Unload a roll from the take-up reel on page 43.

Table A-4  Handle the ink system (continued)
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B Urgent walk-in job scenario

In this scenario, the print service provider (PSP) receives an urgent walk-in order which requires delivery
in less than two hours. The plotter is currently printing and there are jobs in the queue, however, the new
job has the highest priority. It also requires different paper than what is currently in the printer.

NOTE: The new job is a repeat order for which the digital content already exists within the ripped
files storage.

The following information describes the necessary tasks to successfully execute an urgent walk-in job.

Task 1: Handle the digital content
The following steps will help you to successfully handle the digital content.

1. Find the digital content on the RIP workstation.

2. Open the PDF file in Adobe Acrobat.

3. Ensure you have all the necessary information to submit the job, including fonts and high-resolution
images.

4. Check the orientation, margins, typography, color and resolution to ensure that there are no printing
or finishing inconsistencies.

NOTE: Ensure the job can be completed and delivered on time given the current workload and
the paper and ink supplies.

Task 2: Handle print jobs
Due to the urgent nature of the new walk-in job, you are required to interrupt the current jobs in the print
queue. The following steps will help you to handle the print jobs.

1. Pause the print queue.

2. Move the new job to the top of the print queue.

3. Adjust the new job settings for productivity, paper type, print size, number of copies and nesting as
necessary.

4. Cancel the job currently on the plotter when the last image is completed.

NOTE: Resume the print queue only after handling the paper and ink system. Once the new job
is done, remember to pause the print queue to avoid printing the queued jobs on the wrong paper.

The table below identifies sections of this user’s guide which will help you to quickly find information on
handling print jobs.
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Table B-1  Handle print jobs

Task Elements See this section of the user’s guide

Submit a job See Submit a job on page 94

Save a job See Save a job on page 95

Cancel a job See Cancel a job on page 96

Manage the print queue See Manage the print queue on page 96

Troubleshooting See this section of the user's guide

I can't access the Embedded Web Server See Cannot access the Embedded Web Server on page 174

NOTE: To improve color consistency between prints or from one printer to another, consider
performing a color calibration. For more information on color calibration, see {ref: Color
calibration}.

Task 3: Handle the paper
The new job requires different paper than the job that was interrupted. The following steps will help you
to handle the paper.

1. Remove the printed output from the plotter and annotate what the remainder of the job.

2. Unload the currently loaded paper.

3. Load the correct paper for the new job.

NOTE: To improve color consistency between prints, or from one printer to another, consider
performing a color calibration. For more information on color calibration, see Color calibration
on page 110.

The table below identifies sections of this user’s guide which will help you to quickly find information on
handling paper.

Table B-2  Handle the paper

Task Elements See this section of the user’s guide

Unload paper See Unload a roll from the printer on page 36

Unload a roll from the take-up reel See Unload a roll from the take-up reel on page 43

Load paper See Load a roll onto the spindle on page 30

Load a roll onto the take-up reel See Load a roll onto the take-up reel on page 38

Check the paper profile See View information about the paper on page 45

Perform color calibration See Color calibration on page 110

Troubleshooting See this section of the user's guide

I can't load the paper See The paper cannot be loaded successfully on page 163

I can't find the paper profile for my paper See Download paper profiles on page 47 and Update the printer firmware
on page 141

I don't have HP paper See Use non-HP paper on page 47 and Supported paper types on page 28

The paper has jammed See The paper has jammed on page 163
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Task Elements See this section of the user’s guide

The take-up reel paper has jammed See Take-up reel paper jammed on page 165

The take-up reel does not wind See Take-up reel does not wind on page 165

NOTE: For additional information about paper, see Handle the paper on page 26.

Task 4: Handle the ink system
Ensure that ink consumables levels are adequate to accommodate the new job and the remaining queued
jobs. If the ink consumables levels are too low, replace and align the components as necessary before
resuming the print queue.

The table below identifies sections of this user’s guide which will help you to quickly find information on
handling the ink system.

Table B-3  Handle the ink system

Task Elements See this section of the user’s guide

Check ink cartridge statistics See Check the status of the ink cartridges on page 76

Remove an ink cartridge See Remove an ink cartridge on page 59

Insert an ink cartridge See Insert an ink cartridge on page 61

Check printhead statistics See Check the status of a printhead on page 77

Remove a printhead See Remove a printhead on page 61

Insert a printhead See Insert a printhead on page 64

Align printheads See Align the printheads on page 71

Remove the maintenance cartridge See Remove the maintenance cartridge on page 73

Insert the maintenance cartridge See Insert the maintenance cartridge on page 75

Troubleshooting See this section of the user's guide

I cannot access the Embedded Web
Server

See Cannot access the Embedded Web Server on page 174

I cannot insert an ink cartridge See Cannot insert an ink cartridge on page 168

I cannot insert a printhead See Cannot insert a printhead on page 168

The printer will not recognize the
printhead

See Clean the electrical connections on a printhead on page 67

NOTE: For additional information about the ink system, see Handle the ink system
on page 56.

Task 5: Adjust printed images
Check the quality of the prints. The table below identifies sections of this user’s guide which will help you
to quickly find information on adjusting printed images.

Table B-2  Handle the paper (continued)
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Table B-4  Handle the ink system

Task Elements See this section of the user’s guide

Select print quality See Select print quality on page 80

Select page size See Select page size on page 80

Select margins options See Adjust margins and layout options on page 82

Resize a print See Resize a print on page 83

Change the treatment of overlapping lines See Change the treatment of overlapping lines on page 89

Print in grayscale See Print in grayscale on page 93

Print crop lines See Print crop lines on page 84

Rotate an image See Rotate an image on page 85

Select the color emulation mode See Select color emulation mode on page 88

Print a mirror image See Print a mirror image on page 87

Select image orientation See Select image orientation on page 87

Remove top and bottom blank areas See Remove the top and bottom blank areas on page 87

Enter an account ID See Enter an account ID on page 88

Troubleshooting See this section of the user's guide

I am experiencing print quality problems See Troubleshoot print-quality issues on page 148

NOTE: For additional information about adjusting printed images, see Print options
on page 79.
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C Replace your HP Designjet 5000
series printer with an HP Designjet
Z6100 printer scenario

The HP Designjet Z6100 Printer series is the next-generation large format printer that allows you to reuse
the knowledge you’ve acquired using the HP Designjet 5000 printer. When designing the Z6100, our
engineers leveraged the best features and functionality from the 5000 series and then made it even more
robust and easier to use. The transition from your 5000 series printer to the Z6100 will not only be quick
and intuitive, it will provide greater flexibility, job assurance and image quality to your large format
printing business.

This scenario highlights some of the basic operations of large format printing, drawing attention to the
main differences between the Z6100 and the 5000 series printer.

Set up the printer
The Z6100 will fit nicely into the space formerly occupied by your 5000 series printer. The rear of the
printer is also similar to the 5000 series, with the same power cord attachments and options for connecting
your printer to a computer and LAN.

See the following sections for more detailed information:

● Physical specifications on page 190

● Turn the printer on and off on page 21

● The printer's main components on page 4

● Connectivity and software instructions on page 12

Front panel
The Z6100 is managed primarily via the front panel. The front panel has been designed to leverage what
you learned while using the 5000 series, with design advancements to improve usability.

The Z6100 front panel contains interactive animations to guide you through all the basic operations.
Furthermore, the front panel menu structure and enhanced text and graphics facilitate the configuration
and use of the various printer features.

For more detailed information about the front panel, see The front panel on page 8.
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Printer software
● Printer drivers for Windows and Mac OS

● The Embedded Web Server (called the HP Designjet WebAccess in the 5000 series) enables you to
manage your print jobs, check consumables levels and check printer status

● The HP Easy Printer Care (Windows) and HP Printer Utility (Mac OS), which enable you to access
various printer features and functionality

See the following sections for more detailed information:

● Printer software on page 9

● Embedded Web Server setup options on page 23

● HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) setup options on page 25

If you have worked through the Set-up poster, you are ready to begin printing.

Handle the paper
The Z6100 requirements for handling the paper, loading and unloading the paper and using the take-up
reel is similar to those for the 5000 series printer. All of the basic paper-handling procedures start from
the front panel.

What is new in paper handling?
● There is no spindle lever on the Z6100 series printers. To remove the spindle, simply lift it from the

printer when you are prompted by the front panel.

● New hub design for improved loading and unloading of paper

● You can now leave the printer window open while loading media

● While the portfolio of printing materials has grown, sheet paper is not supported in the Z6100; only
roll paper is supported

See the following sections for more detailed information on supported paper types and ordering paper:

● Supported paper types on page 28

● Order paper on page 49

Paper profiles
When you load a new roll into the printer, the front panel prompts you to select the type of paper you are
loading and enter the length of the roll. For every paper type listed in the front panel, there is a paper
profile (containing an ICC profile) already stored in the printer software.

If you want to use a paper that is not listed in the front panel, choose one of the following options:

● Select the paper that matches most closely the paper you intend to use, via the front panel

● Download the profile from the Internet. The printer automatically performs color calibration and
paper advance calibration for every downloaded profile.

You can easily view information on the currently loaded paper. To do so, select the  icon, in the front
panel and then select View information about the paper.
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See the following sections for more detailed information:

● View information about the paper on page 45

● Download paper profiles on page 47

● Use non-HP paper on page 47

● Load a roll onto the spindle on page 30

● Load a roll into the printer on page 32

Print paper info feature
This feature was called Track paper length in the 5000 series. If you enable the Print paper info feature,
a barcode containing all available paper information will be printed on the roll when it is unloaded.
Subsequently, when you load a roll with an information barcode printed on it, the printer automatically
detects the paper type, loads the appropriate profile and tracks the amount of paper remaining in the roll.

See the following sections for more detailed information:

● Unload a roll from the printer on page 36

● Printing paper info on page 49

The take-up reel
The take-up reel on the Z6100 is similar in form and function to the 5000 series take-up reel, but it has
been improved for better usability. Here are some of the improvements.

● Dual winding direction. You can choose to wind the printed paper so that the graphics face inward
(toward the core) or outward.

● Faster paper advance for shorter set up time

● Improved skew check when loading the paper into the printer to reduce skewing

See the following sections for more detailed information on the take-up reel:

● The printer's main components on page 4

● Use the take-up reel on page 38

Handle the ink system
The Z6100 series printer incorporates cutting-edge technology to give you the best image quality available
for large format printing. With the exception of the maintenance cartridge (which has replaced the
printhead cleaners) you will notice that the ink system components can be found in the same general
locations as in the 5000 series. You will also notice that the ink cartridge door has been removed. This
streamlined design offers instant access to the ink cartridges.

What is new with the ink system components?
● Ink cartridges: The Z6100 uses 8 ink cartridges. The inks are available exclusively in 775 ml

cartridges, offering extended print runs, simplifying the installation process and reducing the
frequency of cartridge changes.

● Printheads: With improved printhead technology, the handling requirements of the printheads has
changed. They must be shaken vigorously and cleaned in a different manner before installation.

● Maintenance cartridge: The maintenance cartridge performs the same functions as did the
printhead cleaners in the 5000 series. However, as there is only one maintenance cartridge for all
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8 printheads, there is less maintenance and less handling of messy printhead cleaners. The printer
notifies you via the front panel when you should change the maintenance cartridge.

NOTE: Handle the maintenance cartridge carefully when removing it to avoid getting ink on
yourself and the printer.

NOTE: The Z6100 automatically performs printhead alignment whenever a printhead is inserted.
You are required to use opaque white paper during printhead alignment. Colored papers, glossy
canvas and translucent materials are not suitable for printhead alignment.

See the following sections for more detailed information on the ink system components:

● The printer's main components on page 4

● Ink system components on page 57

● Ink system tips on page 58

● Remove an ink cartridge on page 59

● Insert an ink cartridge on page 61

● Remove a printhead on page 61

● Insert a printhead on page 64

● Align the printheads on page 71

● Remove the maintenance cartridge on page 73

● Insert the maintenance cartridge on page 75

● Clean (recover) the printheads on page 66

● Clean the electrical connections on a printhead on page 67

See the following sections for information on checking ink system status and printer usage statistics:

● Check the status of the ink system on page 76

● Check the status of the ink cartridges on page 76

● Check the status of a printhead on page 77

● Check printer usage statistics on page 77

Image quality and color management
The Z6100 series printers make it easier than ever to achieve the image quality levels you demand of
your large format printer.

Print quality
This feature was called Print mode in the 5000 series. The Z6100 series offers one additional print quality
level with which to balance print speed and print quality. The table below identifies the correlation
between the 5000 series print modes and the Z6100 series print quality levels.

Printer series Print quality settings from fastest speed (far left) to best quality (far right)

5000 Max speed Productivity Max quality

Z6100 Fast Normal-fast Normal Best
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Calibration and image quality
The list below highlights some of the features and functionality built into the Z6100 series to ensure the
highest possible image quality.

● Greater print resolution (when photo paper is used, print quality is set to Best and the Maximum
resolution feature is enabled)

● Automatic paper advance calibration

● Automatic color calibration

● Automatic paper profiling including ICC profiles (except for unknown papers, which require
downloading from the Internet)

● Embedded spectrophotometer: a precision instrument that determines the exact composition of light
reflected from a color patch to help ensure consistent and accurate color

● Variety of color emulations. You can even emulate the color palette from your 5000 series printer.

See the following sections for more detailed information:

● Select print quality on page 80

● Perform paper advance calibration on page 46

● A summary of the color-management process on page 109

● Color calibration on page 110

● Color profiling on page 111

● Color-management options on page 114

● Color emulation modes on page 118

Efficient use of paper and consumables
The Z6100 series printers help you to economize paper and consumables usage by providing:

● Printer usage statistics

● Nesting options

● Tips on using paper and inks economically

See the following sections for more detailed information:

● Nest jobs to save paper on page 98

● Use paper economically on page 102

● Use ink economically on page 102

Maintenance and troubleshooting
See the following chapters and sections for information on maintaining the printer and troubleshooting
issues:

● Maintain the printer on page 135

● Troubleshoot print-quality issues on page 148
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● Troubleshoot ink-system issues on page 167

● Troubleshoot paper issues on page 162

● Troubleshoot other issues on page 172

● Use the Printhead status plot on page 71

● Front-panel error messages on page 179

● Get help on page 182
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Glossary

Bonjour Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a
computer network technology that is used in Apple Mac OS X V10.2 and later. Use it to discover the services that
are available on a local area network (LAN). It was originally known as Rendezvous.

Color accuracy The ability to print colors that match the original image as closely as possible, given the fact that
all devices have a limited color gamut and might not be able to match certain colors precisely.

Color consistency The ability to print the same colors in a particular print job, from print to print and from printer
to printer.

Color model A system of representing colors by numbers. An example of such a system is RGB or CMYK.

Color space A color model in which each color is repesented by a specific set of numbers. Many different color
spaces can use the same color model: for instance, monitors generally use the RGB color model, but they have
different color spaces, because a particular set of RGB numbers results in different colors on different monitors.

Cutter A printer component that slides back and forth across the platen to cut the paper.

ESD ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door,
or the cling of clothing. Although controlled static electricity has some useful benefits, uncontrolled electrostatic
discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some precautions
are needed when setting up the product, or handling ESD sensitive devices. This type of damage may reduce the
life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is
by touching any exposed grounded part of the product (mainly metal parts) before handling ESD sensitive devices
(such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body
try to avoid working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive
devices. Also, avoid working in low humidity environments.

Ethernet A popular computer networking technology for local area networks.

Firmware Software that controls your printer's functionality and is stored semi-permanently in the printer (it can
be updated).

Gamut The range of colors and density values reproducible on an output device, such as a printer or monitor.

HP-GL/2 Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.

I/O Input/Output: this term describes the passing of data between one device and another.

ICC The International Color Consortium, a group of companies that have agreed on a common standard for color
profiles.

Ink cartridge A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers
separated by dots.

Jetdirect HP's brand name for its series of print servers that allow a printer to be connected directly to a local
area network.

LED Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.
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MAC address Media Access Control address: a unique identifier used to identify a particular device on a
network. It is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP
address.

Nozzle One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which
are pulped, dried, and pressed.

Platen The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead A removable printer component that takes ink of one or more colors from the corresponding ink
cartridge(s) and deposits it on the paper, through a cluster of nozzles.

Rendezvous Apple Computer's original name for its networking software later known as Bonjour.

Spindle A rod that supports a roll of paper while it is being used for printing.

TCP/IP Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is
based.

USB Universal Serial Bus: a standard serial bus designed to connect devices to computers.
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setup options 25

HP Instant Support 183
HP Professional PANTONE

emulation 116

I
image problems

blank page 159
clipped at bottom 159
clipped image 160
distorted print 161
missing objects 151
overlapping images 161
pen settings ineffective 161
small image 160
unexpected mirror image 161
unexpected rotation 160
unintelligible print 161
Visio 2003 177

ink absorber
change 142

ink cartridge
about 57
cannot insert 168
inserting 61
maintenance 139
ordering 78
refilling 57
removing 59
specification 189
status 76

ink system status 76
ink system tips 58
ink usage, economize 102
install the driver 13
Instant Support 183
internal prints 101

J
job status 97
JPEG 102

L
language 22
line thickness 150
loading paper problems 163
loading roll into printer 32
loading roll onto spindle 30
lubricate the carriage 139
lubricating the platen rollers 175

M
maintenance 139
maintenance cartridge

about 58
inserting 75
removing 73

margins
changing 82
specification 190

maximum speed 94
mechanical accuracy 190
media profiles

downloading 47
memory error 175
memory error (AutoCAD) 175
memory specifications 191
mirror image 87
mirror image unexpected 161
misaligned colors 152
move the printer 140

N
nesting 98

O
open source software 197
order

accessories 147
ink cartridges 78
maintenance cartridges 78
paper 49
printheads 78

out-of-memory error 175
overlapping images 161
overlapping lines 89
overnight job scenario 202,  210

P
page size 80
paper

advance 46

cannot load 163
displaying information 45,  49
overview 27
tips 27,  49

paper advance calibration 46
paper jam

take-up reel 165
paper not flat 155
paper sizes (max & min) 189
paper types

front panel names 28
supported 28

paper usage, economize 102
PDF 102
pen settings ineffective 161
Photoshop

HP-GL/2 and PostScript
drivers 123

Photoshop CS2 v9.0
HP-GL/2 and PostScript

drivers 126
physical specifications 190
PostScript 102
power specifications 191
preventive maintenance 139
preview a print 90
print job

canceling 96
ink usage 101
nesting 98
paper usage 101
queue management 96
saving 95
submitting 94

print preview 90
print quality

changing 80
choosing 91

print resolution 189
print with shortcuts 89
print-quality problems

banding 153
blurred lines 152
bronzing 154
colors inaccurate 157
general 149
graininess 154
horizontal lines 153
ink marks 155
line thickness 150
misaligned colors 152
paper not flat 155
smudging 155
stepped lines 150
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top of print 156
warped lines 153
wood-grain appearance 161

printer does not print 173
printer software

Mac OS uninstall 19
Windows uninstall 15

printer's main components 4
printer's main features 4
printhead

about 57
align 169
aligning 71
cannot insert 168
clean; purge 168
cleaning 66
cleaning connections 67
inserting 64
ordering 78
recovery 66
removing 61
reseat, reseat 168
specification 189
status 77

printhead cleaner
cannot insert 168
specification 189

Printhead status plot 71
profiling, accessory 113

R
rear view 42–in printer 6,  7
refilling ink cartridges 57
regulatory notices 197
remove top/bottom blank

areas 87
rendering intent 116
reprint a job 96
resizing an image 83
resolution 189
restart the printer 22
roll paper

loading into the printer 32
loading onto the spindle 30
unloading 36

roller lubrication 175
rotating an image 85
rotation unexpected 160

S
safety precautions 2
scenario

overnight job 202,  210
urgent walk-in job 206

Select color emulation mode 88
select image orientation 87
shortcuts 89
sleep mode wait time 23
slow printing 173
small image 160
smudging 155
software 9
specifications

acoustic 192
ecological 191
environmental 191
functional 189
graphic languages 190
hard disk 191
ink supplies 189
margins 190
mechanical accuracy 190
memory 191
paper size 189
physical 190
power 191
print resolution 189

spectrophotometer 108
squeaky rollers 175
stacking problems in bin 165
statistics

ink cartridge 76
printer usage 77

status 97
stepped lines 150
store the printer 140
support services

HP Customer Care 183
HP Designjet Online 183, 

186
HP Instant Support 183

supported papers 28

T
take-up reel

doesn't rewind 165
motor 7
using 38

telephone numbers 184
TIFF 102
turn the printer on/off 21

U
unintelligible print 161
unloading roll from printer 36
urgent walk-in job scenario 206
use the take-up reel 38
using this guide 2

V
Visio 2003, no output 177

W
warped lines 153
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